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●●
About the Product Warranty
Every effort has been made to ensure that the information in this document is complete, accurate,
and up-to-date. The manufacturer assumes no responsibility for the results of errors beyond its
control. The manufacturer also cannot guarantee that changes in software and equipment made by
other manufacturers and referred to in this guide will not affect the applicability of the information
in it. Mention of software products manufactured by other companies does not necessarily constitute
endorsement by the manufacturer.
While all reasonable efforts have been made to make this document as accurate and helpful as
possible, we make no warranty of any kind, expressed or implied, as to the accuracy or completeness
of the information contained herein.

All rights are reserved by Oki Electric Industry Co., Ltd. You must not copy, transfer, translate, etc. the
content herein without authorization. You must obtain written permission from Oki Electric Industry
Co., Ltd. before doing any of the above.
© 2012 Oki Electric Industry Co., Ltd.
OKI is a registered trademark of Oki Electric Industry Co., Ltd.
Energy Star is a trademark of the United States Environmental Protection Agency.
Microsoft, Windows, Windows Server and Windows Vista are registered trademarks of Microsoft
Corporation.
Apple, Macintosh, Rosetta, Mac and Mac OS are registered trademarks of Apple Inc.
Other product names and brand names are registered trademarks or trademarks of their proprietors.
This product complies with the requirements of the Council Directives 2014/30/EU (EMC), 2014/35/
EU (LVD), 2014/53/EU (RED), 2009/125/EC (ErP) and 2011/65/EU(RoHS), as amended where
applicable, on the approximation of the laws of the member states relating to Electromagnetic
Compatibility, Low Voltage, Radio & Telecommunications Terminal Equipment, Energy related
Products and Restriction on the use of certain Hazardous Substances in electrical and electronic
equipment.

The following cables were used to evaluate this product for EMC directive 2014/30/EU compliance, and
configurations other than this may affect that compliance.
length
(meters)

core

Power

1.8

✘

✘

USB

5.0

✘

✔

LAN

15.0

✘

✘

cable type
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shield

●●
ENERGY STAR
Target countries of the ENERGY STAR program are the United States, Canada and Japan.
It is not applicable to other countries.
This product is compliant with ENERGY STAR v2.0 only.

●●
Emergency first aid
Take care with toner powder:
If swallowed, give small amounts of cold water and seek medical attention. DO
NOT attempt to induce vomiting.
If inhaled, move the person to an open area for fresh air. Seek medical attention.
If it gets into the eyes, flush with large amounts of water for at least 15 minutes
keeping eyelids open. Seek medical attention.
Spillages should be treated with cold water and soap to help reduce risk of
staining skin or clothing.

●●
Environmental information
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●●
For Your Safety
Read the User’s Manual for your safety before using the product.

Cautions related to safety
WARNING
CAUTION

A warning provides additional information which, if ignored, may result in a risk of personal
injury.
A caution provides additional information which, if ignored, may result in equipment
malfunction or damage.

General cautions
WARNING
Do not touch the safety
switch inside the printer.
Doing so may cause electric
shock when high voltage
occurs. In addition, the
rotating gears may result in
injury.

Do not use highly flammable
sprays near the printer. Doing
so may cause fire as parts of
the printer are hot.

Unplug the power cord and
contact a customer service
center if a liquid such as
water enters in the internal
parts of the printer.
Failure to do so may lead to
a fire.
Unplug the power cord
and contact a customer
service center if the printer
is dropped or the cover is
damaged.
Failure to do so may cause
electric shock and/or fire,
leading to injuries.

Unplug the power cord and
remove foreign materials
such as paper clips if they
fall inside the printer. Failure
to do so may cause electric
shock and/or fire, leading to
injuries.
Unplug the power cord
periodically to clean plug
blades and base section
between the blades.
If the power plug remains
inserted for a long time, the
base section will get dusty,
and the plug may short
circuit, which may cause fire.
Do not put a cup with liquids
such as water on the printer.
Doing so may cause electric
shock and/or fire leading to
personal injuries.
Do not use a power cord, a
cable, or a ground wire other
than those that are indicated
in User's Manual.
Doing so may cause fire.

Do not insert materials in a
vent hole.
Doing so may cause electric
shock and/or fire leading to
personal injuries.
Do not throw toner cartridges
and image drum cartridges
into fire. Doing so may cause
dust explosion leading to
burns.

Unplug the power cord
and contact a customer
service center if the cover
is unusually hot, smoking,
giving off an unusual odor,
or making strange noises.
Failure to do so may lead to
a fire.
Do not operate and/or
disassemble the printer other
than as directed in User’s
Manual. Doing so may cause
electric shock and/or fire,
leading to injuries.
Do not clean spilled toner
with a vacuum cleaner.
If cleaning spilled toner with
a vacuum cleaner, it may
catch fire due to the sparks
from electric contact.
Toner spilled on the floor
should be wiped off with wet
cloth.
Do not touch the fuser and
other parts when opening the
cover of the printer.
Doing so may cause burns.
The operation of using UPS
(uninterruptible power
source) or inverters is not
guaranteed. Do not use
uninterruptible power source
or inverters.
Doing so may cause fire.

CAUTION
Do not come closer to the paper’s exit area
when the power is turned on, while printing.
Doing so may result in personal injury.

Do not touch a damaged liquid-crystal display.
If liquid (liquid crystal) leaked from the liquidcrystal display gets into the eyes or mouth, flush
with large amount of water. Follow the direction
from a doctor if necessary.
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●●
Manual Composition
The following manuals are included with this product.
●● Quick Guide
This notes brief descriptions of how to install this printer.
●● User’s Manual (Setup) ---- This document
Basic operations are described to aid understanding of this printer. The initial setup descriptions
including printer placement and the network initial setting are noted along with troubleshooting and
maintenance procedures.
●● User’s Manual (Advanced)
The advanced manual describes the advanced operations of each function. The utility and network
setting information is included.

●●
About This Manual
Terms in this document
The following terms are used in this manual.
Note

●● Indicates important information on operations. Make sure to read sections with this mark.
Memo

●● Indicates additional information on operations. You should read sections with this mark.
Reference

●● Indicates where to look when you want to know more detailed or related information.

WARNING
●● A warning provides additional information which, if ignored, may result in a risk of personal injury.

CAUTION
●● A caution provides additional information which, if ignored, may result in equipment malfunction or
damage.

Symbols in this document
The following symbols are used in this manual.
Symbols
[ ]
" "

< > button/key
>
Your Printer

Description
●● Indicates menu names on the display screen.
●● Indicates menu, window, and dialog names on the computer.
●● Indicates messages and input text on the display screen.
●● Indicates file names on the computer.
●● Indicates reference titles.
Indicates a hardware button on the operator panel or a key on the keyboard of the
computer.
Indicates how to get to the item you want in the menu of this printer or the computer.
Indicates a printer you want to use or select.

-5-

Notation used in this manual
The following notations may be used in this manual.
●● C831n/C831dn→ C831
●● C841n/C841dn→ C841
●● PostScript3 Emulation→ PSE, POSTSCRIPT3 Emulation, POSTSCRIPT3 EMULATION
●● Microsoft® Windows® 7 64-bit Edition operating system→ Windows 7 (64bit version) *
●● Microsoft® Windows Vista® 64-bit Edition operating system→ Windows Vista (64bit version) *
●● Microsoft® Windows Server® 2008 R2 64-bit Edition operating system→ Windows Server 2008 *
●● Microsoft® Windows Server® 2008 64-bit Edition operating system→ Windows Server 2008 (64bit version) *
●● Microsoft® Windows® XP x64 Edition operating system → Windows XP (x64 version) *
●● Microsoft® Windows Server® 2003 x64 Edition operating system→ Windows Server 2003 (x64 version) *
●● Microsoft® Windows® 7 operating system→ Windows 7 *
●● Microsoft® Windows Vista® operating system→ Windows Vista *
●● Microsoft® Windows Server® 2008 operating system→ Windows Server 2008 *
●● Microsoft® Windows® XP operating system→ Windows XP *
●● Microsoft® Windows Server® 2003 operating system→ Windows Server 2003 *
●● Microsoft® Windows® 2000 operating system→ Windows 2000
●● Generic name for Windows 7, Windows Vista, Windows Server 2008, Windows XP, Windows Server 2003, and
Windows 2000→ Windows
* I f there is no special description, 64bit version is included in Windows 7, Windows Vista, Windows Server 2008,
Windows XP, and Windows Server 2003. (64bit version and Windows Server 2008 R2 is included in Windows
Server 2008.)
If there is no special description, Windows 7 is used as Windows, Mac OS X 10.6 is used as Mac OS X, and C831dn
is used as the printer for examples in this document.
Depending on your OS or model, the description on this document may be different.
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1. Setup

1. Setup

How to set up is explained in this chapter.

 Setup Flow
1. Checking Products
●● Checking package contents
●● Checking names of the operator panel and how to
operate
●● Checking names of product parts
●● Checking options

2. Checking the Placement Environment
●● Checking the placement environment
●● Checking placement location

3. Preparing a Printer
●● Unpacking
●● Removing cushioning materials
●● Installing consumables
●● Loading paper
●● Turning on/off the power
●● Installing options
●● Test printing from the printer

4. Connecting to a Computer
Connecting through network
For Windows

Connecting through USB

For Macintosh
Connecting through
EtherTalk

For Windows

For Macintosh

Connecting
through Bonjour

Specifying an IP address Enabling EtherTalk on the
on the operator panel
operator panel

Disabling the sleep mode on the operator panel

Connecting a cable

Connecting a cable

Installing a printer driver on a computer

Adding printers on a computer

Enabling the sleep mode on the operator panel

Test printing from a computer
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Connecting a
cable

Adding printers on a
computer

Checking Products

●●
Checking Products

1

This section gives an overview of the printer.
●● Quick Guide
●● Software DVD-ROM

Check that you have everything shown below.

CAUTION

It may cause injury!

●● At least two people are needed to lift the printer
safely because it weighs about 37 Kg or 40 Kg.

●● AC cord

Reference

●● For details on how to open the package, refer to
“Unpacking” P.17.
Note

●● Printer

●● An Ethernet cable and USB cable are not supplied with
your printer. Procure them separately.
●● Packaging and cushioning material are needed if
transporting the printer. Do not throw them away.

●● Four image drums (black, yellow, magenta
and cyan)
●● Four starter toner cartridges (black, yellow,
magenta and cyan)
Note

●● The starter toner cartridges are installed in the
image drums which are installed in the printer before
shipment.

●● Louver for emission
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1. Setup

Checking Package Contents

Operator Panel

Operator Panel
1 ●●
1. Setup

This section explains the names and functions of components on the operator panel and how to enter
text.
1

2

5

12

9

8
11

13

No.

7

6

Name

1
2
3
4

Display screen
<ON LINE> button
<CANCEL> button
<ENTER> button

5
6
7

<SCROLL> button
<BACK> button
<HELP> button

8

<POWER SAVE> button

9

Ten-key pad

10
11

<Fn> key
<CLEAR> key

12
13

<READY> indicator
<ATTENTION> indicator

3 10

Function

Use to enter numbers and characters.
Each time a numeric key is pressed, entered
numbers or characters are changed cyclically in
the following order:
1
a→b→c→2→a
d→e→f→3→d
g→h→i→4→g
j→k→l→5→j
m→n→o→6→m
p→q→r→s→7→p
t → u → v →8 → t

4

Displays operating instructions and the status of the printer.
Switches between on line and off line modes.
Cancels the current print immediately.
●● Displays the menu screen.
●● Confirms the highlighted item.
Selects the menu or scrolls the screen.
Returns to the previous screen.
Displays the help screen. To close, press the <HELP> button, <BACK>
button, or <CANCEL> button.
●● Enters or exits the power saving mode.
●● Exits the sleep mode.
Lights up green in the power save mode and blinks green in the sleep mode.
●● Enters numbers.
●● Enters alphabetical characters and symbols.
A password can be entered only with a ten-key pad.
Displays the equipment setting menu screen with a shortcut function.
Executes the following actions according to the entered items when pressed
or held down.
●● Minimizes a setting value.
●● Enters zero for a setting value.
●● Deletes a character.
●● Cancels a selected item.
Returns to the previous settings. Not available when entering an IP address.
Lights up green in on line mode and turns off in off line mode.
Lights up or blinks orange when an error occurs in the device.

How to Use the Ten-Key Pad

<1>:
<2>:
<3>:
<4>:
<5>:
<6>:
<7>:
<8>:

5

<9>: w → x → y → z → 9 → w
<0>: 0
The functions of < > and <C> keys are the
followings:
< >: Function key (Available only when the
standby screen is displayed.)
<C>: Deletes a character when entering a
password.
To enter “abc” for example,
press <2> → <ENTER> button → <2> → <2>
→ <ENTER> button → <2> → <2> → <2> →
<ENTER> button.
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Operator Panel

Function No.

How to Use the Function Key
Press numeric keys after pressing the <Fn>
key when the message “Ready To Print”
appears on the display screen. The function
menu corresponding to the number entered is
displayed.

1

Press the <Fn> key.

2

Press the numeric keys (0-9) to display
the desired function item and press the
<ENTER> button.
䎩䏘䏑䏆䏗䏌䏒䏑䎃䎱䏘䏐䏅䏈䏕

䎨䏑䏗䏈䏕䎃䎔䎐䎖䏇䏌䏊䏌䏗䎃䎱䏘䏐䏅䏈䏕

3

The setting screen of the selected
function is displayed. Check or change
the settings.
䎳䏄䏓䏈䏕䎃䎶䏌䏝䏈䎃䎃䎃䎃䎔䎒䎔䎔
䎤䎖
䎤䎗
䎍䎃䎤䎗
䎤䎘

Reference

●● For the menu that Function No. is not assigned, refer to
“Menu List of the Operator Panel” P.134.

Function Menu List
Function No.
1
2
10
11
12
13
14
15
16
20
21
22

Function menu
Encrypted Job
Stored Job
Paper Size (Tray 1)
X Dimension (Tray 1)
Y Dimension (Tray 1)
Media Type (Tray 1)
Media Weight (Tray 1)
Legal Paper (Tray 1)
Other Size (Tray 1)
Paper Size (Tray 2)
X Dimension (Tray 2)
Y Dimension (Tray 2)
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Media Type (Tray 2)
Media Weight (Tray 2)
Legal Paper (Tray 2)
Other Size (Tray 2)
Paper Size (Tray 3)
X Dimension (Tray 3)
Y Dimension (Tray 3)
Media Type (Tray 3)
Media Weight (Tray 3)
Legal Paper (Tray 3)
Other Size (Tray 3)
Paper Size (Tray 4)
X Dimension (Tray 4)
Y Dimension (Tray 4)
Media Type (Tray 4)
Media Weight (Tray 4)
Legal Paper (Tray 4)
Other Size (Tray 4)
Paper Feed
Paper Size (MP Tray)
X Dimension (MP Tray)
Y Dimension (MP Tray)
Media Type (MP Tray)
Media Weight (MP Tray)
Tray Usage (MP Tray)
Configuration
Network
Usage Report
Error Log
Power Save Time
Sleep Time
Auto Power Off Time
Error Report
X Adjust
Y Adjust
Duplex X Adjust
Duplex Y Adjust
Paper Black Setting
Paper Color Setting
Trans. Black Setting
Trans. Color Setting
SMR Setting
BG Setting
Drum Cleaning
Hex Dump
Adjust Density
Adjust Registration
Print Tuning Pattern
Cyan Darkness
Magenta Darkness
Yellow Darkness
Black Darkness

1
1. Setup

23
24
25
26
30
31
32
33
34
35
36
40
41
42
43
44
45
46
80
90
91
92
93
94
95
100
101
102
103
200
201
202
210
220
221
222
223
230
231
232
233
234
235
236
237
300
301
302
310
311
312
313

Function menu

Operator Panel

1

Names of Components
2

5

1. Setup

3

16
8

4
17
6

No.
16
17

8
1

7

No.
1
2
3
4
5
6
7
8

Name
Multipurpose tray
Paper set cover

Name
Front cover
Front cover open lever
Operator panel
Power switch
Top cover
Multipurpose tray
Tray 1
Air vents

18

22

19
21
20
9

No.
18
19
20
21
22

13
12

15

11
10

14

Name
Faceup stacker
AC power socket
Interface part
Access cover
Duplex unit (Only for the model of the name
with dn or ES)

●● Interface part
23

No.
9
10
11
12
13
14
15

24

Name
Top cover open button
Toner cartridge
Image drum (K: black)
Toner cartridge
Image drum (Y: yellow)
Toner cartridge
Image drum (M: magenta)
Toner cartridge
Image drum (C: cyan)
Fuser unit
LED head (four heads)

25

No.
23
24
25
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Name
Accessory connector
USB interface connection
Network interface connection

Operator Panel

Available Options

1
1. Setup

The following options are available for your
printer:
●● Additional tray unit (tray 2/3/4)
●● Additional RAM (256 MB or 512 MB)
●● 16 GB SD memory card kit
Reference

●● For details on how to install the options, refer to
“Installing Options” P.23.
●● An SD memory card kit is used for functions such as a
storage for spooling when copying sectors, saving secure
print/encrypted print data, and as a storage destination
for form data. For information on secure print, encrypted
secure print and form data storage functions, please refer
to the User’s Manual (Advanced).
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Checking the Placement Environment

Checking the Placement Environment
1 ●●
1. Setup

Placement Environment
Your printer must be placed in the following
environment:
Temperature:
Humidity:
Maximum
wet bulb
temperature:
Recommended
environment:

10 - 32°C
20% - 80% RH
(relative humidity)
25°C

Placement Space
Place your printer on a flat surface that is wide
enough that the printer’s feet securely on the
surface.
Allow for enough room around your printer as
shown in the images below.
●● Top view
20 cm

17 - 27°C, 50 - 70 % RH

Note

●● Be careful of condensation. It may cause a malfunction.
●● If placing your printer in a location where the humidity of
the surrounding air is less than 30% RH, use a humidifier
or antistatic mat.

WARNING
●● Do not install near high temperature or the fire.
●● Please do not install in a place from which a
chemical reaction is started (laboratory etc.).
●● Do not install near the inflammable solution, such
as alcohol and thinner.
●● Do not install in the place which the small child's
hand reaches.
●● Do not install in an unstable place (the shaky
stand, leaning place, etc.).
●● Do not install in a place many humidity, dusty and
the place where direct rays hit.
●● Do not install in the environment of briny air and
corrosive gas.
●● Do not install in a place with much vibration.
●● Do not install in a place where the ventilation hole
of the printer is closed.

60 cm

100 cm
20 cm

●● Side view

70 cm

CAUTION
●● Do not place directly on a rug or carpet with long
strands.
●● Do not install in a closed room with poor
ventilation and circulation.
●● If you use the printer in a small room for a long
time, please make sure that you ventilate the
room.
●● Install away from strong magnetic fields and
sources of noise.
●● Install away from monitors or TVs.
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Preparing Your Printer

●●
Preparing Your Printer

1

This section explains how to unpack your printer and how to turn it on and off.

CAUTION

Installing Consumables
1

It may cause injury!

●● At least two people are needed to lift the printer
safely because it weighs about 37 Kg or 40 Kg.

Insert your finger into the recess on
the right side of the printer and pull the
front cover open lever (1) to open the
front cover (2) forward.
Note

Note

●● Open the front cover gently. If opening rapidly, an MP
tray may open.

●● Be sure to use the consumables or maintenance units
provided with this printer at first. Otherwise, the life of the
consumables or maintenance units may not be displayed
correctly, or you may not be able to use them later.
●● The image drum (the green tube) is very delicate. Handle
it carefully.
●● Do not expose the image drum to direct sunlight or very
bright interior light (approximately more than 1500 lux).
Even under the normal interior light, do not leave it for
more than 5 minutes.

1

●● Packaging and cushioning material are needed if
transporting the printer. Do not throw them away.

1

Remove your printer from the box and
remove all cushioning materials and the
plastic bag from your printer.

2

Remove the two strips of protective tape
(1) at the back of your printer.

2

2

Press the top cover open button (3) and
open the top cover (4).
3
4

1

3
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Take out all four image drums from the
printer.

1. Setup

Unpacking

Preparing Your Printer

1

4

6

Remove the protective sheets from four
image drums.

Turn the blue lever (7) of the toner
cartridge in direction of the arrow fully.
Turn the levers of all four 4 toner cartridges.

(1) Place an image drum on a
1. Setup

newspaper. Remove a tape (6) stuck
on a protective sheet (5) and open it.
6

5

(2) Pull out a protective sheet to the
direction of the arrow.

➋

7

7

Close the top cover (4) by pushing the
both sides of the cover firmly.
4

➊
Note

●● Do not turn the blue lever of the toner cartridge.

5

Put all four image drums back into a
printer.

8

Close the front cover (2).
Note

●● The front cover cannot be closed securely if the top cover
is not closed.
●● When the error message that the top or front cover is
open does not disappear from the operator panel’s display
screen, make sure they are closed securely.

2
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Preparing Your Printer

Installing Accessories

1

Install the supplied louver (1) on the air
vent on the side of the printer.

Reference

●● Please refer to “Supported Paper” P.59 for information
on how to load paper into the printer.

1

Pull out the paper tray (1).

1

1

Memo

●● Turn a louver to change a direction of air emitted from a
printer.

1

2

Set the paper size dial (2) to match the
loading paper size.
Set the dial to [A4
] when loading the A4 size
paper with a landscape orientation.

2

A4
A4
A5
A5
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1. Setup

If you want to adjust a direction of air emitted
from a printer, install a louver.

Loading Paper

Preparing Your Printer

1

3

Slide the paper guide (3) and paper
stopper (4) to the size of paper to be
loaded.

5

Load paper with the print side face down
and press it from above.
Note

1. Setup

●● Do not load paper exceeding the [▼] mark (5) of the
paper guide.
5

4
3
Note

●● When loading the A6 size paper, move the paper
stopper (4) forward and remove it once, then install
it on the metal part.
4

6

Secure the loaded paper with the paper
guide.

7

Check if a size of loaded paper matches
the setting of paper size dial.

8

Return the paper tray to the printer.
Memo

4

●● If loading a paper that you cannot select the
size with a paper size dial options, set the dial to
[Other], and then set a paper size on the operator
panel.

Flex paper back and forth, and then fan
it. Straighten the edges of the paper
stack on a level surface.
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Preparing Your Printer

Turning On/Off the Power

1

Plug the AC cord (1) into the AC power
socket of your printer.

The power supply must meet the following
conditions:
Current:
Frequency:

110 - 127 VAC (Range 99 - 140 VAC)
220 - 240 VAC (Range 198 - 264 VAC)
50/60 Hz ± 2%

1

Note

●● If the power supply is unstable, use a voltage regulator.
●● The maximum power consumption of this printer is
1400 W. Ensure that the power supply is sufficient to
operate this printer.
●● We do not guarantee operation where an uninterruptible
power system (UPS) or inverter is used. Do not use an
uninterruptible power system (UPS) or inverter.

WARNING

2

Plug the AC cord into the electric socket.

3

Hold down the power switch (2) for
about 1 second to turn on the power.

There is a risk of getting
an electric shock and/or
causing fire.

●● Be sure to turn off the power supply switch when
attaching or removing the AC cable and earth wire.
●● Be sure to connect an earth wire to the grounding
terminal of exclusive use.
●● Please do not connect with the ground of a water pipe,
a gas pipe, and a telephone wire, and a lightning rod by
any means.
●● Make sure to connect with the ground terminal before
connecting the power cord to the power supply plug.
●● Be sure to plug in and unplug the AC cable while holding
on to the power supply plug.
●● Insert the AC cable plug completely into the wall socket
securely.
●● Do not touch the power cord, or printer, if your hands
are wet.
●● Install a power cord in the place which is not stepped
on, and do not place a thing on a power cord.
●● Do not use the cord tied in a bundle.
●● Please do not use the damaged power cord.
●● Do not use multi-outlet adapters.
●● Do not connect this printer and other electric products
to the same wall socket. If it connects simultaneously
with an air conditioner, copier, shredder, etc. Especially,
a printer may incorrect-operate by the electric
noise. When you connect with the same wall socket
unavoidably, please use a commercial noise filter or a
commercial noise cut transformer.
●● Use the attached power cord and insert it directory with
the ground terminal. Do not use the power cord for
other product for the printer.
●● Do not use an extension cord. When you use it
unavoidably, use the thing more than rated 15 A.
●● Use of an extended code may not operate a printer
normally by AC voltage descent.
●● During printing, do not shut off a power supply or do not
pull out a power supply plug.
●● When you use it neither for consecutive holidays nor a
travel for a long time, pull out a power cord.
●● Do not use attached power cord to the other products.

2

The Power switch LED indicator lights up when
the printer turns on.
The message “Ready To Print” is displayed in
the operator panel once printer is ready.
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Power Supply Conditions

Turning On the Power

Preparing Your Printer

1

Turning Off the Power

Power Save Mode and Sleep Mode

1

Two-phase power conservation enables you to
save on power consumed by the printer.

1. Setup

Hold down the power switch (1) for
about a second.
The message “Shutting down Please wait.
Printer will turn off automatically” appears
in the operator panel, and the power switch
indicator blinks every 1 second. Then the printer
turns off automatically and the power switch
indicator goes out.

 Power Save Mode

When your printer is not used for a certain
period of time, it automatically enters the power
save mode to reduce the power consumption.
You can enter the power save mode manually
by pressing the <POWER SAVE> button on the
operator panel.

Note

●● It may take about 5 minutes to turn off the power. Wait
until it turns off.

The <POWER SAVE> button lights up green
while in this mode.

●● Holding down the power switch for more than 5 seconds
turns off printer forcibly. Only perform this procedure
when a problem occurs. For printer problems, refer to
“Other Issues” P.102.

Memo

●● By factory default, the time interval before entering the
power save mode is set to 1 minute. For how to change
the time that elapses before the printer enters the power
save mode, refer to “Setting the Time that Elapses Before
Entering the Power Save Mode” P.76.

1

 Sleep Mode
 When the Printer is Not Used for a
Long Time
When the printer is not used for a long time due
to consecutive holidays or when on vacation, or
when changing or attaching parts in repair or
maintenance, unplug the AC cord.
Memo

●● The printer will not be functionally impaired even if left
unplugged for a long time (more than 4 weeks).

Your printer goes from the power save mode to
the sleep mode after a set period of time.
In the sleep mode, the status of your printer is
almost the same as when it is turned off.
The <POWER SAVE> button blinks while in the
sleep mode.
Note

●● The printer does not enter the sleep mode if an error
occurs.
Memo

●● By factory default, the time interval before entering the
sleep mode is set to 15 minutes. For how to change the
time that elapses before the printer enters the sleep
mode, refer to “Setting the Time that Elapses Before
Entering the Sleep Mode” P.77.
Reference

●● For more detailed information on sleep mode, please refer
to the User’s Manual (Advanced).

 Restoring a Printer from the
Power Saving Mode

To restore the printer from the power save mode
or the sleep mode, press the <POWER SAVE>
button on the operator panel.
Memo

●● When the printer receives a print job from a computer or
other devices, it is restored automatically.
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Auto Power Off Function

Installing Options

When a certain period of time elapses after
printing, this printer will turn off automatically.
Memo

●● The factory default setting for time that elapses before the
printer power turns off automatically is 4 hours.
●● For how to change the time that elapses before the
printer power turns off automatically, refer to “Settings for
Turning Power Off Automatically (Auto Power Off)” P.80.
Note

●● In the factory default setting, the auto power off mode
is disabled during network connection. To enable the
auto power off mode during network connection, refer to
“Settings for Turning Power Off Automatically (Auto Power
Off)” P.80.

●● Additional tray unit (Tray 2/3/4)
●● Additional RAM (256 MB or 512 MB)
●● 16 GB SD memory card kit
Note

●● Be sure to turn off your printer and unplug the AC cord
and Ethernet or USB cable before installing options.
Installing options while your printer is turned on may
damage your printer and options.
Memo

●● After installing options, set the option settings with a
printer driver. Refer to “When Adding Options” P.56.

Installing an Additional Tray Unit
Install an optional additional tray unit when
you want to increase the paper capacity of your
printer. You can install up to three additional tray
units. After installation, you need to configure
the printer driver settings.

N35110A
Reference

●● For specifications of the additional tray unit, refer to
“Supported Paper” P.59.

CAUTION

It may cause injury!

●● At least two people are needed to lift the printer
safely because it weighs about 37 Kg or 40 Kg.

1

Turn off your printer, and then unplug
the AC cord and the Ethernet or USB
cable.
Reference

●● “Turning Off the Power” P.22
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1. Setup

This section explains how to install options on
your printer. The following options are available:

1

Preparing Your Printer

1

2

Stack an additional tray aligning a back
side of each tray.

●● Do not apply force to the printer’s top cover
while it is open.

1. Setup
●● Do not apply downward force to the paper tray
while it is pulled out.

3

Place a printer on the additional trays
gently aligning the back sides of a
printer and the additional trays.

●● Do not apply force to the printer from the back
while the paper tray is pulled out.

4

Plug the AC cord and Ethernet or USB
cable into your printer, and then turn on
the power switch.

- 24 -

Preparing Your Printer

3

Installing Additional RAM
Install additional RAM to increase the memory
capacity of your printer in cases such as if
memory overflow or the collate print errors
occur. Your printer supports 256 MB and 512 MB
RAM.

Slide the metal plate (2) upward to
remove.
Note

(1) Put your finger in the recess of the

Note

●● Use only genuine OKI products. The performance cannot
be guaranteed when using other products.
●● The static electricity may damage parts. Discharge the
static electricity from your body by touching grounded
metallic parts, etc., before work.

2

Memo

●● For banner printing, installing additional memory is
recommended.

(2) Pinch the lower part of the metal
plate (2), and pull it forward.

Turn off your printer, and then unplug
the AC cord and Ethernet or USB cable.
Reference

2

●● “Turning Off the Power” P.22

2

Open the access cover (1) on the right
side of a printer.

4

Make sure the LED (3) indicated by the
arrow turns off. If it is lit, wait until it
turns off.

1

3
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●● If the SD memory card socket is attached, remove
the SD memory card.

metal plate (2), and slide it upward.

1

1

Preparing Your Printer

1

5

Insert the additional RAM (4) into the
slot and fix it by pushing it toward the
printer.

7

Close the access cover (1).

1. Setup

Note

●● Be sure to check a direction of an additional RAM.
The additional RAM has small dents on its connector,
which are fitted with a connector of a slot.

1

8

Plug the AC cord and Ethernet or USB
cable into your printer, and then turn on
the power switch.

9

Press the <ENTER> button on the
operator panel.

4

6

Install the metal plate (2).

(1) First, insert the upper part of the

metal plate (2) in the printer, then
install the metal plate.

2

10 Check that [Configuration] is selected

➊

and press the <ENTER> button.

➋

䎩䏘䏑䏆䏗䏌䏒䏑䏖䎃䎃䎃䎃䎃䎃䎔䎒䎕
䎦䏒䏑䏉䏌䏊䏘䏕䏄䏗䏌䏒䏑
䎳䏕䏌䏑䏗䎃䎬䏑䏉䏒䏕䏐䏄䏗䏌䏒䏑
䎳䏕䏌䏑䏗䎃䎶䏈䏆䏘䏕䏈䎃䎭䏒䏅
䎰䏈䏑䏘䏖

(2) While holding the lower part of the

metal plate (2), slide the metal plate
downward and secure it.

11 Press the scroll button

several times
to select [System] and press the
<ENTER> button.

2

➋

䎦䏒䏑䏉䏌䏊䏘䏕䏄䏗䏌䏒䏑䎃䎃䎃䎔䎒䎔
䎷䏕䏄䏜䎃䎦䏒䏘䏑䏗
䎶䏘䏓䏓䏏䏌䏈䏖䎃䎯䏌䏉䏈
䎱䏈䏗䏚䏒䏕䏎
䎶䏜䏖䏗䏈䏐

➊

Note

●● Attach the SD memory card socket before installing
the metal plate if the SD memory card socket was
attached to the printer.
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12 Press the scroll button

Installing the 16-GB SD Memory
Card Kit

several times
to select [Total Memory] and press the
<ENTER> button.
䎶䏜䏖䏗䏈䏐䎃䎃䎃䎃䎃䎃䎃䎕䎒䎕
䎷䏒䏗䏄䏏䎃䎰䏈䏐䏒䏕䏜
䎩䏏䏄䏖䏋䎃䎰䏈䏐䏒䏕䏜
䎶䎧䎃䎦䏄䏕䏇

13 Check that the value of [Total Memory]

SD memory card

has increased.

䎷䏒䏗䏄䏏䎃䎰䏈䏐䏒䏕䏜䫹䎃䎔䎒䎔
䎚䎙䎛䎰䎥

SD memory socket
Memo

●● The SD memory socket is attached to the SD memory
card.
Note

-- For memory expanded to 256 MB, it is
[512 MB]; for memory expanded to 512
MB, it is [768 MB].
Note

●● Use only genuine OKI products. The performance cannot
be guaranteed when using other products.
●● The static electricity may cause damage to the parts.
Discharge the static electricity in your body by touching
grounded metallic parts, etc. before work.

●● If the value of [Total Memory] has not increased, turn
off your printer and unplug the AC cord and Ethernet or
USB cable, and then reinstall the additional RAM.

●● You can not use the SD memory card with the protection
switch for accidental overwriting locked. Make sure to
release the lock.

14 Press the <ON LINE> button.

1

Turn off your printer, and then unplug
the AC cord and Ethernet or USB cable.
Reference

●● “Turning Off the Power” P.22

2

Open the access cover (1).

1
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For storing print data or a secure printing, install
the SD memory card kit.

1

Preparing Your Printer

1

3

Remove the metal plate (2) by sliding it
upward.

5

Install the SD memory card (4) into the
SD memory card socket (5).

(1) Put your finger in the recess of the
1. Setup

metal plate (2), and slide it upward.

4

5

2

6
(2) Pinch the lower part of the metal
plate (2), and pull it forward.

Install the SD memory socket to the
printer with the screw (6) and tab (7) for
the SD memory card socket and attach
the connector (8).

2
8

7

4

Make sure the LED (3) indicated by the
arrow turns off. If it is lit, wait until it
turns off.

6

7

Install the metal plate (2).

(1) First, insert the upper part of the

metal plate (2) in the printer, then
install the metal plate.

2
3

➊
➋
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(2) While holding the lower part of the

metal plate (2), slide the metal plate
downward and secure it.

12 Press the scroll button

several times
to select [System] and press the
<ENTER> button.

➋

䎦䏒䏑䏉䏌䏊䏘䏕䏄䏗䏌䏒䏑䎃䎃䎃䎔䎒䎔
䎷䏕䏄䏜䎃䎦䏒䏘䏑䏗
䎶䏘䏓䏓䏏䏌䏈䏖䎃䎯䏌䏉䏈
䎱䏈䏗䏚䏒䏕䏎
䎶䏜䏖䏗䏈䏐

➊
13 Press the scroll button

several times
to select [SD Card] and press the
<ENTER> button.

8

Close the access cover (1).

䎶䏜䏖䏗䏈䏐䎃䎃䎃䎃䎃䎃䎕䎒䎕
䎷䏒䏗䏄䏏䎃䎰䏈䏐䏒䏕䏜
䎩䏏䏄䏖䏋䎃䎰䏈䏐䏒䏕䏜
䎶䎧䎃䎦䏄䏕䏇

14 Check that the value of [SD Card] is
[16 GB].

1

9

䎶䎧䎃䎦䏄䏕䏇䫹䫹䫹䎃䎔䎒䎔
䎔䎘䎪䎥䎾䎩䎘䎕䏀

Plug the AC cord and Ethernet or USB
cable into your printer, and then turn on
the power switch.

10 Press the <ENTER> button on the
operator panel.

Note

●● [15 GB] may be displayed in [SD Card]. This is not an
error.
●● If the value of [SD Card] has not increased, turn off
your printer and unplug the AC cord and Ethernet or USB
cable, and then reinstall the SD memory card.

15 Press the <ON LINE> button.

11 Check that [Configuration] is selected
and press the <ENTER> button.
䎩䏘䏑䏆䏗䏌䏒䏑䏖䎃䎃䎃䎃䎃䎃䎔䎒䎕
䎦䏒䏑䏉䏌䏊䏘䏕䏄䏗䏌䏒䏑
䎳䏕䏌䏑䏗䎃䎬䏑䏉䏒䏕䏐䏄䏗䏌䏒䏑
䎳䏕䏌䏑䏗䎃䎶䏈䏆䏘䏕䏈䎃䎭䏒䏅
䎰䏈䏑䏘䏖
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2

1

Preparing Your Printer

1

Test Printing from the Printer

1. Setup

Check that you can print with the printer. Check
the detailed settings and status of your printer
by printing the contents of the settings (Menu
Map).
Note

●● When a printer is in the power saving mode, press the
<POWER SAVE> button to restore from the mode.

1

Press the <Fn> key on the operator
panel.

2

Enter “100” using the ten-key pad and
press the <ENTER> button.

䎩䏘䏑䏆䏗䏌䏒䏑䎃䎱䏘䏐䏅䏈䏕

䎨䏑䏗䏈䏕䎃䎔䎐䎖䏇䏌䏊䏌䏗䎃䎱䏘䏐䏅䏈䏕

3

Press the <ENTER> button as
[Execute] is selected.
䎦䏒䏑䏉䏌䏊䏘䏕䏄䏗䏌䏒䏑䎃䎃䎃䎔䎒䎔
䎨䏛䏈䏆䏘䏗䏈

4

After finishing a print of printer settings,
a setup for printing from a printer
completes.
Reference

●● You can also print reports and lists for each function.
Refer to the User’s Manual (Advanced).
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Connecting to a Computer

●●
Connecting to a Computer
Prepare a computer with a DVD drive.

 Connection Method

You can select either of the following connection methods:
●● “Network Connection” P.32
●● “USB Connection” P.52

 Product Requirements

Your printer supports the following operating systems:
●● Windows 7/Windows 7 (64bit Version)
●● Windows Vista/Windows Vista (64bit Version)
●● Windows Server 2008 R2
●● Windows Server 2008/Windows Server 2008 (x64 Version)
●● Windows XP/Windows XP (x64 Version)
●● Windows Server 2003/Windows Server 2003 (x64 Version)
●● Windows 2000
●● Mac OS X 10.3.9 to 10.7

 Types of Drivers

The types of the drivers that can be installed are as follows.
●● For Windows
Type
PCL

Description
The PCL printer driver is suitable for printing of business documents. For Windows XP/Windows
2000, Internet Explorer 6.0 or later (MSXML 4.0 or later) must be installed.
The PS printer driver is suitable for printing of documents including PostScript fonts and EPS data.
The XPS printer driver is suitable for printing from an application for XPS.

PS
XPS

* Windows XP/ Windows Server 2003 and Windows 2000 are not supported.

●● For Mac OS X
Type
PS

Description
The PS printer driver is suitable for printing of documents including PostScript fonts and EPS data.
It can be also used for normal printing.

Note

●● Depending on the printer driver version or the version of Windows or Mac OS X, the description may be different.
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1. Setup

This section explains how to connect your printer to a computer and install a printer driver software
using the provided “Software DVD-ROM”.

1

Connecting to a Computer

1

Installing a Printer Driver
(for Windows)

Network Connection

1. Setup

Perform the following procedure to connect your
printer to a computer via network.

Connecting an Ethernet Cable

To complete the network connection with a
Windows computer, first set IP addresses for the
printer, and then install a printer driver on the
computer.

Be sure to connect your printer to a network
with an Ethernet cable before driver installation.

If there is no DHCP server or BOOTP server on
the network, you need to manually configure the
IP address on the computer or printer.

1

If your network administrator or internet service
provider specifies an unique IP address for the
computer and your printer, you need to set the
IP addresses manually.

Prepare an Ethernet cable (1) and a hub
(2).
Prepare an Ethernet cable (category 5, twisted
pair, straight) and a hub separately.

Note

1

●● You need to complete the network setting of the computer
before this procedure.
2

2

Turn off your printer and computer.
Reference

●● To complete this procedure, you must be logged in as an
administrator.
●● When setting an IP address manually, ask the network
administrator or your internet service provider which
IP address to use. If the IP address is set wrong, the
network may go down or Internet access may be disabled.

●● “Turning Off the Power” P.22

3

4

Plug one end of the Ethernet cable into
the network interface connection (3) on
the back of the printer.

Memo

●● If configuring a small network consisting of only your
printer and a computer, set IP addresses as shown below
(according to RFC1918).
For the computer

Plug the other end of the Ethernet cable
into the hub (2).

IP address :

192.168.0.1 - 254

Subnet mask :

255.255.255.0

Default gateway :

not used

DNS server :

not used

For the printer
2

IP address Set :

Manual

IP address:

192.168.0.1 - 254 (select a
different value from that of the
computer)

Subnet Mask :

255.255.255.0

Default Gateway :

0.0.0.0

Network Scale :

Small

●● To set [Network Scale], press the <ENTER> button
and then select [Admin Setup] > [Network Setup] >
[Network Scale].

3
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7

First, Set the IP address of the printer.
Turn on the printer.

2

Press the <ENTER> button on the
operator panel.

䎱䏈䏗䏚䏒䏕䏎䎃䎶䏈䏗䏘䏓䎃䎃䎕䎒䎘
䎨䏗䏋䏈䏕䎃䎷䏄䏏䏎
䎬䎳䎃䎤䏇䏇䏕䏈䏖䏖䎃䎶䏈䏗
䎬䎳䏙䎗䎃䎤䏇䏇䏕䏈䏖䏖
䎶䏘䏅䏑䏈䏗䎃䎰䏄䏖䏎

8
3

Press the scroll button to select
[Admin Setup], and press the
<ENTER> button.

If setting the IP address manually, press
the scroll button and select [Manual],
and press the <ENTER> button.
Proceed to the step 9.
䎬䎳䎃䎤䏇䏇䏕䏈䏖䏖䎃䎶䏈䏗䎃䎃䎃䎔䎒䎔
䎤䏘䏗䏒
䎍䎃䎃䎰䏄䏑䏘䏄䏏

䎩䏘䏑䏆䏗䏌䏒䏑䏖䎃䎃䎃䎃䎃䎃䎕䎒䎕
䎤䏇䏐䏌䏑䎃䎶䏈䏗䏘䏓
䫹䎦䏄䏏䏌䏅䏕䏄䏗䏌䏒䏑

If obtaining the IP address automatically, check
that [Auto] is selected, and press the <ENTER>
button.

4

Enter the administrator password, using
the numeric (0-9) keys.

Proceed to the step 15.

The factory default password is “aaaaaa”. Press
<ENTER> button after each character you input.

䎬䎳䎃䎤䏇䏇䏕䏈䏖䏖䎃䎶䏈䏗䎃䎃䎔䎒䎔
䎍䎃䎃䎤䏘䏗䏒
䎰䏄䏑䏘䏄䏏

䎨䏑䏗䏈䏕䎃䎳䏄䏖䏖䏚䏒䏕䏇

䯴䎙䎐䎔䎕䏇䏌䏊䏌䏗䏖䎌

9
5

Press the <ENTER> button.

Press the <BACK> button until
[Network Setup] is displayed.
Press the scroll button to select
[IPv4 Address], and press the
<ENTER> button.
䎱䏈䏗䏚䏒䏕䏎䎃䎶䏈䏗䏘䏓䫹䎕䎒䎘
䎬䎳䎃䎤䏇䏇䏕䏈䏖䏖䎃䎶䏈䏗
䎬䎳䏙䎗䎃䎤䏇䏇䏕䏈䏖䏖
䎶䏘䏅䏑䏈䏗䎃䎰䏄䏖䏎
䎪䏄䏗䏈䏚䏄䏜䎃䎤䏇䏇䏕䏈䏖䏖

6

Check that [Network Setup] is selected
and press the <ENTER> button.
䎤䏇䏐䏌䏑䎃䎶䏈䏗䏘䏓䎃䎃䎃䎃䎔䎒䎗
䎱䏈䏗䏚䏒䏕䏎䎃䎶䏈䏗䏘䏓
䎳䏕䏌䏑䏗䎃䎶䏈䏗䏘䏓
䎳䎶䎃䎶䏈䏗䏘䏓
䎳䎦䎯䎃䎶䏈䏗䏘䏓
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1
1. Setup

1

Press the to select [IP Address Set],
and press the <ENTER> button.

Connecting to a Computer

1

10 Enter the IP address using the numeric
(0-9) keys, and press the <ENTER>
button.

14 Enter the default gateway address and
press the <ENTER> button.

To move to the next box, press the <ENTER>
button.

1. Setup

To move to the next box, press the <ENTER>
button.

After entering all settings, press the <BACK>
button.

䎬䎳䏙䎗䎃䎤䏇䏇䏕䏈䏖䏖

㪅 㪅 㪅

㪈㪐㪉 㩷㩷㪈㪍㪏 㩷㩷㩷㩷㪇 㩷㩷㩷㩷㪉
㩷

䎪䏄䏗䏈䏚䏄䏜䎃䎤䏇䏇䏕䏈䏖䏖

㪅 㪅㩷㩷㩷㩷㩷㪇㪅㩷㪉㪌㪋

㪈㪐㪉 㩷㪈㪍㪏
㩷

11 Press the <BACK> button until

[Network Setup] is displayed.
Press the scroll button to select
[Subnet Mask], and press the
<ENTER> button.

15 When the setup menu screen is

displayed, press the <ON LINE> button
to complete the network settings.

䎱䏈䏗䏚䏒䏕䏎䎃䎶䏈䏗䏘䏓䫹䎕䎒䎘
䎬䎳䱂䎗䎃䎤䏇䏇䏕䏈䏖䏖
䎶䏘䏅䏑䏈䏗䎃䎰䏄䏖䏎
䎪䏄䏗䏈䏚䏄䏜䎃䎤䏇䏇䏕䏈䏖䏖
䰣䏈䏅

12 Enter the subnet mask in the same
manner of IP address.

To move to the next box, press the <ENTER>
button.

䎶䏘䏅䏑䏈䏗䎃䎰䏄䏖䏎

㪅 㪅 㪅

㪁䇭㪉㪌㪌 㩷㪉㪌㪌 㩷㪉㪌㪌 㩷㪉㪌㪌
㩷

13 Press the <BACK> button until

[Network Setup] is displayed.
Press the scroll button to select
[Gateway Address], and press the
<ENTER> button.
䎱䏈䏗䏚䏒䏕䏎䎃䎶䏈䏗䏘䏓䎃䎖䎒䎘
䎶䏘䏅䏑䏈䏗䎃䎰䏄䏖䏎
䎪䏄䏗䏈䏚䏄䏜䎃䎤䏇䏇䏕䏈䏖䏖
䎺䏈䏅
䎷䏈䏏䏑䏈䏗
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Next, install the printer driver on the
computer.

1

7

Select a check box for the driver to
install from [PCL driver], [PS driver]
or [XPS driver] under [Software].

8

Click the install bunch button on the top.

1. Setup

Ensure that your printer and the
computer are turned on and connected,
and then insert the “Software DVD-ROM”
into the computer.
Reference

●● “Connecting an Ethernet Cable” P.32

2

Click [Run Setup.exe] after
[Auto Play] is displayed.
If the [User Account Control] dialog box
appears, click [Yes].

3

Select the language, and then click
[Next].

Memo

●● To batch install software, select check boxes of
software to be installed.
To install software separately, click the install
button on the right side of each item, and follow the
instructions displayed on a screen.

Icon

Description
Click
to install the drivers and/or
software that have been check-box
selected.
Click
on the right side of each
item to install driver or software
individually.

4

Select the model of your printer, and
then click [Next].

Install bunch button

Install buttons (separately)

Installation starts.

5
6

Read the license agreement and then
click [I Agree].
Read the [Environmental advice for
Users] and then click [Next].

1

Memo

●● Color Correct Utility also installed simultaneously
with printer driver.

9
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If the [Windows Security] dialog box
appears, click [Install this driver
software anyway].

Connecting to a Computer

1

10 Click [Network].

13 Click [Exit] to complete the installation.

The device search starts.

1. Setup
Note

●● If the dialog box prompting to restart the computer
appears, click [Yes]. The computer automatically
restarts.

-- If the printer is detected, the software is
automatically installed. Proceed to step
12.
-- If the printer is not detected, the
[Installation settings] screen is
displayed. Proceed to step 11.

11 Click [Restart search] to restart the

Reference

●● For how to configure the tray settings by the driver,
refer to “When Adding Options” P.56.

14 Click [Start] > [Devices and Printers].
15 Check that the [OKI C831] icon is
displayed.

device search.

After the printer is displayed, select the printer
and click [Next].

Right-click the [OKI C831] icon and select one
of the menu items, and then check that all the
printer drivers installed are displayed in the
submenu.

16 Remove the “Software DVD-ROM” from
the computer.

Finish by test printing from a computer.

1

Open a printer driver property.

2

Click Test Print.
The installation is complete.

Memo

●● If the printer is not displayed by clicking [Restart
search], select [IP address] and enter the IP
address assigned to your printer, and then click
[Next].

If installing the options such as an
additional tray unit or the SD memory
card kit, specify the settings with a printer
driver. Refer to “When Adding Options”
P.56.

12 If the [Windows Security] dialog box
appears, click [Install this driver
software anyway].
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Installing a Printer Driver
(For Mac OS X)

4

Enter the administrator password, using
the numeric (0-9) keys.

Select the protocol for your network connection
from the following:

䎨䏑䏗䏈䏕䎃䎳䏄䏖䏖䏚䏒䏕䏇

䯴䎙䎐䎔䎕䏇䏌䏊䏌䏗䏖䎌

●● EtherTalk
●● Bonjour (Rendezvous for Mac OS X 10.3)
Note

●● EtherTalk is not supported in Mac OS X 10.6.
●● Disable the anti-virus software before starting this
procedure.

5

Press the <ENTER> button.

6

Check that [Network Setup] is selected
and press the <ENTER> button.

 Using EtherTalk (For Mac OS X
10.5)

When connecting to the network with EtherTalk,
it is necessary to enable EtherTalk and disable
the sleep mode on the printer. After doing that,
install the driver on the computer.

First, enable EtherTalk and disable the
sleep mode on the printer.

1

䎤䏇䏐䏌䏑䎃䎶䏈䏗䏘䏓䎃䎃䎃䎃䎔䎒䎗
䎱䏈䏗䏚䏒䏕䏎䎃䎶䏈䏗䏘䏓
䎳䏕䏌䏑䏗䎃䎶䏈䏗䏘䏓
䎳䎶䎃䎶䏈䏗䏘䏓
䎳䎦䎯䎃䎶䏈䏗䏘䏓

Ensure that your printer and the
computer are turned on and connected.
Reference

●● “Connecting an Ethernet Cable” P.32

2

Press the <ENTER> button on the
operator panel.

7

Press the scroll button several times
to select [EtherTalk], and press the
<ENTER> button.
䎱䏈䏗䏚䏒䏕䏎䎃䎶䏈䏗䏘䏓䎃䎃䎕䎒䎘
䎨䏗䏋䏈䏕䎷䏄䏏䏎
䎬䎳䎃䎤䏇䏇䏕䏈䏖䏖䎃䎶䏈䏗
䎬䎳䏙䎗䎃䎤䏇䏇䏕䏈䏖䏖
䎶䏘䏅䏑䏈䏗䎃䎰䏄䏖䏎

3

Press the scroll button several times
to select [Admin Setup], and press the
<ENTER> button.

8

䎩䏘䏑䏆䏗䏌䏒䏑䏖䎃䎃䎃䎃䎃䎃䎕䎒䎕
䎤䏇䏐䏌䏑䎃䎶䏈䏗䏘䏓
䫹䎦䏄䏏䏌䏅䏕䏄䏗䏌䏒䏑

Press the scroll button to select
[Enable], and press the <ENTER>
button.
䎨䏗䏋䏈䏕䎷䏄䏏䏎䎃䎃䎃䎃䎃䎃䎃䎔䎒䎔
䎍䎃䎃䎨䏑䏄䏅䏏䏈
䎧䏌䏖䏄䏅䏏䏈
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1. Setup

The factory default password is “aaaaaa”. Press
the <ENTER> button after each character you
input.

To complete the network connection with a Mac
operating system, install a printer driver on the
computer and set your printer as a network
printer.

1

Connecting to a Computer

1

9

Press the <BACK> button until
[Network Setup] is displayed.

14 Press the <ON LINE> button to exit the
menu mode.

1. Setup

䎱䏈䏗䏚䏒䏕䏎䎃䎶䏈䏗䏘䏓䎃䎃䎕䎒䎘
䎨䏗䏋䏈䏕䎷䏄䏏䏎
䎬䎳䎃䎤䏇䏇䏕䏈䏖䏖䎃䎶䏈䏗
䎬䎳䏙䎗䎃䎤䏇䏇䏕䏈䏖䏖
䎶䏘䏅䏑䏈䏗䎃䎰䏄䏖䏎

10 Press the <BACK> button until
[Admin Setup] is displayed.
䎤䏇䏐䏌䏑䎃䎶䏈䏗䏘䏓䎃䎃䎃䎃䎔䎒䎗
䎱䏈䏗䏚䏒䏕䏎䎃䎶䏈䏗䏘䏓
䎳䏕䏌䏑䏗䎃䎶䏈䏗䏘䏓
䎳䎶䎃䎶䏈䏗䏘䏓
䎳䎦䎯䎃䎶䏈䏗䏘䏓

Then, install the printer driver on the
computer.

1

Insert the “Software DVD-ROM” into the
computer.

2

Double-click the [OKI] icon on the
desktop.

3

Double-click [Driver] >
[C841_C831_ES84x1] >
[Installer for Mac OSX].

4

Enter the administrator’s password for
Mac OS X, and then click [OK].

11 Press the scroll button

several times
to select [Power Setup], and press the
<ENTER> button.
䎤䏇䏐䏌䏑䎃䎶䏈䏗䏘䏓䎃䎃䎃䎃䎃䎖䎒䎗
䎰䏈䏐䏒䏕䏜䎃䎶䏈䏗䏘䏓
䎶䏜䏖䏗䏈䏐䎃䎶䏈䏗䏘䏓
䎥䏘䏝䏝䏈䏕䎃䎶䏈䏗䏘䏓
䎳䏒䏚䏈䏕䎃䎶䏈䏗䏘䏓

12 Press the scroll button

to select
[Sleep], and press the <ENTER>
button.

Follow the instructions displayed on the screen to
complete the installation.

5

From the Apple menu, select [System
Preferences].

6

Click [Print & Fax].

7

Click [+].

䎳䏒䏚䏈䏕䎃䎶䏈䏗䏘䏓䎃䎃䎃䎔䎒䎔
䎳䏒䏚䏈䏕䎃䎶䏄䏙䏈
䎶䏏䏈䏈䏓
䎤䏘䏗䏒䎃䎳䏒䏚䏈䏕䎃䎲䏉䏉

13 Press the scroll button

to select
[Disable], and press the <ENTER>
button.
䎶䏏䏈䏈䏓䎃䎃䎃䎃䎃䎃䎃䎃䎃䎔䎒䎔
䎨䏑䏄䏅䏏䏈
䎍䎃䎃䎧䏌䏖䏄䏅䏏䏈
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8

Click [AppleTalk].

Next, enable the sleep mode on the
printer.
Note

1

●● If using the EtherTalk, disable the sleep mode.

Press the <ENTER> button on the
operator panel.

2

Press the scroll button several times
to select [Admin Setup], and then
press the <ENTER> button.

Select the name of your printer and then
check that [OKI C831(PS)] is displayed
in [Print Using].

䎩䏘䏑䏆䏗䏌䏒䏑䏖䎃䎃䎃䎃䎃䎃䎕䎒䎕
䎤䏇䏐䏌䏑䎃䎶䏈䏗䏘䏓
䫹䎦䏄䏏䏌䏅䏕䏄䏗䏌䏒䏑

10 Click [Add].
11 Check that your printer is displayed

in [Printers] and [OKI C831(PS)] is
displayed in [Kind].

3

Enter the administrator password, using
the numeric (0-9) keys.
The factory default password is “aaaaaa”. Press
the <ENTER> button after each character you
input.

䎨䏑䏗䏈䏕䎃䎳䏄䏖䏖䏚䏒䏕䏇

䯴䎙䎐䎔䎕䏇䏌䏊䏌䏗䏖䎌

4
Note

●● If [OKI C831(PS)] is not correctly displayed in
[Kind], click [-] to remove your printer from [Print
& Fax] and then redo the procedure from steps 7 to
10.

12 Close [Print & Fax].
13 Remove “Software DVD-ROM” from the
computer.
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Press the <ENTER> button.

1. Setup

9

1

Connecting to a Computer

1

5

Finish by test printing from a computer.

Press the scroll button several times
to select [Power Setup], and press the
<ENTER> button.

1. Setup

䎤䏇䏐䏌䏑䎃䎶䏈䏗䏘䏓䎃䎃䎃䎃䎃䎖䎒䎗
䎰䏈䏐䏒䏕䏜䎃䎶䏈䏗䏘䏓
䎶䏜䏖䏗䏈䏐䎃䎶䏈䏗䏘䏓
䎥䏘䏝䏝䏈䏕䎃䎶䏈䏗䏘䏓
䎳䏒䏚䏈䏕䎃䎶䏈䏗䏘䏓

6

1

Start up [TextEdit].

2

Open an appropriate file.

3

Start printing.
The installation is complete.

If installing the options such as an
additional tray unit or the SD memory
card kit, specify the settings with a printer
driver. Refer to “When Adding Options”
P.56.

Press the scroll button to select
[Sleep], and press the <ENTER>
button.
䎳䏒䏚䏈䏕䎃䎶䏈䏗䏘䏓䎃䎃䎃䎔䎒䎔
䎳䏒䏚䏈䏕䎃䎶䏄䏙䏈
䎶䏏䏈䏈䏓
䎤䏘䏗䏒䎃䎳䏒䏚䏈䏕䎃䎲䏉䏉

7

Press the scroll button to select
[Enable], and press the <ENTER>
button.
䎶䏏䏈䏈䏓䎃䎃䎃䎃䎃䎃䎃䎃䎃䎔䎒䎔
䎍䎃䎃䎨䏑䏄䏅䏏䏈
䎧䏌䏖䏄䏅䏏䏈

8

Press the <ON LINE> button to exit the
menu mode.
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 Using EtherTalk
(For Mac OS X 10.3.9 to 10.4.11)

5

Press the <ENTER> button.

6

Check that [Network Setup] is selected
and press the <ENTER> button.

1. Setup

When connecting to the network with EtherTalk,
it is necessary to enable EtherTalk and disable
the sleep mode on the printer. After doing that,
install the driver on the computer.
Memo

●● The following procedure uses Mac OS X 10.4.11 as an
example. Depending on an OS, the description may be
different.

First, enable EtherTalk and disable the
sleep mode on the printer.

1

䎤䏇䏐䏌䏑䎃䎶䏈䏗䏘䏓䎃䎃䎃䎃䎔䎒䎗
䎱䏈䏗䏚䏒䏕䏎䎃䎶䏈䏗䏘䏓
䎳䏕䏌䏑䏗䎃䎶䏈䏗䏘䏓
䎳䎶䎃䎶䏈䏗䏘䏓
䎳䎦䎯䎃䎶䏈䏗䏘䏓

Ensure that your printer and the
computer are turned on and connected.
Reference

●● “Connecting an Ethernet Cable” P.32

2

Press the <ENTER> button on the
operator panel.

7

Press the scroll button several times
to select [EtherTalk], and press the
<ENTER> button.
䎱䏈䏗䏚䏒䏕䏎䎃䎶䏈䏗䏘䏓䎃䎃䎕䎒䎘
䎨䏗䏋䏈䏕䎷䏄䏏䏎
䎬䎳䎃䎤䏇䏇䏕䏈䏖䏖䎃䎶䏈䏗
䎬䎳䏙䎗䎃䎤䏇䏇䏕䏈䏖䏖
䎶䏘䏅䏑䏈䏗䎃䎰䏄䏖䏎

3

Press the scroll button several times
to select [Admin Setup], and press the
<ENTER> button.

8
䎩䏘䏑䏆䏗䏌䏒䏑䏖䎃䎃䎃䎃䎃䎃䎕䎒䎕
䎤䏇䏐䏌䏑䎃䎶䏈䏗䏘䏓
䫹䎦䏄䏏䏌䏅䏕䏄䏗䏌䏒䏑

Press the scroll button to select
[Enable], and press the <ENTER>
button.
䎨䏗䏋䏈䏕䎷䏄䏏䏎䎃䎃䎃䎃䎃䎃䎃䎔䎒䎔
䎍䎃䎃䎨䏑䏄䏅䏏䏈
䎧䏌䏖䏄䏅䏏䏈

4

Enter the administrator password, using
the numeric (0-9) keys.
The factory default password is “aaaaaa” Press
the <ENTER> button after each character you
input.

1

9

Press the <BACK> button until
[Network Setup] is displayed.
䎱䏈䏗䏚䏒䏕䏎䎃䎶䏈䏗䏘䏓䎃䎃䎕䎒䎘
䎨䏗䏋䏈䏕䎷䏄䏏䏎
䎬䎳䎃䎤䏇䏇䏕䏈䏖䏖䎃䎶䏈䏗
䎬䎳䏙䎗䎃䎤䏇䏇䏕䏈䏖䏖
䎶䏘䏅䏑䏈䏗䎃䎰䏄䏖䏎

䎨䏑䏗䏈䏕䎃䎳䏄䏖䏖䏚䏒䏕䏇

䯴䎙䎐䎔䎕䏇䏌䏊䏌䏗䏖䎌

- 41 -

Connecting to a Computer

1

10 Press the <BACK> button until

Then, install the printer driver on the
computer.

[Admin Setup] is displayed.

1. Setup

䎤䏇䏐䏌䏑䎃䎶䏈䏗䏘䏓䎃䎃䎃䎃䎔䎒䎗
䎱䏈䏗䏚䏒䏕䏎䎃䎶䏈䏗䏘䏓
䎳䏕䏌䏑䏗䎃䎶䏈䏗䏘䏓
䎳䎶䎃䎶䏈䏗䏘䏓
䎳䎦䎯䎃䎶䏈䏗䏘䏓

1

From the Apple menu, select [System
Preferences].

2

Select [Network].

3

Select [Network Port Configurations]
from [Show], and then check that
[Built-in Ethernet] is selected.

4

Select [Built-in Ethernet] from [Show]
and select the [AppleTalk] tab, and
then check that [Make AppleTalk
Active] is selected.

5

Close [Network].

6

Insert “Software DVD-ROM” in the
computer.

7

Double-click the [OKI] icon on the
desktop.

8

Double-click [Driver] folder >
[C841_C831_ES84x1] folder >
[Installer for Mac OSX].

11 Press the scroll button

several times
to select [Power Setup], and press the
<ENTER> button.
䎤䏇䏐䏌䏑䎃䎶䏈䏗䏘䏓䎃䎃䎃䎃䎃䎖䎒䎗
䎰䏈䏐䏒䏕䏜䎃䎶䏈䏗䏘䏓
䎶䏜䏖䏗䏈䏐䎃䎶䏈䏗䏘䏓
䎥䏘䏝䏝䏈䏕䎃䎶䏈䏗䏘䏓
䎳䏒䏚䏈䏕䎃䎶䏈䏗䏘䏓

12 Press the scroll button

to select
[Sleep], and press the <ENTER>
button.
䎳䏒䏚䏈䏕䎃䎶䏈䏗䏘䏓䎃䎃䎃䎔䎒䎔
䎳䏒䏚䏈䏕䎃䎶䏄䏙䏈
䎶䏏䏈䏈䏓
䎤䏘䏗䏒䎃䎳䏒䏚䏈䏕䎃䎲䏉䏉

13 Press the scroll button

to select
[Disable], and press the <ENTER>
button.
䎶䏏䏈䏈䏓䎃䎃䎃䎃䎃䎃䎃䎃䎃䎔䎒䎔
䎨䏑䏄䏅䏏䏈
䎍䎃䎃䎧䏌䏖䏄䏅䏏䏈

14 Press the <ON LINE> button to exit the
menu mode.
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9

14 Check that the name of your printer is

Enter the administrator’s password for
MacOS X, and then click [OK].

displayed in [Printer List], and then
close the window.

Follow the instructions displayed on the screen to
complete the installation.

1. Setup

10 From the [Go] menu, select [Utilities]
and then double-click [Printer Setup
Utility].
Note

●● If [Printer Setup Utility] is already running, close it
and open it again.

15 From the [Go] menu, select

[Applications] and then double-click
[TextEdit].

11 Click [Add].

16 Select the [File] menu > [Page Setup].
17 Select the name of your printer from
[Format for].

18 Check that the [OKI C831(PS)] is

If the [You have no printers available] dialog
box appears, click [Add].

displayed correctly under [Format for].

12 Select the name of the printer where

[Connection] is [AppleTalk], and then
check that [OKI C831(PS)] is displayed
in [Print Using].

19 Click [OK].
20 Remove “Software DVD-ROM” from the
computer.

Next, enable the sleep mode on the
printer.
Note

●● If using the EtherTalk, disable the sleep mode.

1
For Mac OS X 10.3.9, set as follows.

a

Select [AppleTalk] from the pop-up
menu.

b

Select the printer from the list.

c

Select [Oki] from [Printer Model]
and then select [OKI C831(PS)]
from the driver list.

1

13 Click [Add].
- 43 -

Press the <ENTER> button on the
operator panel.

Connecting to a Computer

1

2

Press the scroll button several times
to select [Admin Setup], and then
press the <ENTER> button.

7

1. Setup

䎩䏘䏑䏆䏗䏌䏒䏑䏖䎃䎃䎃䎃䎃䎃䎕䎒䎕
䎤䏇䏐䏌䏑䎃䎶䏈䏗䏘䏓
䫹䎦䏄䏏䏌䏅䏕䏄䏗䏌䏒䏑

3

Enter the administrator password, using
the numeric (0-9) keys.

Press the scroll button to select
[Enable], and press the <ENTER>
button.
䎶䏏䏈䏈䏓䎃䎃䎃䎃䎃䎃䎃䎃䎃䎔䎒䎔
䎍䎃䎃䎨䏑䏄䏅䏏䏈
䎧䏌䏖䏄䏅䏏䏈

8

Press the <ON LINE> button to exit the
menu mode.

The factory default password is “aaaaaa”. Press
the <ENTER> button after each character you
input.

䎨䏑䏗䏈䏕䎃䎳䏄䏖䏖䏚䏒䏕䏇

䯴䎙䎐䎔䎕䏇䏌䏊䏌䏗䏖䎌

Finish by test printing from a computer.

4

Press the <ENTER> button.

1

Start up [TextEdit].

2

Open an appropriate file.

3

Start printing.
The installation is complete.

5

Press the scroll button several times
to select [Power Setup], and press the
<ENTER> button.

If installing the options such as an
additional tray unit or the SD memory
card kit, specify the settings with a printer
driver. Refer to “When Adding Options”
P.56.

䎤䏇䏐䏌䏑䎃䎶䏈䏗䏘䏓䎃䎃䎃䎃䎃䎖䎒䎗
䎰䏈䏐䏒䏕䏜䎃䎶䏈䏗䏘䏓
䎶䏜䏖䏗䏈䏐䎃䎶䏈䏗䏘䏓
䎥䏘䏝䏝䏈䏕䎃䎶䏈䏗䏘䏓
䎳䏒䏚䏈䏕䎃䎶䏈䏗䏘䏓

6

Press the scroll button to select
[Sleep], and press the <ENTER>
button.
䎳䏒䏚䏈䏕䎃䎶䏈䏗䏘䏓䎃䎃䎃䎔䎒䎔
䎳䏒䏚䏈䏕䎃䎶䏄䏙䏈
䎶䏏䏈䏈䏓
䎤䏘䏗䏒䎃䎳䏒䏚䏈䏕䎃䎲䏉䏉

- 44 -

Connecting to a Computer

 Using Bonjour
(For Mac OS X 10.5 and 10.6)

5

䎤䏇䏐䏌䏑䎃䎶䏈䏗䏘䏓䎃䎃䎃䎃䎃䎖䎒䎗
䎰䏈䏐䏒䏕䏜䎃䎶䏈䏗䏘䏓
䎶䏜䏖䏗䏈䏐䎃䎶䏈䏗䏘䏓
䎥䏘䏝䏝䏈䏕䎃䎶䏈䏗䏘䏓
䎳䏒䏚䏈䏕䎃䎶䏈䏗䏘䏓

First, disable the sleep mode on the
printer.

1

Press the <ENTER> button on the
operator panel.

6

Press the scroll button to select
[Sleep], and press the <ENTER>
button.
䎳䏒䏚䏈䏕䎃䎶䏈䏗䏘䏓䎃䎃䎃䎔䎒䎔
䎳䏒䏚䏈䏕䎃䎶䏄䏙䏈
䎶䏏䏈䏈䏓
䎤䏘䏗䏒䎃䎳䏒䏚䏈䏕䎃䎲䏉䏉

2

Press the scroll button several times
to select [Admin Setup], and press the
<ENTER> button.

7

䎩䏘䏑䏆䏗䏌䏒䏑䏖䎃䎃䎃䎃䎃䎃䎕䎒䎕
䎤䏇䏐䏌䏑䎃䎶䏈䏗䏘䏓
䫹䎦䏄䏏䏌䏅䏕䏄䏗䏌䏒䏑

Press the scroll button to select
[Disable], and press the <ENTER>
button.
䎶䏏䏈䏈䏓䎃䎃䎃䎃䎃䎃䎃䎃䎃䎔䎒䎔
䎨䏑䏄䏅䏏䏈
䎍䎃䎃䎧䏌䏖䏄䏅䏏䏈

3

Enter the administrator password, using
the numeric (0-9) keys.
The factory default password is “aaaaaa”. Press
<ENTER> button after each character you input.

8

Press the <ON LINE> button to exit the
menu mode.

䎨䏑䏗䏈䏕䎃䎳䏄䏖䏖䏚䏒䏕䏇

䯴䎙䎐䎔䎕䏇䏌䏊䏌䏗䏖䎌

4

Press the <ENTER> button.

Then, install the driver on the computer.

1

Ensure that your printer and the
computer are turned on and connected.
Reference

●● “Connecting an Ethernet Cable” P.32

2
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Insert “Software DVD-ROM” into the
computer.

1
1. Setup

When connecting to the network with Bonjour,
it is necessary to disable the sleep mode in the
printer. After doing that, install the driver on
the computer and set the printer as a network
printer.

Press the scroll button several times
to select [Power Setup], and press the
<ENTER> button.

Connecting to a Computer

1
1. Setup

3

Double-click the [OKI] icon on the
desktop.

4

Double-click [Driver] folder >
[C841_C831_ES84x1] folder >
[Installer for Mac OSX].

5

10 Select the name of the printer where

[Kind] is [Bonjour], and then check
that [OKI C831(PS)] is displayed in
[Print Using].
The name of your printer is displayed in the
format of “OKI-C831- (the last six digits of the
MAC address)”.

Enter the administrator’s password, and
then click [OK].
Follow the instructions displayed on the screen to
complete the installation.

6

From the Apple menu, select [System
Preferences].

7

Click [Print & Fax].

8

Click [+].

11 Click [Add].
12 If the [Installable Options] window is
displayed, click [Continue].

If you have installed the optional additional
tray unit before the printer driver installation,
configure each item and then click [Continue].

13 Check that your printer is displayed

in [Printers] and [OKI C831(PS)] is
displayed in [Kind].

9

Click [Default].

Note

●● If [OKI C831(PS)] is not correctly displayed in
[Kind], click [-] to remove your printer from [Print
& Fax] and then redo the procedure from step 8 to
12.

14 Close [Print & Fax].
15 Remove “Software DVD-ROM” from the
computer.
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Next, enable the sleep mode on the
printer.

5

Note

Press the scroll button several times
to select [Power Setup], and press the
<ENTER> button.

1

●● If using the Bonjour, disable the sleep mode.

Press the <ENTER> button on the
operator panel.

䎤䏇䏐䏌䏑䎃䎶䏈䏗䏘䏓䎃䎃䎃䎃䎃䎖䎒䎗
䎰䏈䏐䏒䏕䏜䎃䎶䏈䏗䏘䏓
䎶䏜䏖䏗䏈䏐䎃䎶䏈䏗䏘䏓
䎥䏘䏝䏝䏈䏕䎃䎶䏈䏗䏘䏓
䎳䏒䏚䏈䏕䎃䎶䏈䏗䏘䏓

6
2

Press the scroll button several times
to select [Admin Setup], and then
press the <ENTER> button.

Press the scroll button to select
[Sleep], and press the <ENTER>
button.
䎳䏒䏚䏈䏕䎃䎶䏈䏗䏘䏓䎃䎃䎃䎔䎒䎔
䎳䏒䏚䏈䏕䎃䎶䏄䏙䏈
䎶䏏䏈䏈䏓
䎤䏘䏗䏒䎃䎳䏒䏚䏈䏕䎃䎲䏉䏉

䎩䏘䏑䏆䏗䏌䏒䏑䏖䎃䎃䎃䎃䎃䎃䎕䎒䎕
䎤䏇䏐䏌䏑䎃䎶䏈䏗䏘䏓
䫹䎦䏄䏏䏌䏅䏕䏄䏗䏌䏒䏑

7
3

Press the scroll button to select
[Enable], and press the <ENTER>
button.

Enter the administrator password, using
the numeric (0-9) keys.

䎶䏏䏈䏈䏓䎃䎃䎃䎃䎃䎃䎃䎃䎃䎔䎒䎔
䎍䎃䎃䎨䏑䏄䏅䏏䏈
䎧䏌䏖䏄䏅䏏䏈

The factory default password is “aaaaaa”. Press
<ENTER> button after each character you input.

䎨䏑䏗䏈䏕䎃䎳䏄䏖䏖䏚䏒䏕䏇

䯴䎙䎐䎔䎕䏇䏌䏊䏌䏗䏖䎌

8

4

Press the <ENTER> button.
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Press the <ON LINE> button to exit the
menu mode.

1. Setup

1

Connecting to a Computer

1

 Using Bonjour (Rendezvous)
(for Mac OS X 10.3.9 to 10.4.11)

Finish by test printing from a computer.

1. Setup

1

Start up [TextEdit].

2

Open an appropriate file.

3

Start printing.

When connecting to the network with Bonjour,
it is necessary to disable the sleep mode in the
printer. After doing that, install the driver on
the computer and set the printer as a network
printer.

The installation is complete.

Memo

If installing the options such as an
additional tray unit or the SD memory
card kit, specify the settings with a printer
driver. Refer to “When Adding Options”
P.56.

●● The following procedure uses Mac OS X 10.4.11 as an
example. Depending on an OS, the description may be
different.

First, disable the sleep mode on the
printer.

1

Press the <ENTER> button on the
operator panel.

2

Press the scroll button several times
to select [Admin Setup], and press the
<ENTER> button.
䎩䏘䏑䏆䏗䏌䏒䏑䏖䎃䎃䎃䎃䎃䎃䎕䎒䎕
䎤䏇䏐䏌䏑䎃䎶䏈䏗䏘䏓
䫹䎦䏄䏏䏌䏅䏕䏄䏗䏌䏒䏑

3

Enter the administrator password.
The factory default password is “aaaaaa”. Press
<ENTER> button after each character you input.

䎨䏑䏗䏈䏕䎃䎳䏄䏖䏖䏚䏒䏕䏇

䯴䎙䎐䎔䎕䏇䏌䏊䏌䏗䏖䎌

4
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Press the <ENTER> button.

Connecting to a Computer

5

Press the scroll button several times
to select [Power Setup], and press the
<ENTER> button.

Select [Network].

4

Select [Network Port Configurations]
from [Show], and then check that
[Built-in Ethernet] is selected.

5

Close [Network].

6

Insert “Software DVD-ROM” into the
computer.

7

Double-click the [OKI] icon on the desktop.

8

Double-click [Driver] folder >
[C841_C831_ES84x1] folder
[Installer for Mac OSX].

9

Enter the administrator’s password, and
then click [OK].

䎤䏇䏐䏌䏑䎃䎶䏈䏗䏘䏓䎃䎃䎃䎃䎃䎖䎒䎗
䎰䏈䏐䏒䏕䏜䎃䎶䏈䏗䏘䏓
䎶䏜䏖䏗䏈䏐䎃䎶䏈䏗䏘䏓
䎥䏘䏝䏝䏈䏕䎃䎶䏈䏗䏘䏓
䎳䏒䏚䏈䏕䎃䎶䏈䏗䏘䏓

6

Press the scroll button to select
[Sleep], and press the <ENTER>
button.
䎳䏒䏚䏈䏕䎃䎶䏈䏗䏘䏓䎃䎃䎃䎔䎒䎔
䎳䏒䏚䏈䏕䎃䎶䏄䏙䏈
䎶䏏䏈䏈䏓
䎤䏘䏗䏒䎃䎳䏒䏚䏈䏕䎃䎲䏉䏉

7

Press the scroll button to select
[Disable], and press the <ENTER>
button.
䎶䏏䏈䏈䏓䎃䎃䎃䎃䎃䎃䎃䎃䎃䎔䎒䎔
䎨䏑䏄䏅䏏䏈
䎍䎃䎃䎧䏌䏖䏄䏅䏏䏈

Follow the instructions displayed on the screen to
complete the installation.

8

Press the <ON LINE> button to exit the
menu mode.

10 From the [Go] menu, select [Utilities]
and then double-click [Printer Setup
Utility].
Note

●● If [Printer Setup Utility] is already running, close it
and open it again.

11 Click [Add].

Then, install the printer driver on the
computer.

1

Ensure that your printer and the
computer are turned on and connected.

If the [You have no printers available] dialog
box appears, click [Add].

Reference

●● “Connecting an Ethernet Cable” P.32

2

From the Apple menu, select [System
Preferences].
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1
1. Setup

3

Connecting to a Computer

1

12 Select the name of the printer where

1. Setup

[Connection] is [Bonjour], and then
check that [OKI C831(PS)] is displayed
in [Print Using].

19 Check that [OKI C831(PS)] is displayed
correctly under [Format for].

The name of your printer is displayed with the
format of “OKI-C831- (the last six digits of the
MAC address)”.

20 Click [OK].
21 Remove “Software DVD-ROM” from the
computer.

Next, enable the sleep mode on the
printer.

For Mac OS X 10.3.9, set as follows.

a

Note

●● If using the Bonjour, disable the sleep mode.

Select [Rendezvous] from the popup menu.

b

Select the printer from the list.

c

Select [Oki] from [Printer Model]
and then select [OKI C831(PS)]
from the driver list.

1

Press the <ENTER> button on the
operator panel.

2

Press the scroll button several times
to select [Admin Setup], and then
press the <ENTER> button.

13 Click [Add].
14 If the [Installable Options] window is
displayed, click [Continue].

If you have installed the optional additional
tray unit before the printer driver installation,
configure each item and then click [Continue].

䎩䏘䏑䏆䏗䏌䏒䏑䏖䎃䎃䎃䎃䎃䎃䎕䎒䎕
䎤䏇䏐䏌䏑䎃䎶䏈䏗䏘䏓
䫹䎦䏄䏏䏌䏅䏕䏄䏗䏌䏒䏑

15 Check that the name of your printer is
displayed in [Printer List], and then
close the window.

3

Enter the administrator password, using
the numeric (0-9) keys.
The factory default password is “aaaaaa”. Press
<ENTER> button after each character you input.

16 From the [Go] menu, select

[Applications] > [TextEdit].

17 Select the [File] menu > [Page Setup].
18 Select the name of your printer from
[Format for].
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䎨䏑䏗䏈䏕䎃䎳䏄䏖䏖䏚䏒䏕䏇

䯴䎙䎐䎔䎕䏇䏌䏊䏌䏗䏖䎌

Connecting to a Computer

4

Press the <ENTER> button.

Finish by test printing from a computer.
Start up [TextEdit].

2

Open an appropriate file.

3

Start printing.
The installation is complete.

5

If installing the options such as an
additional tray unit or the SD memory
card kit, specify the settings with a printer
driver. Refer to “When Adding Options”
P.56.

Press the scroll button several times
to select [Power Setup], and press the
<ENTER> button.
䎤䏇䏐䏌䏑䎃䎶䏈䏗䏘䏓䎃䎃䎃䎃䎃䎖䎒䎗
䎰䏈䏐䏒䏕䏜䎃䎶䏈䏗䏘䏓
䎶䏜䏖䏗䏈䏐䎃䎶䏈䏗䏘䏓
䎥䏘䏝䏝䏈䏕䎃䎶䏈䏗䏘䏓
䎳䏒䏚䏈䏕䎃䎶䏈䏗䏘䏓

6

Press the scroll button to select
[Sleep], and press the <ENTER>
button.
䎳䏒䏚䏈䏕䎃䎶䏈䏗䏘䏓䎃䎃䎃䎔䎒䎔
䎳䏒䏚䏈䏕䎃䎶䏄䏙䏈
䎶䏏䏈䏈䏓
䎤䏘䏗䏒䎃䎳䏒䏚䏈䏕䎃䎲䏉䏉

7

Press the scroll button to select
[Enable], and press the <ENTER>
button.
䎶䏏䏈䏈䏓䎃䎃䎃䎃䎃䎃䎃䎃䎃䎔䎒䎔
䎍䎃䎃䎨䏑䏄䏅䏏䏈
䎧䏌䏖䏄䏅䏏䏈

8

Press the <ON LINE> button to exit the
menu mode.
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1
1. Setup

1

Connecting to a Computer

1

USB Connection

1. Setup

Perform the following procedure to connect your
printer to a computer via USB.

Connecting a USB Cable
1

Installing a Printer Driver
(For Windows)
Note

●● You must be logged in as an administrator to complete
this procedure.

1

Ensure that your printer is turned off
and the USB cable is unplugged from the
computer.

2

Turn on the computer.

3

Insert “Software DVD-ROM” into the
computer.

4

Click [Run Setup.exe] after [Auto
Play] is displayed.

Prepare a USB cable (1).
A USB cable is not supplied with your printer.
Prepare a USB 2.0 cable separately.
1

Memo

●● Use a USB 2.0 Hi-Speed cable for a USB 2.0 HiSpeed connection.

2

Turn off your printer and the computer.
Reference

If the [User Account Control] dialog box
appears, click [Yes].

5

Select the language, and then click
[Next].

6

Select the model of your printer, and
then click [Next].

7

Read the license agreement and then
click [I Agree].

8

Read the [Environmental advice for
Users] and then click [Next].

●● “Turning Off the Power” P.22

3

Plug one end of the USB cable into the
USB interface connector (2) on the back
of the printer.

4

Plug the other end of the USB cable into
the computer’s USB interface connector.

2

Note

●● For Windows, do not plug the other end of the USB
cable into the computer until prompted while a
printer driver installation.
Note

●● Do not plug the USB cable into the network interface
connection. Doing so may cause a malfunction.
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9

12 When connecting the printer to the

Select a check box for the driver to
install from [PCL driver], [PS driver]
or [XPS driver] under [Software].

Follow the instructions displayed on the screen to
complete the installation.

10 Click the install bunch button on the top.
Memo

Reference

●● To batch install software, select check boxes of
software to be installed.
To install software separately, click the install
button on the right side of each item, and follow the
instructions displayed on a screen.

Icon

●● “Connecting a USB Cable” P.52

13 Click [Exit] and the installation is
complete.

Description
Click
to install the drivers and/or
software that have been check-box
selected.
Click
on the right side of each
item to install driver or software
individually.

Install bunch button

14 Click [Start] > [Devices and Printers].
15 Check that the [OKI C831] icon is
displayed.

Right-click the [OKI C831] icon and select one
of the menu items, and then check that all the
printer drivers installed are displayed in the
submenu.

Install buttons (separately)

Installation starts.
Memo

●● Color Correct Utility also installed simultaneously
with printer driver.

11 If the [Windows Security] dialog box
appears, click [Install this driver
software anyway].

16 Remove “Software DVD-ROM” from the
computer.
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1
1. Setup

computer, and the instruction prompting
to turn on the printer appears, plug the
USB cable into the computer and turn on
your printer.

Connecting to a Computer

1

8

Finish by test printing from a computer.

1. Setup

1

Open a printer driver property.

2

Click Test Print.

Click [+].

The installation is complete.

If installing the options such as an
additional tray unit or the SD memory
card kit, specify the settings with a printer
driver. Refer to “When Adding Options”
P.56.

Installing a Printer Driver
(For Mac OS X)

Note

●● If the printer is already shown in [Printers], select
your printer, and click on [-] to delete. After this,
click [+].

Note

●● Disable the anti-virus software before starting this
procedure.

 For Mac OS X 10.5 and 10.6
1

9

Ensure that your printer and the
computer are turned on and connected.

Select the name of the printer where
[Kind] is [USB], and then check
that [OKI C831(PS)] is displayed in
[Print Using].

Reference

●● “Connecting a USB Cable” P.52

2

Insert “Software DVD-ROM” into the
computer.

3

Double-click the [OKI] icon on the
desktop.

4

Double-click [Driver] folder >
[C841_C831_ES84x1] folder
[Installer for Mac OSX].

5

Enter the administrator’s password, and
then click [OK].

10 Click [Add].
11 Check that the name of your printer
is displayed in [Printers] and [OKI
C831(PS)] is displayed in [Kind].

Follow the instructions displayed on the screen to
complete the installation.

6

From the Apple menu, select [System
Preferences].

7

Click [Print & Fax].

Note

●● If [OKI C831(PS)] is not correctly displayed, click
[-] to remove your printer from [Printers] and then
redo the procedure from steps 8 to 10.
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12 Close [Print & Fax].

7

Click [Add].

13 Remove “Software DVD-ROM” from the

1

computer.

1. Setup

Finish by test printing from a computer.

1

Start up [TextEdit].

2

Open an appropriate file.

3

Start printing.

If the [You have no printers available] dialog
box appears, click [Add].

The installation is complete.

If installing the options such as an
additional tray unit or the SD memory
card kit, specify the settings with a printer
driver. Refer to “When Adding Options”
P.56.

Note

●● If the name of the printer is already displayed, select
it and click [Delete], and then click [Add].

8

 For Mac OS X 10.3.9 to 10.4.11
Memo

●● The procedure below uses Mac OS X 10.4.11 as an
example. Depending on your OS, the description may be
different.

1

Select the name of the printer where
[Connection] is [USB], and then check
that [OKI C831(PS)] is displayed in
[Print Using].

Ensure that your printer and the
computer are turned on and connected.
Reference

●● “Connecting a USB Cable” P.52

2

Insert “Software DVD-ROM”.

3

Double-click the [OKI] icon on the
desktop.

4

5

For Mac OS X 10.3.9, set as follows.

Double-click [Driver] folder >
[C841_C831_ES84x1] folder >
[Installer for Mac OSX].

a

Select [USB] from the pop-up menu.
Select the printer from the list.

Enter the administrator’s password, and
then click [OK].

b
c

Select [Oki] from [Printer Model]
and then select [OKI C831(PS)]
from the driver list.

Follow the instructions displayed on the screen to
complete the installation.

6

9

From the [Go] menu, select [Utilities],
and then double-click [Printer Setup
Utility].

Click [Add].

10 Check that the name of your printer is

Note

●● If [Printer Setup Utility] is already running, close it
and open it again.
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displayed in [Printer List], and then
close the window.

Connecting to a Computer

1

11 Remove “Software DVD-ROM” from the

When Adding Options

computer.

1. Setup

Finish by test printing from a computer.

1

Start up [TextEdit].

2

Open an appropriate file.

3

Start printing.
The installation is complete.

If options such as additional tray unit and/or
SD memory card kit have been installed, use
following procedures to change printer driver
settings.

 For Windows PCL Driver
1

Click [Start] > [Devices and Printers].

2

Right-click the [OKI C831] icon and
select [Properties]. (If you have
installed multiple printer drivers, select
[Properties] >[OKI C831(PCL)].)

3

Select the [Device Options] tab.

4

If using a network connection, select
[Get Printer Settings].
If using a USB connection,
enter the total number of trays
excluding the multipurpose tray in
[Installed Paper Trays]. For example,
when three option trays are installed,
enter “4” as the trays 1, 2, 3 and 4 are
available.

5

Click [OK].
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 For Windows PS Driver
Click [Start] > [Devices and Printers].

2

Right-click the [OKI C831] icon and
then select [Properties]. (If you have
installed multiple printer drivers, select
[Properties] > [OKI C831(PS)].)

3

Select the [Device Settings] tab.

4

If using a network connection, select
[Get installed options automatically]
under [Installable Options], and then
click [Setup].
If using a USB connection, select
an appropriate number of trays in
[Available Trays] under [Installable
Options].

If using a network connection, select
[Get Printer Settings].
If using a USB connection,
enter the total number of trays
excluding the multipurpose tray in
[Installed Paper Trays]. For example,
when three option trays are installed,
enter “4” as the trays 1, 2, 3 and 4 are
available.

5

Click [OK].

 For Mac OS X PS Driver
(Mac OS X 10.5 and 10.6)

5

Click [OK].

1

Select [System Preferences] from the
Apple menu.

2

Click [Print & Fax].

3

Select the name of your printer and then
click [Options & Supplies].

 For Windows XPS Driver
1

Click [Start] > [Devices and Printers].

4

Select the [Driver] tab.

2

Right-click the [OKI C831] icon and
select [Properties]. (If you have
installed multiple printer drivers, select
[Properties] > [OKI C831(XPS)].

5

Select the number of available trays in
[Available Tray], and then click [OK].

3

Select the [Device Options] tab.
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1
1. Setup

1

4

Connecting to a Computer

1

 For Mac OS X PS Driver
(Mac OS X 10.3.9 to 10.4.11)
Memo

1. Setup

●● The following procedure uses Mac OS X 10.4.11 as an
example. Depending on an OS, the description may be
different.

1

From [Go], select [Utilities] and then
double-click [Printer Setup Utility].

2

Select the name of your printer and then
click [Show Info].

3

Select [Installable Options].

4

Select the number of available trays
in [Available Tray], and then click
[Apply Changes].

5

Close [Printer Info].
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2. Printing Basic Operation
This chapter describes how to print documents from a computer.

2

●●
Supported Paper
For high-quality printing, be sure to use paper types that satisfy requirements such as those for
material quality, weight, and surface finish. Please use digital photo print paper.
If not using recommended paper, please check the print quality and the movement of the paper
sufficiently beforehand to make sure that there are no problems. Your printer supports the following
types of paper.
Paper Type
Plain paper

Paper Size mm (inch)
A3
A4
A5
A6
B4
B5
B6
Letter
Legal (13 inch)
Legal (13.5 inch)
Legal (14 inch)
Executive
Tabloid
Statement
8K
(260 x 368
8K
(270 x 390
8K
(273 x 394
16K
(184 x 260
16K
(195 x 270
16K
(197 x 273
Custom

mm)
mm)
mm)
mm)
mm)
mm)

297 x 420
210 x 297
148 x 210
105 x 148
257 x 364
182 x 257
128 x 182
215.9 x 279.4
(8.5 x 11)
215.9 x 330.2
(8.5 x 13)
215.9 x 342.9
(8.5 x 13.5)
215.9 x 355.6
(8.5 x 14)
184.2 x 266.7
(7.25 x 10.5)
(11 x 17)
(5.5 x 8.5)
260 x 368

Paper Weight
64 to 256 g/m2
For duplex print, 64 to 220 g/m2
Note

●● If the paper size is set at A6, A5, or with
a paper width narrower than 148 mm (A5
width), the printing will be slower.

270 x 390
273 x 394
184 x 260
195 x 270
197 x 273
Width:
64 - 297
Length:
90 - 1321
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64 to 256 g/m2

2. Printing Basic Operation

Supported Paper Types

Supported Paper

Paper Type
Envelope

Paper Size mm (inch)
Com-10
DL

2

C5
C4

2. Printing Basic Operation

104.8 x 241.3
(4.125 x 9.5)
110 x 220
(4.33 x 8.66)
162 x 229
(6.4 x 9)
229 x 324
(9 x 12.76)
76.2 x 127
(3 x 5)
210 x 297
215.9 x 279.4
(8.5 x 11)

Paper Weight
Envelopes should be 24lb paper, and
flap parts of envelopes should be folded

Index card

Index card

Label

A4
Letter

Partly-printing paper

Subject to the plain paper*1

64 to 256 g/m2

Color paper

Subject to the plain paper*2

64 to 256 g/m2

0.1 - 0.2 mm

Use paper that meets the following conditions*1:
●● Paper that meets the conditions for plain paper.
●● An ink used for a part printing is heat resistant (230°C).
Note

●● When specifying a printing area, please take into account the differences of printing position as followings:
Print start position: ±2 mm, Paper skew: ±1 mm/100 mm, Image stretch: ±1 mm/100 mm
(when paper ream weight is 70 kg)
●● This printer cannot print on an ink.

Use paper that meets the following conditions*2:
●● A pigment or an ink used to color paper is heat resistant (230°C).
●● Paper that has same characteristics with light paper and used for an electronic photo printer.

Paper Recommendations

CAUTION

Your printer will handle a variety of print media,
including a range of paper weights and sizes.
This section provides general advice on choice of
media, and explains how to use each type.
The best performance will be obtained when
using standard 75 - 90 g/m2 paper designed for
use in copiers and laser printers.
Use of heavily embossed or very rough textured
paper is not recommended.
Pre-printed stationery can be used, but the ink
must not offset when exposed to the high fuser
temperatures used in the printing process.
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●● Envelopes should be free from twist, curl or
other deformations. They should also be of the
rectangular flap type, with glue that remains
intact when subjected to hot roll pressure fusing
used in this type of printer. Window envelopes are
not suitable.
●● Labels should also be of the type recommended
for use in copiers and laser printers, in which the
base carrier page is entirely covered by labels.
Other types of label stock may damage the printer
due to the labels peeling off during the printing
process.

Supported Paper

Storing Paper
Store paper under the following conditions to
maintain quality.
●● Inside a cabinet or other dry and dark place

2

●● On a flat surface
●● Temperature: 20°C

2. Printing Basic Operation

●● Humidity: 50% RH (relative humidity)
Do not store in the following locations.
●● Directly on the floor
●● In direct sunlight
●● Near the inside of an exterior wall
●● On an uneven surface
●● Where static electricity may be generated
●● In places that are excessively hot or where
temperature rapidly changes
●● Near a copier, air conditioner, heater, or duct
Note

●● Do not unwrap the paper until you are ready to use the
paper.
●● Do not leave paper unwrapped for a long period. Doing
so may result in paper handling and print quality issues.
●● Depending on a media you use, usage conditions and a
storing conditions, a decrease in paper quality or curling
of the paper may occur.
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Supported Paper

Paper Loaded on the Tray
Your printer has two built-in trays (tray 1 and the MP tray) and an additional tray unit (tray 2/3/4).
Refer to the list below to check the supported paper and capacities of each tray.
Note

2

●● Duplex printing can not be performed on paper indicated with an asterisk (*).

Tray

2. Printing Basic Operation

Tray1

Tray2/3/4
(option)

Supported paper size
●● A3
●● A4
●● A5
●● B4
●● B5
●● A6*
●● Letter
●● Legal 13
●● Legal 13.5
●● Legal 14
●● Executive
●● Tabloid
●● 8K (260 x 368 mm)
●● 8K (270 x 390 mm)
●● 8K (273 x 394 mm)
●● 16K (184 x 260 mm)
●● 16K (195 x 270 mm)
●● 16K (197 x 273 mm)
●● Custom
●● A3
●● A4
●● A5
●● B4
●● B5
●● Letter
●● Legal 13
●● Legal 13.5
●● Legal 14
●● Executive
●● Tabloid
●● 8K (260 x 368 mm)
●● 8K (270 x 390 mm)
●● 8K (273 x 394 mm)
●● 16K (184 x 260 mm)
●● 16K (195 x 270 mm)
●● 16K (197 x 273 mm)
●● Custom

Paper capacity

Paper weight

300 sheets
(when paper weight is 80 g/m2)

●● Light
(64 to 82 g/m2)
●● Medium Light
(83 to 90 g/m2)
●● Medium
(91 to 105 g/m2)
●● Heavy
(106 to 128 g/m2)
●● Ultra Heavy1
(129 to 188 g/m2)
●● Ultra Heavy2
(189 to 220 g/m2)

530 sheets
(when paper weight is 80 g/m2)

●● Light
(64 to 82 g/m2)
●● Medium Light
(83 to 90 g/m2)
●● Medium
(91 to 105 g/m2)
●● Heavy
(106 to 128 g/m2)
●● Ultra Heavy1
(129 to 188 g/m2)
Note

●● Weight of paper loaded on an
additional tray unit is 64 to
176 g/m2.
●● The specified paper weight
of Ultra Heavy1 is described
as 129 to 188 g/m2, but the
printable weight is up to
176 g/m2.
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Supported Paper

Tray
MP Tray

Supported paper size

Paper weight

●● 100 sheets
●● Light
(when paper weight is 80 g/m2)
(64 to 82 g/m2)
●● 10 envelopes
●● Medium Light
(83 to 90 g/m2)
●● Medium
(91 to 105 g/m2)
●● Heavy
(106 to 128 g/m2)
●● Ultra Heavy1
(129 to 188 g/m2)
●● Ultra Heavy2
(189 to 220 g/m2)
●● Ultra Heavy3
(221 to 256 g/m2)
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●● A3
●● A4
●● A5
●● B4
●● B5
●● B6
●● A6*
●● Letter
●● Legal 13
●● Legal 13.5
●● Legal 14
●● Executive
●● Tabloid
●● Statement
●● 8K (260 x 368 mm)
●● 8K (270 x 390 mm)
●● 8K (273 x 394 mm)
●● 16K (184 x 260 mm)
●● 16K (195 x 270 mm)
●● 16K (197 x 273 mm)
●● Custom
●● Com-10 Envelope*
●● DL Envelope*
●● C4 Envelope*
●● C5 Envelope*
●● Index Card*

Paper capacity

How to Print from the Tray

●●
How to Print from the Tray
The following procedure explains how to load paper in tray 1 or tray 2/3/4 (option).
Memo

2

●● This procedure explains to load paper in tray 1. The same procedure is applied to tray 2/3/4.

1

Pull out the paper tray (1).

Note

2. Printing Basic Operation

●● When loading A6 size paper, move the paper stopper
(4) forward and remove it once, then install it on the
metal part.
4

1

2

4

Flex paper back and forth, and then fan
it. Straighten the edges of the paper
stack on a level surface.

5

Load paper with the print side face down
and press it from above.

Set the paper size dial (2) to match the
size of the paper to be loaded.
Set the dial to [A4
] when loading A4 size
paper in horizontal orientation.

2

A4
A4
A5
A5

Note

●● Do not load paper exceeding the [▼] mark (5) of the
paper guide.
5

3

Slide the paper guide (3) and paper
stopper (4) to the size of paper to be
loaded.

6

Secure the loaded paper with the paper
guide.

7

Check if a size of loaded paper matches
the setting of paper size dial.

8

Return the paper tray to the printer.
Memo

●● If loading a paper that you cannot select the
size with a paper size dial options, set the dial to
[Other], and then set a paper size on the operator
panel.

4
3

9
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Open a file you want to print, and print it.

How to Print from the MP Tray

●●
How to Print from the MP Tray
This procedure explains how to load paper in the MP tray.
Note

●● Do not load paper of different sizes, types or weights at the same time.
●● When adding paper, remove the paper on the MP tray and straighten the edges of both stacks of paper, and then load them
again.

1

4

Open the MP tray (1) forward by
inserting your fingers into the front
recesses (2).

Open the paper set cover (5).
5

2

1

2

5

2

Adjust the manual feeding paper guide
(6) to the width of paper to be loaded.

Pull out the paper support (3) by holding
the center part of it.

3

6

6

Insert the paper with the print side face
up.
Note

3

●● Do not load paper exceeding the [▼] mark (7) of the
paper guide.

Unfold the sub support (4).

7

4
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2. Printing Basic Operation

●● Do not put anything other than paper for printing in the MP tray.

2

How to Print from the MP Tray

7

When loading paper vertically or horizontally
ABC

ABC

Close the paper set cover (5).

5

2
Com-10, DL, C5

C4

2. Printing Basic Operation

If always printing on same size or type paper
from the MP tray, register the paper on the
operator panel. If printing once, proceed to the
step 18.
Memo

Note

●● When loading envelopes in the MP tray, load them face up
with the orientation noted below.

●● When a printer is in the power saving mode, press
the <POWER SAVE> button to restore from the
mode.

--Com-10, DL and C5 are loaded with the flap folded
and the flap should come to the top side in the feeding
direction.
--C4 is loaded with the flap folded and the flap should
come to the right side in the feeding direction.
Note

●● Make sure that the message “Ready To Print” is
displayed in the operator panel. If the message is not
displayed, press the <ON LINE> button.

8

Press the <Fn> key.

9

Enter “90” and press the <ENTER>
button.

●● The paper may be wrinkled or curled after printing.
●● Use paper stored in proper temperature and humidity
conditions. Do not use paper that is curled or waved
because of humidity.
●● Do not print on the back side of paper on which other
printer has printed.
●● Curling of a postcard or an envelope may cause the ink
absorbing problem. Use paper that is not curled. Correct a
paper Curling within 2 mm.
●● Printing an envelope with an adhesive flap bent cause the
ink absorbing problem.

䎩䏘䏑䏆䏗䏌䏒䏑䎃䎱䏘䏐䏅䏈䏕

䎨䏑䏗䏈䏕䎃䎔䎐䎖䏇䏌䏊䏌䏗䎃䎱䏘䏐䏅䏈䏕

10 When [Paper Size] is displayed, select
the size of the loaded paper and then
press the <ENTER> button.
䎳䏄䏓䏈䏕䎃䎶䏌䏝䏈䎃䎃䎃䎃䎃䎔䎒䎔䎔
䎤䎖
䎤䎗
䎤䎗
䎤䎘

Reference

●● If [Custom] is selected for [Paper Size], you need
to register the custom size. For how to register the
custom size, refer to “Printing in Custom Sizes”
P.69.
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How to Print from the MP Tray

11 Press the <BACK> button until
[MPTray Config] is displayed.

16 Press the scroll button

to select the
weight of the loaded paper and then
press the <ENTER> button.

䎰䎳䎷䏕䏄䏜䎃䎦䏒䏑䏉䏌䏊䎃䎃䎃䎔䎒䎔
䎳䏄䏓䏈䏕䎃䎶䏌䏝䏈
䎰䏈䏇䏌䏄䎃䎷䏜䏓䏈
䎰䏈䏇䏌䏄䎃䎺䏈䏌䏊䏋䏗
䎷䏕䏄䏜䎃䎸䏖䏄䏊䏈

to select
[Media Type] and then press the
<ENTER> button.

17 Press the <ON LINE> button to exit the
menu mode.

䎰䎳䎷䏕䏄䏜䎃䎦䏒䏑䏉䏌䏊䫹䎃䎔䎒䎔
䎳䏄䏓䏈䏕䎃䎶䏌䏝䏈
䎰䏈䏇䏌䏄䎃䎷䏜䏓䏈
䎰䏈䏇䏌䏄䎃䎃䎺䏈䏌䏊䏋䏗
䎷䏕䏄䏜䎃䎸䏖䏄䏊䏈

13 Press the scroll button

to select the
type of the loaded paper and then press
the <ENTER> button.
䫹䫹䫹䫹䫹䎰䏈䏇䏌䏄䎃䎷䏜䏓䏈䎃䎃䎃䎃䎃䎔䎒䎖
䎍䎃䎳䏏䏄䏌䏑
䎯䏈䏗䏗䏈䏕䏋䏈䏄䏇
䎷䏕䏄䏑䏖䏓䏄䏕䏈䏑䏆䏜
䎯䏄䏅䏈䏏䏖

14 Press the <BACK> button until
[MPTray Config] is displayed.
䎰䎳䎷䏕䏄䏜䎃䎦䏒䏑䏉䏌䏊䫹䎃䎔䎒䎔
䎳䏄䏓䏈䏕䎃䎶䏌䏝䏈
䎰䏈䏇䏌䏄䎃䎷䏜䏓䏈
䎰䏈䏇䏌䏄䎃䎃䎺䏈䏌䏊䏋䏗
䎷䏕䏄䏜䎃䎸䏖䏄䏊䏈

18 Open the file you want to print, and print
it by following the procedures below.

For Windows PCL Printer Driver
1

From the [File] menu, select [Print].

2

Click [Preferences] or [Properties].

3

On the [Setup] tab, select a paper size
from [Size].

4

Select [Multipurpose Tray] from
[Source].

5

Start printing.

15 Press the scroll button

to select
[Media Weight] and then press the
<ENTER> button.
䎰䎳䎷䏕䏄䏜䎃䎦䏒䏑䏉䏌䏊䫹䎃䎔䎒䎔
䎳䏄䏓䏈䏕䎃䎶䏌䏝䏈
䎰䏈䏇䏌䏄䎃䎷䏜䏓䏈
䎰䏈䏇䏌䏄䎃䎺䏈䏌䏊䏋䏗
䎷䏕䏄䏜䎃䎸䏖䏄䏊䏈
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12 Press the scroll button

䎰䏈䏇䏌䏄䎃䎺䏈䏌䏊䏋䏗䫹䎃䎔䎒䎕
䎍䎃䎯䏌䏊䏋䏗
䎰䏈䏇䏌䏘䏐䎃䎯䏌䏊䏋䏗
䎰䏈䏇䏌䏘䏐
䎫䏈䏄䏙䏜

How to Print from the MP Tray

For Windows PS Printer Driver

2
2. Printing Basic Operation

1

From the [File] menu, select [Print].

2

Click [Preferences] or [Properties].

3

Select the [Paper/Quality] tab.

4

Select [Multi-Purpose Tray] from
[Paper Source].

5

Click [Advanced].

6

Click [Paper Size] and select a paper
size from the drop-down list.

7

Click [OK].

8

Start printing.

For Windows XPS Printer Driver
1

From the [File] menu, select [Print].

2

Click [Preferences] or [Properties].

3

On the [Setup] tab, select a paper size
from [Size].

4

Select [Multipurpose Tray] from
[Source].

5

Start printing.

For Mac OS X PS Printer Driver
1

From the [File] menu, select [Page
Setup].

2

Select a paper size from [Paper Size]
and then click [OK].

3

From the [File] menu, select [Print].

4

Select [Paper Feed] from the panel
menu.

5

Select [All pages From] and then select
[Multi Purpose Tray].

6

Start printing.
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Printing in Custom Sizes

●●
Printing in Custom Sizes
To load custom size paper, you need to register the width and length of the paper before printing. The
range of the sizes you can set differs according to the paper tray.
Tray

4

Available size range

Tray1

䎷䏕䏄䏜䎃䎦䏒䏑䏉䏌䏊䏘䏕䏄䏗䏌䏒䏑䎔䎒䎖
䎰䎳䎷䏕䏄䏜䎃䎦䏒䏑䏉䏌䏊
䎷䏕䏄䏜䎔 䎃䎦䏒䏑䏉䏌䏊
䎷䏕䏄䏜䎕 䎃䎦䏒䏑䏉䏌䏊
䎷䏕䏄䏜䎖 䎃䎦䏒䏑䏉䏌䏊

5

Note

●● [Custom] is displayed only when [Paper Size] is set to
[Custom].

䎰䎳䎷䏕䏄䏜䎃䎦䏒䏑䏉䏌䏊䎃䎃䎃䎔䎒䎔
䎳䏄䏓䏈䏕䎃䎶䏌䏝䏈
䎰䏈䏇䏌䏄䎃䎷䏜䏓䏈
䎰䏈䏇䏌䏄䎃䎺䏈䏌䏊䏋䏗
䎷䏕䏄䏜䎃䎸䏖䏄䏊䏈

●● The available size range for duplex printing is the same as
that for tray 2/3/4.

1

Check that [Paper Size] is selected and
press the <ENTER> button.

Press the <ENTER> button on the
operator panel.

6

Press the scroll button several times
to select [Custom] and then press the
<ENTER> button.
䎳䏄䏓䏈䏕䎃䎶䏌䏝䏈䎃䎃䫹䎚䎒䎔䎔

2

Press the scroll button several times
to select [Menus] and press the
<ENTER> button.
䎩䏘䏑䏆䏗䏌䏒䏑䏖䎃䎃䎃䎃䎃䎃䎔䎒䎕
䎦䏒䏑䏉䏌䏊䏘䏕䏄䏗䏌䏒䏑
䎳䏕䏌䏑䏗䎃䎬䏑䏉䏒䏕䏐䏄䏗䏌䏒䏑
䎳䏕䏌䏑䏗䎃䎶䏈䏆䏘䏕䏈䎃䎭䏒䏅
䎰䏈䏑䏘䏖

3

䎍䎃䎦䏘䏖䏗䏒䏐
䎦䏒䏐䎐䎔䎓䎃䎨䏑䏙䏈䏏䏒䏓䏈
䎧䎯䎃䎨䏑䏙䏈䏏䏒䏓䏈
䎦䎘

7

Check that [Tray Configuration]
is selected and press the <ENTER>
button.
䎰䏈䏑䏘䏖䎃䎃䎃䎃䎃䎃䎃䫹䎔䎒䎔
䎷䏕䏄䏜䎃䎦䏒䏑䏉䏌䏊䏘䏕䏄䏗䏌䏒䏑
䎶䏜䏖䏗䏈䏐䎃䎤䏇䏍䏘䏖䏗
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Press the <BACK> button.

2
2. Printing Basic Operation

Width:
105 to 297 mm (4.1 to 11.7 inches)
Length:
148, 182 to 431.8 mm
(5.8, 7.2 to 17.0 inches)
Tray 2/3/4 Width:
(Option)
148 to 297 mm (5.8 to 11.7 inches)
Length:
182 to 431.8 mm (7.2 to 17.0 inches)
MP tray
Width:
64 to 297 mm (2.5 to 11.7 inches)
Length:
90 to 1321 mm (3.5 to 52 inches)

Press the scroll button several times
to select [Tray Config] of the paper
tray in which you loaded paper and then
press the <ENTER> button.

Printing in Custom Sizes

8

Press the scroll button to select
[X Dimension] and then press the
<ENTER> button.

2

13 Press the <ON LINE> button to exit the
menu mode.

䎰䎳䎷䏕䏄䏜䎃䎦䏒䏑䏉䏌䏊䫹䎔䎒䎕
䎳䏄䏓䏈䏕䎃䎶䏌䏝䏈
䎻䎃䎧䏌䏐䏈䏑䏖䏌䏒䏑
䎼䎃䎧䏌䏐䏈䏑䏖䏌䏒䏑
䎰䏈䏇䏌䏄䎃䎷䏜䏓䏈

2. Printing Basic Operation

9

Enter the paper width value using
the ten-key pad and then press the
<ENTER> button.

䎍

䎻䎃䎧䏌䏐䏈䏑䏖䏌䏒䏑

14 Specify a custom in the following
procedures.

For Windows PCL Printer Driver
1

Click [Start] and select [Devices and
Printers].

2

Right-click the Your Printer icon and
select the type of driver you want to
specify from [Printing preferences].

3

On the [Setup] tab, click [Paper Feed
Options].

4

Click [Custom Size].

5

Enter a name and the dimensions.

䎔䎓䎘䎃䏐䏌䏏䏏䏌䏐䏈䏗䏈䏕

10 Press the <BACK> button.

11 Press the scroll button

to select
[Y Dimension] and then press the
<ENTER> button.
䎰䎳䎷䏕䏄䏜䎃䎦䏒䏑䏉䏌䏊䫹䎔䎒䎕
䎳䏄䏓䏈䏕䎃䎶䏌䏝䏈
䎻䎃䎧䏌䏐䏈䏑䏖䏌䏒䏑
䎼䎃䎧䏌䏐䏈䏑䏖䏌䏒䏑
䎰䏈䏇䏌䏄䎃 䎷䏜䏓䏈

12 Enter the paper length value using

the ten-key pad and then press the
<ENTER> button.

䎍

6

a

Enter a name for the new size in the
[Name] box.

b

Enter its dimensions in the [Width]
and [Length] boxes.

Click [Add] to save the custom paper
size to the list and then click [OK].
You can save up to 32 custom sizes.

7

Press [OK] until the [Printing
preferences] dialog box is closed.

8

Open the file you want to print.

9

Select the registered paper size and
start printing on the print dialog.

䎃䎼䎃䎧䏌䏐䏈䏑䏖䏌䏒䏑
䎔䎗䎛 䏐䏌䏏䏏䏌䏐䏈䏗䏈䏕
䎃
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Printing in Custom Sizes

For Windows PS Printer Driver
1

Click [Start] and select [Devices and
Printers].

2

Right-click the Your Printer icon and
select the type of driver you want to
specify from [Printing preferences].
On the [Layout] tab, click [Advanced].

4

Click [Paper Size] and select
[PostScript Custom Page Size] from
the drop-down list.

5

Note

●● In the Mac OS X PS printer driver, paper size out of the
available range can be set, however, image is not correctly
printed. set paper size within available range.

Enter the dimensions in the [Width] and
[Height] boxes, and press [OK].
Note

●● [Offsets Relative to Paper Feed Direction] is not
available.

6

Press [OK] until the [Printing
preferences] dialog box is closed.

7

Open the file you want to print from the
application.

8

Select [PostScript Custom Page Size]
for a paper size and start printing on the
printer driver.

1

Open the file you want to print.

2

From the [File] menu, select [Page
Setup].

3

Select [Manage Custom Sizes] from
[Paper Size]

4

Click [+] to add an item to the list of
custom paper sizes.

5

Double-click [Untitled] and enter a
name for the custom paper size.

6

Enter the dimensions in the [Width] and
[Height] boxes.

7

Click [OK].

8

Click [OK].

9

From the [File] menu, select [Print].

10 Configure other settings if necessary and
then start printing.

Memo

●● If the print dialog contains only two menus and does
not contain the options you expect to see on the Mac
OS X 10.5 or 10.6, click the
button on the side of the
[Printer] menu.
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2
2. Printing Basic Operation

3

For Mac OS X PS Printer Driver

Printing in Custom Sizes

Open the file you want to print, and print
it in the following procedures.

2

For Mac OS X PS Printer Driver

2. Printing Basic Operation

For Windows PCL Printer Driver

1

From the [File] menu, select [Page
Setup].

1

From the [File] menu, select [Print].

2

2

Click [Preferences] or [Properties].

Select a paper size from [Paper Size]
and then click [OK].

3

On the [Setup] tab, select a paper size
from [Size].

3

From the [File] menu, select [Print].

4

4

Select [Multipurpose Tray] from
[Source].

Select [Paper Feed] from the panel
menu.

5

5

Start printing.

Select [All] and then select [Multi
Purpose Tray].

6

Start printing.

For Windows PS Printer Driver
1

From the [File] menu, select [Print].

2

Click [Preferences] or [Properties].

3

Select the [Paper/Quality] tab.

4

Select [Multipurpose Tray] from
[Paper Source].

5

Click [Advanced].

6

Click [Paper Size] and select a paper
size from the drop-down list.

7

Click [OK].

8

Start printing.
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Paper Output

●●
Paper Output
Your printer outputs to the facedown or faceup stacker. Paper types that can be outputted to each
stacker are as follows.
Supported
paper type

Facedown

●● Plain paper
●● Recycled
paper

●● 250 sheets (when
paper weight is less
than 80 g/m2)

●● Plain paper
●● Recycled
paper
●● Envelope
●● Index card
●● Label

●● 100 sheets (when
paper weight is less
than 80 g/m2)
●● 10 sheets (Ultra
Heavy paper and
envelopes)

Faceup

Paper output
capacity

 Using the Faceup Stacker

Paper is delivered with the print side face up,
stacked opposite the order printed.

1

Pull the faceup stacker (1) on the rear
side of the printer and open it outward.
1

Note

●● Do not open or close the faceup stacker while printing as
it may result in a paper jam.

 Using the Facedown Stacker

Paper is delivered with the print side face down,
stacked in the order printed.

2

Unfold the paper support (2).

Note

●● Check that the faceup stacker (1) on the rear side of the
printer is closed. If the faceup stacker is open, paper is
always outputted to the faceup stacker.

2

3

Open the sub support (3).
3

1

Memo

●● Open the paper supporter (2) so that the printed papers
do not fall down from the top cover.

2

- 73 -

2
2. Printing Basic Operation

Output
Stacker

Convenient Print Functions

●●
Convenient Print Functions
The following convenient print functions are available. For details, refer to the User’s Manual
(Advanced).

2

 Printing on Postcards, Reply
Postcards or Envelopes

 Changing Print Quality
(Resolution)

2. Printing Basic Operation

You can change the print quality to suit your
needs.

 Printing on Labels
 Printing on Custom Size Paper

You can register customized paper sizes to the
printer driver so you can print on nonstandard
paper such as banners.

 Saving Toner

You can save toner by reducing printing density. A
toner saving can be set in 3 levels.
When printing in 100 % black, you can also
select the setting without a toner saving. Amount
of toner can be saved without affecting any
readability for small characters.

● Printing on custom size paper
A3
A4

●Saving toner

 Changing the Page Layout

You can change the page layout to multiple print,
booklet print and poster print etc.

●Multipie print

●Booklet print
12

1

2

3

4

11
9

1

3

●Poster print
1

2

3

4

Memo

●● There are many convenient print functions in addition to
those above. Refer to the User’s Manual (Advanced).

7

5

 Duplex Printing

You can print on both sides of a sheet of paper.
●Duplex prints

2

1

 Scaling to Pages

You can print data formatted for one size page
onto a different size page without modifying the
print data.

 Printing Color Data in
Monochrome
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Canceling Printing

●●
Canceling Printing
Press the <CANCEL> button on the operator
panel to cancel print jobs being currently printed
or preparing for a print.

2
2. Printing Basic Operation

When you press the <CANCEL> button is
pressed, the following message appears.

䎦䏄䏑䏆䏈䏏䎃䎧䏄䏗䏄䎢
䎼䏈䏖
䎱䏒

To cancel printing, select [Yes] and then press
the <ENTER> button.
To proceed to printing, select [No] and then
press the <ENTER> button.
If a printer is not operated for about 3 minutes
while this message appears, the message will go
out and printing proceeds.

- 75 -

Setting the Time that Elapses Before Entering the Power Save Mode

●●
Setting the Time that Elapses Before Entering the
Power Save Mode
Note

2

●● When a printer is in the power saving mode, press the <POWER SAVE> button to restore from the mode.
●● Check if the message “Ready To Print” appears. If the message is not displayed, press the <ON LINE> button.

2. Printing Basic Operation

1

Press the <Fn> key on the operator
panel.

Memo

●● The power save time can be selected from the followings:
--[1 minute]
--[2 minutes]
--[3 minutes]
--[4 minutes]
--[5 minutes]
--[10 minutes]
--[15 minutes]

2

Enter “200” using the ten-key pad and
then press the <ENTER> button.

--[30 minutes]
--[60 minutes]
--[120 minutes]

䎩䏘䏑䏆䏗䏌䏒䏑䎃䎱䏘䏐䏅䏈䏕
䎕䎓䎓
䎨䏑䏗䏈䏕䎃䎔䎐䎖䏇䏌䏊䏌䏗䎃䎱䏘䏐䏅䏈䏕

3

Press the scroll button or to specify
the time and then press the <ENTER>
button.
䎳䏒䏚䏈䏕䎃䎶䏄䏙䏈䎃䎷䏌䏐䏈䎔䎒䎖

䎍䎃䎔䎃䏐䏌䏑䏘䏗䏈
䎕䎃䏐䏌䏑䏘䏗䏈䏖
䎖䎃䏐䏌䏑䏘䏗䏈䏖
䎗䎃䏐䏌䏑䏘䏗䏈䏖

4

Press the <ON LINE> button.
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Setting the Time that Elapses Before Entering the Sleep Mode

●●
Setting the Time that Elapses Before Entering the
Sleep Mode
Note

●● When a printer is in the power saving mode, press the <POWER SAVE> button to restore from the mode.
●● Check if the message “Ready To Print” appears. If the message is not displayed, press the <ON LINE> button.

Press the <Fn> key on the operator
panel.

Memo

●● The sleep time can be selected from the followings:
--[1 minute]
--[2 minutes]
--[3 minutes]
--[4 minutes]
--[5 minutes]
--[10 minutes]
--[15 minutes]

2

Enter “201” using the ten-key pad and
then press the <ENTER> button.

--[30 minutes]
--[60 minutes]
--[120 minutes]

䎩䏘䏑䏆䏗䏌䏒䏑䎃䎱䏘䏐䏅䏈䏕
䎕䎓䎔
䎨䏑䏗䏈䏕䎃䎔䎐䎖䏇䏌䏊䏌䏗䎃䎱䏘䏐䏅䏈䏕

3

Press the or to specify the time and
then press the <ENTER> button.
䎶䏏䏈䏈䏓䎃䎷䏌䏐䏈䎃䎃䎃䎃䎕䎒䎖

䎍䎃䎖䎓䎃䏐䏌䏑䏘䏗䏈䏖
䎙䎓䎃䏐䏌䏑䏘䏗䏈䏖
䎔䎕䎓䎃䏐䏌䏑䏘䏗䏈䏖

4

Press the <ON LINE> button.
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2. Printing Basic Operation

1

2

Setting the Time that Elapses Before Entering the Sleep Mode

Constraints When in Sleep Mode
This section explains constraints when in the sleep mode.
The printer may not enter the sleep mode if an error is displayed.

2

Printer Driver Utility Constraints

2. Printing Basic Operation

When the printer goes into the sleep mode, the following constraints apply to the printer driver and
utility functions.
When the printer goes into the sleep mode, press the <POWER SAVE> button on the control panel
and check that the screen displays the message “Ready To Print”.
If the message “Ready To Print” is displayed, the following constraints do not apply.

OS
Windows

Mac OS X

Software Name

Constraints When in the
Sleep Mode

Configuration Tool

Cannot specify the network plug-in
settings.
Network Card Setup
Cannot search the printer or adjust
settings.
Printer Display Language Setup You cannot change settings when
there is a USB connection.
Driver Installer
If there is a connection with the
network, you cannot automatically
get printer option information
when installing a driver.
Printer Drivers
If there is either a USB or a
EtherTalk connection, you cannot
print.
Network Card Setup
Cannot search the printer or adjust
settings.
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Method of resolving
other than to press the
<POWER SAVE>
button
Connect to the printer through
the network.
-

Connect to the printer through
TCP/IP.
-

Setting the Time that Elapses Before Entering the Sleep Mode

Network Function Constraints

 Cannot Search/Cannot Specify
Settings

In the sleep mode, the following constraints
apply to network functions.

In the sleep mode, you cannot search or specify
settings with the following functions or protocols.
●● PnP-X

 Does Not Enter the Sleep Mode

In the following cases, a printer will not enter
the sleep mode.

●● UPnP

●● If IPSec is activated.

●● LLTD

●● If NetBEUI is activated.

●● MIB*

●● Bonjour (Rendezvous)

* You can reference through some supported MIB in the sleep mode
(Get command).

●● If EtherTalk is activated.
●● If a TCP connection is being established.
E.g.: If a connection is being established with
Telnet or FTP.
In the power save mode, the printer will go
into the sleep mode if the connection is broken
after some time passes.

 Protocols with the Client
Functions Do Not Work

●● When receiving e-mails is activated.

●● SNMP Trap

●● If you want to activate the sleep mode, please deactivate
IPSec/NetBEUI/NetWare/EtherTalk/receiving e-mail.

 Cannot Print

In the sleep mode, you cannot print with the
following protocols.
●● NetBEUI
●● NBT
●● NetWare
●● EtherTalk*

In the sleep mode, the following protocols with
client functions will not work.
●● E-mail alerts*1
●● WINS*2
●● SNTP*3
*1 Time that passes in the sleep mode is not included in the interval
for periodic notification by e-mail alert.
*2 Time that passes in the sleep mode is not included in the intervals
between WINS updates. Regular WINS updates are not carried out
in the sleep mode, so the names registered on the WINS server
may be deleted.
*3 Time that passes in the sleep mode is not included in the interval
between update for NTP servers.

 Protocols Needing the Sleep Mode
to be Disabled

●● Bonjour (Rendezvous)*

When using the following protocols, disable the
sleep mode.

* For Mac OS X, you can print while in sleep mode with an IP Print
connection.

●● IPv6
●● NetBEUI
●● NetWare
●● EtherTalk
●● Bonjour (Rendezvous)*
* For Mac OS X, you can print while in sleep mode with an IP Print
connection.
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2. Printing Basic Operation

●● If NetWare is activated.

Memo

2

Settings for Turning Power Off Automatically (Auto Power Off)

●●
Settings for Turning Power Off Automatically
(Auto Power Off)
Note

2

●● In the factory default, a printer does not enter the auto power off mode while connecting to the network.

2. Printing Basic Operation

Setting the Auto Power Off
Time

5

To enable the auto power off mode while
connecting to the network perform the following
procedure.

1

䎤䏇䏐䏌䏑䎃䎶䏈䏗䏘䏓䎃䎃䎃䎃䎃䎖䎒䎗
䎰䏈䏐䏒䏕䏜䎃䎶䏈䏗䏘䏓
䎶䏜䏖䏗䏈䏐䎃䎶䏈䏗䏘䏓
䎥䏘䏝䏝䏈䏕䎃䎶䏈䏗䏘䏓
䎳䏒䏚䏈䏕䎃䎶䏈䏗䏘䏓

Press the <ENTER> button on the
operator panel.

6

2

3

Press the scroll button several times
to select [Auto Power Off], and press
the <ENTER> button.
䎳䏒䏚䏈䏕䎃䎶䏈䏗䏘䏓䎃䎃䎃䎔䎒䎔
䎳䏒䏚䏈䏕䎃䎶䏄䏙䏈
䎶䏏䏈䏈䏓
䎤䏘䏗䏒䎃䎳䏒䏚䏈䏕䎃䎲䏉䏉

Press the scroll button several times
to select [Admin Setup], and press the
<ENTER> button.
䎩䏘䏑䏆䏗䏌䏒䏑䏖䎃䎃䎃䎃䎃䎃䎕䎒䎕
䎤䏇䏐䏌䏑䎃䎶䏈䏗䏘䏓
䫹䎦䏄䏏䏌䏅䏕䏄䏗䏌䏒䏑

Press the scroll button several times
to select [Power Setup], and press the
<ENTER> button.

7

Press the scroll button or to select
[Enable], and press the <ENTER>
button.
䎤䏘䏗䏒䎃䎳䏒䏚䏈䏕䎃䎲䏉䏉䎃䎃䎃䎔䎒䎔

Enter the administrator password, using
the numeric (0-9) keys.

䎍䎃䎃䎨䏑䏄䏅䏏䏈
䎤䏘䏗䏒䎃䎦䏒䏑䏉䏌䏊
䎧䏌䏖䏄䏅䏏䏈

The factory default password is “aaaaaa”. Press
the <ENTER> button whenever inputting one
character.

䎨䏑䏗䏈䏕䎃䎳䏄䏖䏖䏚䏒䏕䏇

8

䯴䎙䎐䎔䎕䏇䏌䏊䏌䏗䏖䎌

4

Press the <ENTER> button.
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Press the <ON LINE> button to exit the
menu mode.

Settings for Turning Power Off Automatically (Auto Power Off)

Setting the Time that Elapses Before
Entering the Auto Power Off Mode

Memo

●● The auto power off time can be selected from the
followings:
--[1 hour]

Note

--[2 hours]

●● When a printer is in the power saving mode, press the
<POWER SAVE> button to restore from the mode.

--[3 hours]
--[4 hours]

●● Check if the message “Ready To Print” appears. If the
message is not displayed, press the <ON LINE> button.

2

--[8 hours]
--[12 hours]

Press the <Fn> key on the operator
panel.

--[18 hours]
--[24 hours]

Enter “202” using the ten-key pad and
then press the <ENTER> button.

䎩䏘䏑䏆䏗䏌䏒䏑䎃䎱䏘䏐䏅䏈䏕
䎕䎓䎕
䎨䏑䏗䏈䏕䎃䎔䎐䎖䏇䏌䏊䏌䏗䎃䎱䏘䏐䏅䏈䏕

3

Press the scroll button or to specify
the time and then press the <ENTER>
button.

䎑䎑䎑䎃䎔䎒䎕

䎤䏘䏗䏒䎃䎳䏒䏚䏈䏕䎃䎲䏉䏉䎃䎷
䎍䎃䎔䎃䏋䏒䏘䏕
䎕䎃䏋䏒䏘䏕䏖
䎖䎃䏋䏒䏘䏕䏖
䎗䎃䏋䏒䏘䏕䏖

4

Press the <ON LINE> button.
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1

2

Setting the Buzzer

●●
Setting the Buzzer
You can specify whether to sound a buzzer when an invalid operation is performed on the operation
panel or when an error occurs.

2

1

Press the <ENTER> button on the
operator panel.

5

Press the scroll button several times
to select [Buzzer Setup], and press the
<ENTER> button.

2. Printing Basic Operation

䎤䏇䏐䏌䏑䎃䎶䏈䏗䏘䏓䎃䎃䎃䎃䎃䎖䎒䎗
䎰䏈䏐䏒䏕䏜䎃䎶䏈䏗䏘䏓
䎶䏜䏖䏗䏈䏐䎃䎶䏈䏗䏘䏓
䎥䏘䏝䏝䏈䏕䎃䎶䏈䏗䏘䏓
䎳䏒䏚䏈䏕䎃䎶䏈䏗䏘䏓

2

Press the scroll button several times
to select [Admin Setup], and press the
<ENTER> button.

6

䎩䏘䏑䏆䏗䏌䏒䏑䏖䎃䎃䎃䎃䎃䎃䎕䎒䎕
䎤䏇䏐䏌䏑䎃䎶䏈䏗䏘䏓
䫹䎦䏄䏏䏌䏅䏕䏄䏗䏌䏒䏑

Press the scroll button several times
to select [Invalid Operation Volume]
or [Error Volume], and press the
<ENTER> button.
䎥䏘䏝䏝䏈䏕䎃䎶䏈䏗䏘䏓䎃䎃䎃䎃䎔䎒䎔
䎬䏑䏙䏄䏏䏌䏇䎃䎲䏕䏈䏕䏄䏗䏌䏒䏑䎃䎹䏒䏏䏘
䎨䏕䏕䏒䏕䎃䎹䏒䏏䏘䏐䏈

3

Enter the administrator password, using
the numeric (0-9) keys.
The factory default password is “aaaaaa”. Press
the <ENTER> button whenever inputting one
character.

7

䎑䎑䎑

䎨䏑䏗䏈䏕䎃䎳䏄䏖䏖䏚䏒䏕䏇

䎬䏑䏙䏄䏏䏌䏇䎃䎲䏓䏈䏕䏄䏗䏌䏒䏑䎃䎹 䎔䎒䎔
䎲䏉䏉
䎍䎃䎯䏒䏚
䎫䏌䏊䏋

䯴䎙䎐䎔䎕䏇䏌䏊䏌䏗䏖䎌

4

Press the <ENTER> button.

Press the scroll button several times
to select a volume level, and press the
<ENTER> button.

8
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Press the <ON LINE> button to exit the
menu mode.

3. Troubleshooting
This chapter provides solutions to the problems you may encounter while operating your printer.
Memo

●● Meanings of symbols in error messages:
-- “%COLOR%” indicates Cyan (C), Magenta (M), Yellow (Y) or Black (K).
-- “%TRAY%” indicates tray 1, tray 2, tray 3, tray 4 or the MP tray.
-- “%COVER%” indicates a front cover or top cover.
-- “%CODE%” indicates a code number displayed in 1 to 3 digits. A code number changes according to an error.
-- “%MEDIA_SIZE%” indicates paper size.
●● When the message “Please see Help for details” appears on the display screen, you can check an error code and remedy
error by pressing the <HELP> button on the operator panel.

●●
When an Error Message Appears on the Display
Screen (When the ATTENTION Indicator Lights
Up/Blinks)
When a printer problem occurs, an error message appears on the display screen and the
<ATTENTION> indicator on the operator panel lights up or blinks. Check the error message and deal
with the problem according to the relevant procedure.
When “Please see Help for details” appears on the display screen, press the <HELP> button to display a
remedy.
Message on the display screen

<HELP> button

××××

Please see HELP for details.

When “Please see Help for details” appears on the display screen,
<ATTENTION> indicator

press the <HELP> button to display a remedy. Help is not available
when this message is not displayed.

Display Screen when the <HELP> button is pressed
Error Code

Scroll display upward

Remedy

Scroll display downward

××××
××××
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3. Troubleshooting

-- “%MEDIA_TYPE%” indicates a paper type.

3

When Paper Jams Occurs/When an Error Message does not Disappear Even After Jammed Paper is Removed

●●
When Paper Jams Occurs/When an Error
Message does not Disappear Even After Jammed
Paper is Removed
When paper is jammed inside a printer or when an error message does not disappear even after
jammed paper is removed, an error message appears on the display screen.

3

Press the <HELP> button to display a remedy. Remove jammed paper according to the remedy
displayed or the relevant procedure described in the following list.
<HELP> button

3. Troubleshooting

Message on the display screen (first line)
Message on the display screen (second line)

××××
××××

Please see HELP for details.

Press the <HELP> button to display a remedy.
<ATTENTION> indicator

Display Screen when the <HELP> button is pressed
Error Code

Scroll display upward

××××

Scroll display downward

Status
Paper jams

Message on the Display Screen
1st Line
2nd Line
3rd Line
1st Line
2nd Line
3rd Line
1st Line
2nd Line
3rd Line
1st Line
2nd Line
3rd Line
1st Line
2nd Line
3rd Line

Open Cassette
Paper Jam
%TRAY%
Open Cover
Paper Jam
Front Cover
Open Cover
Paper Jam
Front Cover
Open Cover
Paper Jam
Front Cover
Open Cover
Paper Jam
Top Cover
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Message displayed
after the <HELP>
button is pressed
Error Code

Reference
Page

391, 392, 393, 394

page 92

372

page 86

380

page 87

390

page 91

381

page 88

When Paper Jams Occurs/When an Error Message does not Disappear Even After Jammed Paper is Removed

Paper jams

A message does not
disappear.

Message on the Display Screen
1st Line
2nd Line
3rd Line
1st Line
2nd Line
1st Line
2nd Line
3rd Line
1st Line
2nd Line
3rd Line
1st Line
2nd Line
3rd Line
1st Line
2nd Line
3rd Line
1st Line
2nd Line
3rd Line
1st Line
2nd Line

Open Cover
Paper Jam
Top Cover
Check Duplex Unit
Paper Jam
Check Paper
Paper Multi Feed
%TRAY%
Open Cassette
Paper Remain
%TRAY%
Open Cover
Paper Remain
Front Cover
Open Cover
Paper Remain
Top Cover
Open Cover
Paper Remain
Top Cover
Check Duplex Unit
Paper Remain

Error Code 370, 371, 373, 641, 642

382, 383

page 89

370, 371, 373

page 85

401

page 87

3

631, 632, 633, 634

page 92

637

page 91

638

page 88

639, 640

page 89

641, 642

page 85

2

Check for jammed paper inside the
printer. If jammed paper remains,
remove it.

3

Check for jammed paper in the duplex
unit. If jammed paper remains, pull it
out gently.

A paper jam has occurred around the duplex
unit.

1

Reference
Page

3. Troubleshooting

Status

Message displayed
after the <HELP>
button is pressed
Error Code

Take out the duplex unit (1) by pulling
it obliquely upward while holding the
center recess on the back of printer.

1
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When Paper Jams Occurs/When an Error Message does not Disappear Even After Jammed Paper is Removed

4

Open the upper duplex unit cover (2)
and check for jammed paper. If jammed
paper remains, pull it out gently and
close the cover.

2

Remove the jammed paper gently in
the direction of the arrow if an edge of
jammed paper can be seen, and then
go to step 8. If you cannot find jammed
paper, go to step 3.

3

Take out the duplex unit (3) by pulling
it obliquely upward while holding the
center recess on the back of printer.

2

3
3. Troubleshooting

5

Replace the duplex unit (1) into the
printer.

1

3

Task is complete.

Error Code 372
A paper jam has occurred around the front
cover.

1

4

Check for jammed paper inside a printer.
If jammed paper remains, remove it.

5

Check if paper remains in the duplex
unit. If jammed paper remains, pull it
out gently.

Insert your finger into the recess on
the right side of the printer and pull the
front cover open lever (1) to open the
front cover (2) forward.

1

2
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When Paper Jams Occurs/When an Error Message does not Disappear Even After Jammed Paper is Removed

6

Open the upper duplex unit cover (4)
and check for jammed paper. If jammed
paper remains, remove it, and close the
cover.

Error Code 380, 401, 637
A paper jam has occurred around the front
cover.

1

4

Insert your finger into the recess on
the right side of the printer and pull the
front cover open lever (1) to open the
front cover (2) forward.

3

Replace the duplex unit (3) to the
printer.

1

2

2

Remove the jammed paper gently in the
direction of the arrow if you can see an
edge of jammed paper.

3

Close the front cover (2).

3

8

Close the front cover (2).

2

2

Task is complete.
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3. Troubleshooting

7

When Paper Jams Occurs/When an Error Message does not Disappear Even After Jammed Paper is Removed

Error Code 381, 638

4

Cover the removed image drums with
paper so that the image drums are not
exposed to light.

5

Pull out the jammed paper gently to the
rear of the printer (the direction of the
arrow) if an edge of jammed paper can
be seen.

A paper jam has occurred under an image drum.

1

Insert your finger into the recess on
the right side of the printer and pull the
front cover open lever (1) to open the
front cover (2) forward.

3
3. Troubleshooting

1

2

2

Press the top cover open button (3) and
open the top cover (4).

CAUTION

Possible to get
burned.

●● The fuser unit is extremely hot. Do not touch
it.
3
4

Pull out the jammed paper gently while
lifting the release levers (5) on the fuser
unit if an edge of jammed paper cannot
be seen.
If an edge of jammed paper still remains inside
the unit, pull out the jammed paper gently to the
rear of the printer.

3

Remove all four image drums and place
them on a flat surface.

5
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When Paper Jams Occurs/When an Error Message does not Disappear Even After Jammed Paper is Removed

6

Return all four image drums into the
printer carefully.

Error Code 382, 383, 639, 640
A paper jam has occurred around the fuser unit.

1

Insert your finger into the recess on
the right side of the printer and pull the
front cover open lever (1) to open the
front cover (2) forward.

3

7

Close the top cover (4) by pushing the
both sides of the cover firmly.
4

2

2

Press the top cover open button (3) and
open the top cover (4).

CAUTION

Possible to get
burned.

●● The fuser unit is extremely hot. Do not touch
it.
3
4

8

Close the front cover (2).
Note

●● The front cover cannot be closed if the top cover is
not closed securely.

3

2

Task is complete.
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Remove all four image drums and place
them on a flat surface.

3. Troubleshooting

1

When Paper Jams Occurs/When an Error Message does not Disappear Even After Jammed Paper is Removed

4

Cover the removed image drums with
paper so that the image drums are not
exposed to light.

7

Hold the fuser unit handle (6) and lift
the fuser unit out of the printer.
6

3
3. Troubleshooting

5

Remove the jammed paper remaining
inside of the unit.

8

Lift the release levers (7) on the fuser
unit, and pull out the jammed paper
forward gently.
7

6

Lift the left lock lever (5) of the fuser
unit forward.

9

Hold the fuser unit handle (6) and place
the fuser unit into the printer.
6

5
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When Paper Jams Occurs/When an Error Message does not Disappear Even After Jammed Paper is Removed

10 Push the left lock lever (5) of the fuser
unit backward.

13 Close the front cover (2).
Note

●● Cannot close the front cover securely if the top cover
is not closed.
5

3
2

printer carefully.

Task is complete.

Error Code 390, 637
A paper jam has occurred while feeding paper
from a paper tray.

1

If there is any paper on the MP tray, lift
the paper set cover (1) and take it out.

1

12 Close the top cover (4) by pushing the
both sides of the cover firmly.
4

2

Insert your finger into the recess on
the right side of the printer and pull the
front cover open lever (2) to open the
front cover (3) forward.
2

3
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3. Troubleshooting

11 Return all four image drums into the

When Paper Jams Occurs/When an Error Message does not Disappear Even After Jammed Paper is Removed

3

Remove the jammed paper gently by
pulling the edge of paper.

6

Lower the paper set cover (1).

3
1

3. Troubleshooting

Remove the paper from the back gently
if the edge of paper cannot be seen.

Task is complete.

Error Code 391, 392, 393, 394, 631,
632, 633, 634
A paper jam has occurred while feeding paper
from a paper tray.
Note

●● If paper jams occur frequently, clean the paper feed
rollers. For details, refer to “Cleaning Paper Feed Rollers”
P.127.

This procedure uses Tray 1 as an example.

4

1

Close the front cover (3).

Gently pull out from the printer the tray
(1) for which an error is indicated.

3

5

If loading paper on MP tray, lift the
paper set cover (1) and set the paper
with the print side face up.

1

1
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When Paper Jams Occurs/When an Error Message does not Disappear Even After Jammed Paper is Removed

2

5

Remove the jammed paper.

Close the front cover (3).

3
3

Task is complete.

Return the tray (1) to the printer.

Memo

●● Open and close the front cover after removing the
jammed paper otherwise the error indication do not go
out.

1

4

Insert your finger into the recess on
the right side of the printer and pull the
front cover open lever (2) to open the
front cover (3) forward.

2

3
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3. Troubleshooting

3

When the Message for Replacement of Consumables or Maintenance Unit Appears

●●
When the Message for Replacement of
Consumables or Maintenance Unit Appears
When the time to replace consumables or maintenance unit is close and replacement must be done,
the message “…Low”, “…Near Life”, “…Empty”, “…Life”, “Istall…”, “Replace…”, “Change…”
appears on the display screen and the <ATTENTION> indicator on the operator panel lights up or blinks.
Check the message and replace consumables and maintenance unit.

3

<HELP> button
Message on the display screen (first line)

××××

Message on the display screen (second line)

××××
××××

3. Troubleshooting

Message on the display screen (third line)

××××
Please see HELP for details.

Message on the display screen (fourth line)

Press the <HELP> button to display a remedy.

<ATTENTION> indicator

Display Screen when the <HELP> button is pressed
Error Code

Scroll display upwards

××××
××××

Scroll display downwards
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When the Message for Replacement of Consumables or Maintenance Unit Appears
Memo

●● “xxx” described on the list below changes according to the printer status.

Status

Message on the Display Screen

Toner Cartridge 1st Line
2nd Line

2nd Line

Image Drums

-

xxx
%COLOR% Toner Empty
xxx
%COLOR% Toner Empty
Install Toner
%COLOR%
Install Toner Or Press Online
Button
%COLOR%

-

Prepare a new toner
cartridge, and replace the
old toner cartridge with new
one after a message for
replacement of consumables
or maintenance unit appears.
page 114

-

page 114

410, 411, 412
413
410, 411, 412

page 117
page 115 (Black toner)
page 114
If a black toner remains, you
can print in black and white
by selecting [Monochrome].
However, replace the toner
cartridge soon after it runs
out. Otherwise, it may cause
the damage to an image
drum.
Prepare new image drums,
and replace the old image
drums with new ones after a
message for replacement of
consumables or maintenance
unit appears.
page 119

1st Line
2nd Line

xxx
%COLOR% Image Drum Near
Life

-

1st Line
2nd Line
1st Line
2nd Line

xxx
%COLOR% Image Drum Life
xxx
%COLOR% Image Drum Life,
%nnn% Pages Left
xxx
%COLOR% Image Drum Life
Install New Image Drum
Image Drum Life
%COLOR%

-

1st Line
2nd Line
1st Line
2nd Line
3rd Line

1st Line
2nd Line
3rd Line
1st Line
2nd Line
3rd Line
4th Line

Install New Image Drum
Image Drum Life
%COLOR%
Install New Image Drum
Image Drum Life
%COLOR%
To Exceed the Life, Press
Online Button

- 95 -

Reference Page or
Remedy

-

page 119
The number of pages you can
print is displayed in “nnn”.

-

page 119

350, 351, 352, 353

560, 561, 562, 565

564, 565, 566, 567

page 119
If a toner remains, you can
continue to print by opening
or closing the front cover.
However, replace the toner
cartridge soon. Otherwise, it
may cause a decrease in a
printing quality.
page 119

page 119

3
3. Troubleshooting

1st Line
2nd Line
1st Line
2nd Line
1st Line
2nd Line
1st Line

xxx
%COLOR% Toner Low

Message displayed
after the <HELP>
button is pressed
Error Code

When the Message for Replacement of Consumables or Maintenance Unit Appears

Status
Image Drums

Fuser Unit

3
3. Troubleshooting
Belt Unit

Message on the Display Screen
1st Line
2nd Line

Message displayed
after the <HELP>
button is pressed
Error Code

Reference Page or
Remedy

680, 681, 682, 683

page 119

-

Prepare a fuser unit, and
replace the old fuser unit with
new one after a message for
replacement of consumables
or maintenance unit appears.
page 124

3rd Line
1st Line
2nd Line

Install New Image Drum
Printing disabled due to low
threshold of Image Drum life.
%COLOR%
xxx
Fuser Unit Near Life

1st Line
2nd Line
1st Line
2nd Line

xxx
Change Fuser Unit
Install New Fuser Unit
Fuser Unit Life

1st Line
2nd Line

xxx
Belt Unit Near Life

-

1st Line
2nd Line
1st Line
2nd Line

xxx
Change Belt Unit
Install New Belt Unit
Belt Unit Life

-

354

355
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page 124
You can continue to print by
opening or closing the front
cover for a while. However
replace the toner cartridge
soon. Otherwise, it may cause
a printer error or paper jam.
Prepare a belt unit, and
replace the old belt unit with
new one after a message for
replacement of consumables
or maintenance unit appears.
page 122
page 122
You can continue to print by
opening or closing the front
cover for a while. However
replace the toner cartridge
soon. Otherwise, it may cause
a printer error.

When the Message for Paper Replacement or Paper Size Error Appears

●●
When the Message for Paper Replacement or
Paper Size Error Appears
When the media type or media size loaded in a tray does not match the settings specified in the printer
driver, the message “Change Paper...” or “Check Paper...” appears on the display screen and the
<ATTENTION> indicator blinks.
Check the message and deal with the problem. Check the paper size and the settings, refer to “How to
Print from the Tray” P.64 or “How to Print from the MP Tray” P.65.

3

<HELP> button
Message on the display screen (first line)

××××
××××

3. Troubleshooting

Message on the display screen (second line)

××××

Message on the display screen (third line)

××××
Please see HELP for details.

Message on the display screen (fourth line)

Press the <HELP> button to display a remedy.

<ATTENTION> indicator

Display Screen when the <HELP> button is pressed
Error Code

Scroll display upward

××××
××××

Scroll display downward

Status

Change Paper

Paper Size does not match print data.

Paper Size Error

Message on the Display Screen

1st Line
2nd Line
3rd Line
4th Line
1st Line
2nd Line
3rd Line
4th Line
1st Line
2nd Line
3rd Line
4th Line
1st Line
2nd Line
3rd Line
4th Line
1st Line
2nd Line
3rd Line
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Change Paper in %TRAY%
%MEDIA_SIZE%
%MEDIA_TYPE%
Press ONLINE Button
Change Paper in MPTray
%MEDIA_SIZE%
%MEDIA_TYPE%
Press ONLINE Button
Change Paper in %TRAY%
%MEDIA_SIZE%
%MEDIA_TYPE%
Press ONLINE Button
Change Paper in MPTray
%MEDIA_SIZE%
%MEDIA_TYPE%
Press ONLINE Button
Check Paper
Paper Size Error
%TRAY%

Message
displayed after
the <HELP>
button is
pressed
Error Code
661, 662, 663, 664

660

461, 462, 463, 464

460

400

Other Error Messages

●●
Other Error Messages
This section explains the causes and remedies for an error message and the function of the
<ATTENTION> indicator. An error message appears on the display screen of the operator panel.
To display an error code, press the <HELP> button on the operator panel.

Error Messages

3

Error
code

Message

<ATTENTION>
indicator

3. Troubleshooting

420

Press ONLINE Button for
RestorationMemory Overflow

Blinks

310
311

Close Cover
%COLOR%

Blinks

320
348

n*
610
611
612
613

Please see HELP for details
Check Fuser Unit
Please see HELP for details
Check Data
Message Data Write Error<%CODE%>
Toner Not Installed
%COLOR%

Cause/Remedy
The memory overflowed.
Reduce the data amount. If that does not
work, reduce the size of the print data.
The cover is open.
Close the cover.
310 : Top cover
311 : Front cover

Blinks

The fuser unit is not correctly installed.
Install the fuser unit correctly in a printer.

Blinks

Writing of message data to be uploaded to a
printer has been failed.
The toner cartridge of the indicated color
is not installed correctly. Install the toner
cartridge correctly.
610 : Yellow (Y)
611 : Magenta (M)
612 : Cyan (C)
613 : Black (K)
The toner cartridge of the indicated color is
not locked properly.
Turn the blue lever on the right side of the
cartridge backwards until it stops.
544 : Yellow (Y)
545 : Magenta (M)
546 : Cyan (C)
547 : Black (K)
Something is wrong with the toner sensor of
the indicated color or the image drum is not
installed correctly.
Install the toner cartridge or image drum of
the indicated color correctly.
540 : Yellow (Y)
541 : Magenta (M)
542 : Cyan (C)
543 : Black (K)
A paper cassette is not in the indicated tray.
Insert the paper cassette into the indicated
tray.
If the cassette is already inserted in the
printer, pull out the cassette and set it again
to correctly locate it.
430, 440 : Tray1
431, 441 : Tray2
432, 442 : Tray3
433 : Tray4

Blinks

Please see HELP for details

544
545
546
547

Check Toner Cartridge
Improper Lock Lever Position
%COLOR%

Blinks

540
541
542
543

Toner Sensor Error
%COLOR%

Blinks

430
431
432
433
440
441
442

Install Paper Cassette
%TRAY%

Blinks

Please see HELP for details

Please see HELP for details
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Other Error Messages

Error
code
356

Message
Install New Belt Unit
Belt Unit Life
Please see HELP for details
File System is Full
File System is Write Protected

330

490

694
696
696
697

Blinks

Lights up
Lights up
Blinks

Cause/Remedy
The belt unit is at the end of its life.
Replace it with a new belt unit.

The file system is full.
The file system to which you tried to write is
write-protected.
The belt unit is not properly installed.
Reinstall it properly.

Please see HELP for details
Deleting Encrypted Job
Print Restricted. Job Rejected

Lights up
Lights up

Press ONLINE Button
Color Restricted. Job Rejected

Deleting an encrypted job.
A print job sent by a user who is not
authorized for printing is deleted.

Lights up

Press ONLINE Button
Color Restricted. Mono Printed

A color print job sent by a user who is not
authorized for color printing is deleted.

Lights up

A color print job sent by a user who is not
authorized for color printing is printed in the
mono-print mode.
Secret file to be erased are full.
The indicated tray is empty.
Load the indicated size paper.
491 : Tray1
492 : Tray2
493 : Tray3
494 : Tray4
Erasing a secret file.
A postscript error has occurred.
Paper in the MP tray is empty.
Load the indicated size paper.

Press ONLINE Button
Erased Data Full
Install Paper
%TRAY%
%MEDIA_SIZE%

Lights up
Blinks

Please see HELP for details
File Erasing
Error Postscript
Install Paper
MPTray
%MEDIA_SIZE%
Press ONLINE Button
Please see HELP for details
Image Drum Not Installed
%COLOR%

Lights up
Blinks
Blinks

Blinks

Please see HELP for details

340
341
342
343

Check Image Drum
%COLOR%

nnn*

Wait a Moment
Rebooting <n>

Blinks

Please see HELP for details

%COLOR% Toner Sensor Error

Blinks

Lights up
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The image drum of the indicated color is not
installed correctly. Install the image drum
correctly.
694 : Yellow (Y)
695 : Magenta (M)
696 : Cyan (C)
697 : Black (K)
The image drum of the indicated color is not
installed correctly. Install the image drum
correctly.
340 : Yellow (Y)
341 : Magenta (M)
342 : Cyan (C)
343 : Black (K)
An error has occurred inside the printer.
The printer is restarted. 1-digit error code
appears. A code number changes according
to an error.
Something is wrong with the toner sensor of
the indicated color or the image drum is not
installed correctly.
Install the toner cartridge or image drum of
the indicated color correctly.

3
3. Troubleshooting

491
492
493
494

Check Belt Unit

<ATTENTION>
indicator

Other Error Messages

Error
code

3

Message
%COLOR% Toner Not Installed

Lights up

%TRAY% Empty

Lights up

Unsupported USB Device Detected

Lights up

3. Troubleshooting

Please detach it
Install Paper
MPTray
%MEDIA_SIZE%
Press ONLINE Button
%COLOR% Waste Toner Full.Replace Toner.

Lights up

Collate Fail:Too Many Pages

Lights up

Press ONLINE Button
File System Operation failed<nnn>

Lights up

Press ONLINE Button
Power Off and Wait for a while
126:Condensing Error

360

<ATTENTION>
indicator

Blinks

Blinks

Cause/Remedy
The toner cartridge of the indicated color
is not installed correctly. Install the toner
cartridge correctly.
The indicated tray is empty.
Load the indicated size paper.
A USB device unsupported by a printer is
connected. Remove the device.
Load the paper of the size indicated in the
MP tray, and then press the <ON LINE>
button.
Waste toner is full. Replace with a new toner
cartridge of the indicated color.
A collate print error has occurred.
Reduce the data amount. If that does not
work, reduce the size of the print data.
An error of file system for a printer has
occurred.
A condensation has occurred inside a printer.
Turn the printer off and turn on again after
a while.
Invalid source data is received in an
authentication printing and deleted.

Invalid Secure Data

Lights up

Press ONLINE Button
USB Hub Unsupported

Lights up

Please detach it
Log Buffer is Full. Job Rejected

A USB hub unsupported by a printer is
connected. Remove the hub.

Lights up

Print data is deleted because the accounting
log buffer is full. Contact a printer
administrator and remove the log buffer.

Blinks

A duplex unit is not installed correctly.
Install a duplex unit in a printer correctly.
When a duplex unit is already installed, pull
out the unit, and then install it again.
An error occurred inside the printer. Turn the
printer off and then on again.
A fatal error has occurred in a printer.
Write down the indicated alphanumerical
characters and contact your dealer.

Press ONLINE Button
Install Duplex Unit

Please see HELP for details
nnn* Service Call
nnn: Error
nnn* Power Off/On
nnn:Error
PC:nnnnnnnn
LR:nnnnnnnn
FR:nnnnnnnn

Blinks
Blinks
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When You Cannot Print from the MP Tray

●●
When You Cannot Print from the MP Tray
If you print from the MP tray without moving down the paper set cover, the message
“Install Paper MPTray” appears on the display screen.
Check the message and deal with the problem. Refer to ”How to Print from the MP Tray” P.65.

3

Paper set cover

3. Troubleshooting

- 101 -

Other Issues

●●
Other Issues
This section explains the issues you may encounter while operating your printer and how to solve them.

Unable to Print from a Computer
Memo

●● If the following information does not solve the issue, contact your dealer.

3

●● For issues caused by an application, contact the manufacturer of the application.

General Causes

3. Troubleshooting

 Common to Windows and Mac OS X
Cause
The printer is in the sleep mode.

The printer is turned off.
An Ethernet or USB cable is unplugged.
Something is wrong with a cable.
The printer is off line.
An error message is displayed on the
display screen of the operator panel.
The interface setting is disabled.
Something is wrong with the print
function.

Remedy

Reference

Press the <POWER SAVE> button on the operator
panel to enter the standby mode.
If the sleep mode is not used, disable it from the
<ENTER> button > [Admin Setup] > [Power Setup]
> [Sleep] > [Disable].
Turn on the printer.
Check that the cable is plugged into the printer and
computer properly.
Replace it with a new cable.
Press the <ON LINE> button.

page 22

“Error Messages” or press the <HELP> button on the
operator panel.
Check the setting of the interface being used from the
operator panel.
Check if you can print the contents of the settings.

page 98

page 21
-

Advanced
page 30

 For Windows
Cause
The printer is not set as the default
printer.
The output port for the printer driver is
incorrect.
A print job from another interface is in
progress.
“Received invalid data” is displayed on
the display screen and printing cannot
be done.
A print job is automatically canceled.

Remedy

Reference

Set the printer as the default printer.

-

Select the output port to which the Ethernet or USB
cable is connected.
Wait until the print job is done.

-

Press the <ENTER> button and select [Menus] >
[System Adjust] > [Wait Timeout], and then select a
longer time. The default setting is 40 seconds.
If using Print Job Control, the print job is not authorized
to print, or the Job Accounting log buffer may be full.

-
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Advanced

Other Issues

Network Connection Problems
 Common to Windows and Mac OS X
Cause
Using a crossover cable.
The printer is turned on before a cable
was connected.
The hub and the printer are incompatible
or have some problem.
It takes much time to print because of
the hub settings

Remedy
Use a straight cable.
Connect cables before turning on the printer.
Press the <ENTER> button and select [Admin Setup]
> [Network Setup] > [HUB Link Setting], and then
select [10Base-T Half].
Press the <ENTER> button > [Admin Setup] >
[Network Setup] > [TCP ACK] > [Tray2].

Reference
page 32
-

-

Cause
IP address is incorrect.

Remedy
●● Check that the same IP address is set for the printer
and the printer's port setting on the computer.
●● If using LPR Utility, check the IP address setting in
LPR Utility.

Reference
-

USB Connection Problems
 Common to Windows and Mac OS X
Cause
Unsupported USB cable is being used.
A USB hub is being used.
Printer driver is not installed correctly.

Remedy
Use a USB 2.0 cable.
Connect the printer directly to the computer.
Reinstall printer driver.

Reference
page 52
page 52,
page 54

 For Windows
Cause
The printer is off line.

Remedy

Reference

Right-click the OKI C831 icon, and then select
[See what's printing] ([OKI C831(*)] when multiple
printer drivers are installed). In the dialog box, select
the [Printer] menu and then remove the check from
[Use Printer Offline].

-

* Select the type of a printer driver you want.

A switch, buffer, extension cable or USB
Connect the printer directly to the computer.
hub is being used.
A driver for a different printer that uses a Delete the other printer driver from the computer.
USB connection has been installed.
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page 52
-

3. Troubleshooting

 For Windows

3

Other Issues

Unable to Install a Printer Driver Successfully
Memo

●● If the following information does not solve the issue, contact your dealer.
●● For issues caused by an application, contact the manufacturer of the application.

USB Connection Problems

3

 For Windows
Cause

3. Troubleshooting

An icon of the printer is not created on
the [Devices and Printers] folder.
Only the first printer driver is installed
even if multiple printer drivers are
selected to install.

Remedy

Reference

The printer driver is not installed correctly.
Reinstall the printer driver correctly.
Follow the procedure below to install the second and
subsequent printer drivers:
1. I nsert the "Software DVD-ROM" into the computer.
2. C
 lick [Run setup.exe] and follow the on-screen
instructions.
3. S
 elect [Custom Installation (Printer)] from
[Driver Installation].
4. C
 lick [Next].
5. S
 elect [Local Printer] and then click [Next].
6. O
 n the [Printer port] screen, select [FILE] and then
click [Next].
7. C
 omplete the setup following the on-screen
instructions.
8. I n the [Devices and Printers], right-click the
icon of the second or subsequent driver and select
[Printer properties] ( [OKI C831(*)] when
multiple printer drivers are installed).

page 52
-

*Select the type of a printer driver you want.

The “Unable to install printer driver”
error message is displayed.

9. F
 rom the [Ports] tab, select [USBxxx] from the list.
10. C
 lick [OK].
Use Plug-and-Play. Follow the procedure below.
1. E
 nsure that the printer and computer is turned off.
2. C
 onnect a USB cable.
3. T
 urn on the printer.
4. T
 urn on the computer.
5. W
 hen the Found New Hardware Wizard is displayed,
follow the on-screen instructions to complete the
setup.
For details, refer to [README.TXT] in the "Software
DVD-ROM".

- 104 -

-

Other Issues

OS-Specific Constraints
Constraints with Windows 7/Windows Vista/Windows Server 2008 R2/
Windows Server 2008
Item
Printer drivers

[Help] is not displayed.
The [User Account Control]
dialog appears.

The [User Account Control]
dialog appears.

The [Program Capability
Assistant] dialog appears.

PS Gamma
Adjuster

The [User Account Control]
dialog appears.

The [Program Capability
Assistant] dialog appears.

Cause/Remedy
The [Help] function is not supported on PS printer drivers.
When you launch an installer or utility, the [User Account
Control] dialog may appear. Click [Yes] or [Continue] to
run the installer or utility as an administrator. If you click
[No], the installer or utility does not start.
When you launch an installer or utility, the [User Account
Control] dialog may appear. Click [Yes] or [Continue] to
run the installer or utility as an administrator. If you click
[No], the installer or utility does not start.
If the [Program Capability Assistant] dialog appears
after an installation (including if you stop an installation
before it is completed), make sure to click [This program
installed correctly].
When you launch an installer or utility, the [User Account
Control] dialog may appear. Click [Yes] or [Continue] to
run the installer or utility as an administrator. If you click
[No], the installer or utility does not start.
If the [Program Capability Assistant] dialog appears
after an installation (including if you stop an installation
before it is completed), make sure to click [This program
installed correctly].

Constraints with Windows Server 2003 Service Pack 1 and Windows XP
Service Pack 2
 Constraints with Windows Firewall

On Windows Server 2003 Service Pack 1 and Windows XP Service Pack 2, the Windows firewall
functionality is enhanced. The following constraints may apply to printer drivers and utilities.
Memo

●● The following procedures are explained using Windows XP Service Pack 2 as an example. The procedure and menu names may
differ on Windows Server 2003 Service Pack 1.

Item

Symptom

Printer driver

You cannot print a file when
using the printer as a shared
printer on a network.

LPR Utility

Unable to find a printer.

Cause/Remedy
On the server, click [Start] and then select [Operator
panel] > [Security Center] > [Windows Firewall].
Select the [Exceptions] tab and select the [File and
Printer Sharing] check box. Click [OK].
If the [Don't allow exceptions] check box is selected
on the [General] tab of the Windows firewall, you cannot
search for a printer in a segment that is connected to
another router. Only printers within the same segment as
the printer can be searched.
When you cannot find a printer, specify the IP address of
the printer in the [Add Printer] or [Confirm Connections]
screen.
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3
3. Troubleshooting

Color Correct
Utility

Symptom

Other Issues

Item
Configuration tool

3

Symptom
Unable to find a printer.

Cause/Remedy
If the [Don't allow exceptions] check box is selected on
the [General] tab of Windows Firewall, you cannot search
for a printer in a segment that is connected to another
router. Only printers within the same segment as the printer
can be searched.
When you cannot find a printer, enter the printer name
(arbitrary) and IP address in [Printer] > [Add or Remove
Printer] and click [Add].

Image Quality Issues

3. Troubleshooting

Memo

●● If the following information does not solve your issues, contact your dealer.

Symptom
Vertical lines appear.

Paper feed direction

Printed images are
fading vertically.

Point to check

Remedy

The LED heads are dirty.
The toner is low.
The image drum is damaged.
Foreign materials may be present
on the image drum.
The light-shielding film of the
image drum is dirty.
The image drum is not installed
properly.
The LED heads are dirty.
The toner is low.
The paper is unsuitable.

Reference

Wipe the LED heads with a soft
tissue paper.
Replace the toner cartridge.
Replace the image drum.
Replace the image drum.

page 129

Wipe the film with a soft tissue
paper.
Install the image drum properly.

-

page 114
page 119
page 119

page 119

Wipe the LED heads with soft
tissue paper.
Replace the toner cartridge.
Use supported paper.

page 129

Change the toner save settings.
Install the toner cartridge properly.

page 114

Replace the toner cartridge.
Use paper stored in proper
temperature and humidity
conditions.
Use supported paper.
Press the <ENTER> button
and select [Menus] > [Tray
Configuration] > the paper tray
configuration you are using, and
then select the proper values
for [Media Type] and [Media
Weight]. Or, select a larger value
for [Media Weight].
Press the <ENTER> button
and select [Menus] > [Tray
Configuration] > the paper tray
you are using, and then select a
larger value for [Media Weight].

page 114
page 59

page 114
page 59

Paper feed direction

Printed images are light. The toner save is enabled.
The toner cartridge is not installed
properly.
The toner is low.
The paper is moist.

The paper is unsuitable.
The paper is unsuitable.
The settings of media type and
weight are incorrect.

The paper is recycled.
The media weight setting is
unsuitable.
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page 59
page 59

page 59

Other Issues

Symptom
Printed images are
partially faded. Spots
and lines appear.

Paper feed direction

White area of paper is
lightly stained.

Periphery of letters is
smudged.

Remedy

The paper is too moist or dry.

Use paper stored in proper
temperature and humidity
conditions.
[Paper Black Setting] or
Press the <ENTER> button
[Paper Color Setting] is
and select [Menus] > [System
improperly configured.
Adjust], and then change the
value for [Paper Black Setting]
or [Paper Color Setting].
[Trans. Black Setting] or
Press the <ENTER> button and
[Trans. Color Setting] is
select [Menus] > [System
improperly configured.
Adjust], and then change the
value for [Trans. Black Setting]
or [Trans. Color Setting].
If the interval of lines or spots
Lightly wipe the image drum with
is about 94 mm (4 inches), the
soft tissue paper.
image drum (the green tube) is
Replace the image drum if it is
damaged or dirty.
damaged.
If the interval of lines or spots is
Open and close the top cover, and
about 30 mm (1.5 inches), foreign print again.
materials may be present on the
image drum.
If the interval of lines or spots is
Change the fuser unit.
about 143 mm, there is damage to
the fuser unit.
The image drum has been exposed Place the image drum back into
to light.
the printer and leave it for a few
hours. If that does not solve the
problem, replace the image drum.
The paper feed path is dirty.
Print a few test copies.
The paper contains static
Use paper stored in proper
electricity.
temperature and humidity
conditions.
The paper is too thick.
Use thinner paper.
The toner is low.
Replace the toner cartridge.

The LED heads are dirty.

Wipe the LED heads with soft
tissue paper.
Use recommended paper.
Replace it with new paper.

The paper is unsuitable.
The paper is moist.

The entire paper area
The toner may be sticking to the
is lightly stained when
whole area of the envelope or
printing on envelopes or coated paper.
coated paper.
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This is not a malfunction of the
printer.
Coated paper is not recommended.

Reference
page 59

-

-

page 119

-

page 124

page 119

page 59

page 114

page 129
page 59

-

3
3. Troubleshooting

Horizontal lines
and spots appear
periodically.

Point to check

Other Issues

Symptom
Toner comes off when it
is rubbed.

Point to check
The settings of media type and
weight are incorrect.

The paper is recycled.
The media weight setting is
unsuitable.

3
3. Troubleshooting

Glossiness is not
uniform.

The settings of media type and
weight are incorrect.

Color of the printed
image is not what you
expect.

The toner is low.
The setting of [Black Finish] is
not suitable for the application.

The color adjustment has been
modified.
The color balance is out of
adjustment.
Color registration is out of
alignment.

Remedy

Reference

Press the <ENTER> button
and select [Menus] > [Tray
Configuration] > the paper
tray configuration you are using,
and then select the proper
values for [Media Type] and
[Media Weight]. Or, select a
heavier weight in [Media Weight].
Press the <ENTER> button
and select [Menus] > [Tray
Configuration] > the paper tray
configuration you are using, and
then select a heavier weight for
[Media Weight].
Press the <ENTER> button
and select [Menus] > [Tray
Configuration] > the paper
tray configuration you are using,
and then select the proper
values for [Media Type] and
[Media Weight]. Or, select a
heavier weight in [Media Weight].
Replace the toner cartridge.
On the printer driver, select
[Composite Black (CMYK)]
of [True Black (K)] for [Black
Finish].
Do color matching from the printer
driver.
Press the <ENTER> button and
select [Calibration], and then
[Adjust Density].
Open and close the top cover.
Or, press the <ENTER> button
and select [Calibration], and then
[Adjust Registration].
Press the <ENTER> button
and select [Admin Setup] >
[Color Setup] > [CMY100%
Density], and then select
[Enable].

page 59

Solid printing of CMY
100% is too light.

[CMY100% Density] is set to
[Disable].

Dots appear.

The paper is unsuitable.
When the interval of the dots
is about 94 mm (4 inches), the
image drum (the green tube) is
damaged or dirty.

Use supported paper.
Lightly wipe the image drum with a
soft tissue paper.
Replace the image drum when it is
damaged.

Smears is printed.

The paper is moist.
The paper is unsuitable.

Replace it with new paper.
Use supported paper.
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page 59

page 59

page 114
Advanced

Advanced
Advanced

Advanced

-

page 59
page 119

page 59
page 59

Other Issues

Symptom

Point to check

Remedy

Reference

The printer may be malfunctioning. Contact your dealer.

Nothing is printed.

Two or more sheets of paper are
Fan the paper well and load it
fed simultaneously.
again.
The printer may be malfunctioning. Contact your dealer.

page 64,
page 65
-

The paper is moist.
The paper is unsuitable.

page 59
page 59

?

Patches appear.

Replace it with new paper.
Use supported paper.

Back cover

Feeding Issues
Memo

●● If the following information does not solve the issue, contact your dealer.

Symptom
●● The paper often
jams.
●● Multiple sheets
are fed at once.
●● The paper is fed
at an angle.

Point to check
The printer is tilted.
The paper is too light or too heavy.
The paper is moist or has a static
charge.
The paper is wrinkled, folded or
curled.
Something is already printed on the
back side of the paper.
The edges of the paper are not kept
even.
There is only one sheet of paper in
the tray.
You have added more paper with
paper already loaded in the tray.

Remedy

Reference

Place the printer on a flat surface.
Use the appropriate paper for the
printer.
Use paper stored in proper
temperature and humidity
conditions.
Use appropriate paper for the printer.
Fix the curled paper.
With tray 1/2/3/4, you cannot use
paper that has been printed.
Load it on the MP tray for printing.
Fan the paper and even up the
edges.
Load several sheets of paper.

page 16
page 59

Remove the already loaded paper,
stack it onto the new paper, even up
the edges and load the paper with
the old paper on top.
The paper is loaded at an angle.
For tray 1/2/3/4, adjust the paper
width guide and stopper to the
paper.
For the MP tray, adjust the paper
width guide to the paper.
Envelopes are not correctly loaded.
Load envelopes correctly.
Paper, envelopes or labels of weight Load the paper, envelopes or labels
between 177 and 220 g/m2 is loaded of weight between 177 and 220 g/m2
in tray 1 and tray 2.
on the MP tray, and use the face up
stacker.
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page 59

page 59
page 65

page 64,
page 65
page 64,
page 65
page 64,
page 65

page 64,
page 65

page 65
page 59,
page 65

3
3. Troubleshooting

The background of a
printed page is dark or
dirty.

Other Issues

Symptom

Point to check

Remedy

Paper does not feed The setting of [Source] in the
into the printer.
printer driver is not correctly
specified.
You have specified manual feeding
on the printer driver.

3
3. Troubleshooting

The printer does
not start processing
even though you
have removed the
jammed paper.
The paper gets
The paper is moist or has a static
folded or wrinkled. charge.
The paper is light.

The paper twists
around the rollers
in the fuser unit.

The settings of media weight and
type are incorrect.

The paper is light.
There is an image or text on the
leading edge of the paper.

Check the paper tray and select
the correct tray in [Source] in the
printer driver.
In the printer driver, clear the [Use
MP tray as manual feed] check
box on [Paper feed options].
Open and close the top cover.

Reference
-

Advanced

-

Use paper stored in proper
temperature and humidity
conditions.
Press the <ENTER> button
and then select [Menus] >
[Tray Configuration] > [(tray
name) Config] > [Media Weight].
Then, specify a lighter weight.
Press the <ENTER> button
and then select [Menus] >
[Tray Configuration] > [(tray
name) Config] > [Media Type]/
[Media Weight]. Then, specify the
appropriate values.
Or, specify a heavier weight in
[Media Weight].
Use heavier paper.
Add a margin on the leading edge of
the paper.
For duplex printing, leave a margin
in the leading and bottom edges.

page 59

Remedy

Reference

page 59

page 59

-

Machine Issues
Symptom

Point to check

You turned on the
The AC cord is unplugged.
printer, but nothing
displays on the
The power is out.
screen.
The printer does
not operate.

The AC cord is not firmly plugged in.
The printer is turned off.
The printer turned off automatically
by the auto power off function.
Printer does not answer.

Turn off the printer and then plug in
the AC cord firmly.
Check if the power is being supplied
to the electric outlet.
Plug in the AC cord firmly.
Turn on the printer.
Disable the auto power off function.
Hold down the power switch for more
than 5 seconds to turn off the printer
forcibly.
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page 21
page 80
-

Other Issues

Symptom
The printer does
not start printing.

Point to check

Remedy

An error is displayed on the panel.
The Ethernet or USB cable is
unplugged.
Something is wrong with the
Ethernet or USB cable.
The printer does not support your
Ethernet or USB cable.

Print data is not
transmitted to the
printer.
There is an
abnormal sound.

There is a buzzing
sound.
It takes a while to
start printing.

A print job has
stopped in the
middle of the
printing process.

Memory is
insufficient.

●● Use a USB 2.0 compatible cable.
●● Use an Ethernet 10BASE-T
/100BASE-TX compatible cable.
Something may be wrong with the
Press the <ENTER> button and
printing function.
select [Print Information] >
[Configuration] and then print the
contents of the settings to check the
printing function.
The interface is disabled.
Press the <ENTER> button and
select [Admin Setup] > [Network
Setup] and enable the interface you
are using.
The printer driver of the printer is
Set the printer driver of the printer
not selected.
as the default printer.
The specified port of the printer
Specify the port the Ethernet or USB
driver is wrong.
cable is connected to.
The printer is in the sleep mode.
Check if the <POWER SAVE>
button lights up and press the
<POWER SAVE> button to activate
the printer.
The Ethernet or USB cable is broken. Connect a new cable.
The time-out period set on the
Set a longer time-out period.
computer has passed.
The printer is tilted.
Place the printer on a flat surface.
There is a piece of paper or foreign
Check the inside of the printer and
object inside the printer.
remove any objects.
The top cover is open.
Close the top cover.
The printer is printing on the heavy
This is not a malfunction. You can
or thin paper when the temperature proceed with the operation.
inside is high.
The printer is warming up from the
Press the <ENTER> button
power save or sleep mode.
and select [Admin Setup] >
[Power Setup] > [Power Save]/
[Sleep] and disable both modes.
The printer may be cleaning the
Wait for a while.
image drum.
The printer is adjusting the
Wait for a while.
temperature of the fuser unit.
The printer is processing data from
Wait until the process finishes.
another interface.
As a result of processing print jobs
Wait for a while.
continuously for a long time, the
When the fuser unit becomes cooler,
inside the printer has become hot.
printing restarts automatically.
The printer is cooling off.
As a result of processing print jobs
Wait for a while.
continuously for a long time, the
When the printer becomes cooler,
temperature in the printer inside
printing restarts automatically.
has become too high. The printer is
cooling off.
When the print processing is
Retry to send data on a computer. If
overloaded by printing with the WSD the error is not resolved, use other
port, a computer may stop sending. network port.
A printer is short on memory
Reduce print data with a printer
because print data is too large.
driver.
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page 98
page 32,
page 52
-

page 30

-

page 22

-

page 22

-

-

-

Advanced

3
3. Troubleshooting

The display screen
is blank.

Check the error code and follow the
on-screen instructions.
Plug in the Ethernet or USB cable
firmly.
Use another Ethernet or USB cable.

Reference

Other Issues

Symptom

Point to check

Remedy

It takes a long time The processing speed of the
to finish printing.
computer may be slowing down the
print job.
You have selected [ProQ/High
Quality] on the [Job Options] tab
of the printer driver.

3
3. Troubleshooting

The printer driver
is not correctly
displayed on Mac
OS X.
Paper is curled.

Use a computer with faster
processing speed.

Select [Fine / Detail (600x1200)]
or [Normal (600x600)] on the
[Job Options] tab of the printer
driver.
The print data is complex.
Make the data simpler.
Paper is narrow (less than 230 mm). Change the mode.
The printer driver may not be
Uninstall the printer driver and install
operating correctly.
it again.

Thin paper is used.

Paper is wet on the Wet paper is used.
edge.
The LED indicator
The printer may be malfunctioning.
in the power switch
is blinking at high
speed per about
0.3 seconds.

Set an appropriate paper weight or
select [High Humid Mode].
Select [High Humid Mode].
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Unplug the AC cord immediately.

Reference
-

-

Advanced
Advanced

Advanced
Advanced
-

4. Maintenance
This chapter explains how to replace consumables and maintenance units, clean the printer, and move
or transport the printer.

●●
Replacing Consumables and Maintenance Units
This section explains how to replace consumable items.

WARNING
Do not throw the toner or
toner cartridge into the fire.
Doing so may cause toner
splashes leading to burns.

Do not vacuum spilled toner
powder. If vacuuming, it may
cause ignition due to the
sparks from electric contacts.
Toners spillage on the floor
should be wiped off by wet
clothes.

CAUTION
There are high temperature
parts in the device. Do
not touch the periphery
of the label "Caution High
Temperature", which may
cause burns.
If the toner powder sticks to
your skin like your hands,
wash with soap.

When handling a paper
jam, or replacing the toner
cartridge, make sure not to
get your cloth and hands
dirty. When toner powder
stains on your cloth, wash
with cold water. If you wash
with hot water, the toner
may be soaked into the
cloth; it may be difficult to
clean.

Keep the toner cartridge out
of reach of young children. If
young children swallow toner
powder, follow the doctor's
direction immediately.
If the toner gets into the
eyes, flush with plenty of
water immediately. Follow
the doctor's direction if
necessary.
Do not disassemble the toner
cartridge. Toner powder may
fly upward, and you may
inhale the toner powder
or may get your cloth and
hands dirty.

If toner powder is inhaled,
gargle with large amounts of
water and move the person
to the open area for fresh air.
Follow the doctor's direction
if necessary.
If you swallow toner powder,
take large amounts of water
to weaken the toner. Follow
the doctor's direction if
necessary.
Keep a used toner cartridge
in a bag so that the toner
powder can not fly upward.

Note

●● Use only genuine OKI consumable items to ensure optimum quality.
●● Service for problems due to use of consumable items other than genuine OKI consumables will incur fees even in the warranty
period or the maintenance contract period.
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4. Maintenance

Do not keep the toner
cartridge in places close to
the fire. It may catch the
fire, which cause fire and
burns.

Replacing Consumables and Maintenance Units
Note

Replacing Toner Cartridges

●● Have a new print cartridge ready, as the print quality
declines after more than one year following breaking the
seal.

Note

●● Toner powder may spill if you remove a toner cartridge
before the toner runs out.

●● If you replace the toner cartridge/image drum while it is
being used, the amount of toner used will not be counted
normally.

Life Span of Toner Cartridge

●● By opening and closing the top cover after the message
“Color toner has run out” is displayed, you are able
to print approximately 100 copies of A4 size ISO test
patterns (approximately 20 pages, five times). However
further printing operations will not be possible after that.
Please replace the toner cartridge as failure to do so may
damage the image drum.

When the “%COLOR% Toner Low” message
(“%COLOR%” indicates C (cyan), M (magenta),
Y (yellow) or K (black)) appears on the display
screen, prepare a replacement toner cartridge.
You can keep printing approximately 250 pages
until the next message appears.

4

When the “%COLOR% Toner Empty” appears
and printing is stopped, replace the toner
cartridge.

4. Maintenance

Memo

●● Even if the cyan (blue), magenta (red) or yellow toner
cartridges run out, you can print in black and white by
selecting [Monochrome] or [Grayscale]. However,
please replace the toner cartridge quickly after it runs
out, as not doing so may cause the image drum to be
damaged.

The life expectancy of toner cartridges is as
follows (for A4 simplex printing with default
density, according to ISO/IEC 19798).
The starter toner cartridge is the toner cartridge
that comes with the product at the time of
purchase.
●● When replacing a toner cartridge
Type
Starter toner
cartridge
Toner cartridge

Number of printable pages
C, M, Y, K

2500 pages

C, M, Y, K

10000 pages

Note

●● The actual life of the toner cartridge differs depending on
the usage.
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Procedure for Replacement
(for K (black) Toner Cartridge)

4

WARNING

Memo

●● When replacing the C, M, Y toner cartridges, refer to
“Procedure for Replacement
(for C (cyan), M (magenta),
Y (yellow) Toner Cartridges)” P.117.

1

Prepare a new [K] toner cartridge.

2

Insert your finger into the recess on
the right side of the printer and pull the
front cover open lever (1) to open the
front cover (2) forward.

Lift the toner cartridge (4) from the right
side, and remove it from the printer.
Possible to get
burned.

●● Do not throw a used toner cartridge in the
fire. They may explode, and the toner inside
may fly off and cause getting burned.
Note

●● When toner powder adheres to the paper feeding area
inside the printer, wipe it off with a wet cloth that has
been well wrung.

➌
4

4

➋

2

3

Turn the blue lever (3) of the toner
cartridge.

3

5

Leaving the replacement toner cartridge
in its bag, gently shake it up and down
and side to side, and then unpack it.

6

Remove the tape (5) from the toner
cartridge.

5
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➊

1

Replacing Consumables and Maintenance Units

7

Insert a new toner cartridge (6) by
aligning its left side indentation (7) with
the protrusion (8) on the image drum so
the toner cartridge and image drum [K]
color label align. Then fix the right side
firmly into place.

10 Please recycle toner cartridges.
Memo

●● If you must dispose of a toner cartridge, put it in a plastic
bag or similar container and dispose of it in accordance
with your municipality’s ordinances or guidelines.

Note

●● Do not insert a toner cartridge without removing the
tape.

6

➊

4

8

4. Maintenance

8

7

➋

Turn the blue lever (3) of the toner
cartridge in the direction of the arrow
fully while pressing the top of the toner
cartridge.

3

9

Close the front cover (2).
Note

●● The front cover cannot be closed if the top cover is
not closed securely.

2
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4

Procedure for Replacement
(for C (cyan), M (magenta),
Y (yellow) Toner Cartridges)

Identify an empty toner cartridge by its
label color (5).
5

Memo

●● When replacing the K toner cartridge, refer to “Procedure
for Replacement
(for K (black) Toner Cartridge)” P.115.

1

Prepare new toner cartridges.

2

Insert your finger into the recess on
the right side of the printer and pull the
front cover open lever (1) to open the
front cover (2) forward.

5

Slide the right blue lever (6) of the toner
cartridge while pressing the top of the
cartridge to unlock.

4. Maintenance

1

6

2

3

Press the top cover open button (3) and
open the top cover (4).

CAUTION

4

6

Possible to get
burned.

Lift the toner cartridge (7) from right
side, and remove it from the printer.

WARNING

●● The fuser unit is extremely hot. Do not touch
it.

Possible to get
burned.

●● Do not throw a used toner cartridge in the
fire. They may explode, and the toner inside
may fly off and cause getting burned.

3
4

➌

7

➋
➊
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7

Unpack the replacement toner cartridge,
and gently shake it up and down and
side to side.

8

Remove the tape (8) from the toner
cartridge.

4

10 Turn the blue lever (6) of the toner

cartridge in the direction of the arrow
fully while pressing the top of the toner
cartridge.

6

11 Close the top cover (4) by pushing the
4. Maintenance

both sides of the cover firmly.
4

8

9

Insert a new toner cartridge (9) by
aligning its left side indentation (10)
with the protrusion (11) on the image
drum so the toner cartridge and image
drum color labels align. Then fix the
right side firmly into place.
Note

●● Do not insert a toner cartridge without removing the
tape.

12 Close the front cover (2).

9

➊
11

10

➋

2
Note

●● The front cover cannot be closed if the top cover is
not closed securely.

13 Please recycle toner cartridges.
Memo

●● If you must dispose of a toner cartridge, put it in a plastic
bag or similar container and dispose of it in accordance
with your municipality’s ordinances or guidelines.
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●● There is one toner cartridge for each color on the image
drum.

Replacing the Image Drum
Life Span of Image Drum
When the “%COLOR% Image Drum Near
Life” message appears on the display screen,
prepare a replacement image drum.
If you continue printing, the message
“%COLOR% Image Drum Life” will be
displayed and printing will stop.

1

Prepare a new image drum.

2

Insert your finger into the recess on
the right side of the printer and pull the
front cover open lever (1) to open the
front cover (2) forward.

A guideline for replacing the image drum is
every 30,000 pages or so for A4 sized paper
(with single-sided printing). However, this
number of pages is for common printing
conditions (3 pages at a time). Printing one page
at a time reduces the drum life by about half.

1

2

If you continue to print more than the above,
the printer will force the printing to stop.

3

Note

●● The actual number of pages you can print with the image
drum depends on how you use it. The above guideline
may be reduced by more than half, depending on the
conditions of printing.
●● Though opening and closing the top cover may extend
the life of a image drum for a while, it is recommended to
replace it soon after the “Install New image drum” is
displayed.

Press the top cover open button (3) and
open the top cover (4).

CAUTION

Possible to get
burned.

●● The fuser unit is extremely hot. Do not touch
it.
3
4

●● The print quality may deteriorate after the toner cartridge
has been unpacked for a year. Replace it with a new one.
●● When the <ENTER> button > [Admin Setup] >
[System Setup] > [Near Life Status] is set to
[Disable], the “%COLOR% Image Drum Near Life”
message does not appear.

Procedure for Replacement
Note

●● If you use a new image drum with the toner cartridges
currently in use, the remaining amount indication of the
toner cartridges will not display correctly.
The messages “%COLOR% Image Drum Near Life” or
“%COLOR% Image Drum Life” may also be displayed
soon after replacement.

4

●● The image drum (the green tube) is very delicate. Handle
it carefully.
●● Do not expose the image drum to direct sunlight or very
bright interior light (approximately more than 1500 lux).
Even under the normal interior light, do not leave it for
more than 5 minutes.
●● In order for the printer to exhibit its full performance,
please use genuine OKI consumables.
●● Service for problems due to use of consumable items
other than genuine OKI consumables will incur fees
even in the warranty period or the maintenance contract
period. (Use of consumable items other than genuine OKI
consumables does not always cause problems, but please
exhibit caution when using those.)
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Identify an empty toner cartridge by its
label color (5).
5

4. Maintenance

The actual number of printed pages may be
halved again relative to the above guideline,
depending on the printing conditions.

4

Replacing Consumables and Maintenance Units

5

8

Remove the image drum (6) from the
printer in the direction of the arrow and
place the image drum on a flat surface.

Remove the protective sheets.
Place a new image drum (9) on a flat
surface.

6
9

9

4

Remove the toner cover (10).

10

4. Maintenance

6

Turn the right blue lever (7) of the toner
cartridge forward while pressing the top
of the toner cartridge to unlock.

7

10 Insert the toner cartridge (8) taken
7

Lift the toner cartridge (8) from the
right side, and remove it from the image
drum.

WARNING

out in step 7 to the image drum (9) by
aligning its left side indentation (11)
with the protrusion (12) on the image
drum, and then fix the right side firmly
into place.

➊

Possible to get
burned.

8

●● Do not throw a used image drum and toner
cartridge in the fire. They may explode, and
the toner inside may fly off and cause getting
burned.

12
11
9

➋
8

➊
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➋
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11 Turn the blue lever (7) of the toner

14 Close the front cover (2).

cartridge in the direction of the arrow
fully while pressing the top of the toner
cartridge.

Note

●● The front cover cannot be closed if the top cover is
not closed securely.

7

12 Check a label color of a new image drum

2

(9) and place the drum into a printer.

Memo

9

●● If you must dispose of an image drum, put it in a plastic
bag or similar container and dispose of it in accordance
with your municipality’s ordinances or guidelines.
●● If the light-shielding film of the image drum becomes
dirty, wipe the film by following the procedures below.

(1) Open the front cover.
(2) Open the top cover.
(3) Remove the image drum.
(4) Wipe the light-shielding film with soft
tissue paper.

13 Close the top cover (4) by pushing the
both sides of the cover firmly.
4

(5) Put the image drum back to the
printer.

(6) Close the top cover by pushing the
both sides of the cover firmly.

(7) Close the front cover.
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15 Please recycle image drums.

4

Replacing Consumables and Maintenance Units

3

Replacing the Belt Unit
Life Span of Belt Unit

Insert your finger into the recess on
the right side of the printer and pull the
front cover open lever (1) to open the
front cover (2) forward.

When the “Belt Unit Near Life” message
appears on the display screen, prepare a
replacement belt unit. You can keep printing
approximately 1000 pages until the next
message appears.
When the “Change Belt Unit” message
appears, replace the belt unit.

4

1

The life expectancy of the belt unit is
approximately 80,000 pages for A4 simplex
printing (three pages per job).

2

Note

4. Maintenance

4

●● The actual number of pages you can print with the belt
unit depends on how you use it.

Press the top cover open button (3) and
open the top cover (4).

Note

●● Though opening and closing the top cover may extend
the life of the belt unit somewhat, you should replace it
soon after the “Change Belt Unit” is displayed to prevent
malfunction.
●● If you replace the belt unit, use it until the end of its
useable life. If you remove the belt unit and install and
use another one before its usable life has expired, the use
life will not be correctly displayed.

CAUTION

Possible to get
burned.

●● The fuser unit is extremely hot. Do not touch
it.
3
4

●● When the <ENTER> button > [Admin Setup] >
[System Setup] > [Near Life Status] is set to
[Disable], the [Belt Unit Near Life] message does not
appear.

Procedure for Replacement
Note

●● The image drum (the green tube) is very delicate. Handle
it carefully.
●● Do not expose the image drum to direct sunlight or very
bright interior light (approximately more than 1500 lux).
Even under the normal interior light, do not leave it for
more than 5 minutes.

1

Prepare a replacement belt unit.

2

Turn off your printer by pressing the
power switch.

5

Reference

●● “Turning Off the Power” P.22
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Take all the four image drums out of a
printer, and then place them on a flat
surface.

Replacing Consumables and Maintenance Units

6

9

Cover the image drums you took out
with paper so that the image drums do
not expose to the light.

Hold the handle of a new belt unit with
one hand and support lower part with
other hand. Place the belt unit into the
printer.

➋
➊

➌
7

4
4. Maintenance

Turn the blue locks (5) on each side of
the belt unit in direction of the arrow to
unlock.
5

5

➍

10 Turn the blue locks (5) on each side of
the belt unit in direction of the arrow.

8

Remove the belt unit by holding the blue
lever (6).

5

5

6
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11 Return all the four image drums to the

Replacing the Fuser Unit

printer.

Life Span of Fuser Unit
When the “Fuser Unit Near Life” message
appears on the display screen, prepare a
replacement fuser unit. You can keep printing
approximately 1250 pages until the next
message appears.
When the “Change Fuser Unit” message
appears, replace the fuser unit.
The life expectancy of the fuser unit is up to
100,000 pages for A4 simplex printing.

4

Note

●● The actual number of pages you can print with the fuser
unit depends on how you use it.

4. Maintenance

12 Close the top cover (4) by pushing the

Note

both sides of the cover firmly.

●● Though opening and closing the top cover may extend
the life of the fuser unit somewhat, you should replace it
soon after “Change Fuser Unit” is displayed to prevent
malfunction.

4

●● If you replace the fuser unit, use it until the end of its
useable life. If you remove the fuser unit and install and
use another one before its usable life has expired, the use
life will not be correctly displayed.
●● When the <ENTER> button > [Admin Setup] >
[System Setup] > [Near Life Status] is set to
[Disable], the [Fuser Unit Near Life] message does not
appear.

Replacement Procedure
13 Close the front cover (2).

Note

●● Do not expose the image drum to direct sunlight or very
bright interior light (approximately more than 1500 lux).
Even under the normal interior light, do not leave it for
more than 5 minutes.

Note

●● The front cover cannot be closed if the top cover is
not closed securely.

1

Prepare a new fuser unit.

2

Turn off your printer by pressing the
power switch.

2

14 Please recycle belt unit.
Memo

Reference

●● If you must dispose of a belt unit, put it in a plastic bag or
similar container and dispose of it in accordance with your
municipality’s ordinances or guidelines.
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Replacing Consumables and Maintenance Units

3

6

Insert your finger into the recess on
the right side of the printer and pull the
front cover open lever (1) to open the
front cover (2) forward.

Hold the fuser unit handle (6) and lift
the fuser unit out of the printer.

6

1

4

2

Press the top cover open button (3) and
open the top cover (4).

CAUTION

Possible to get
burned.

7

Hold the fuser unit handle (6) and place
the fuser unit into the printer.
6

●● Since the fuser unit gets hot, carry out the
operation carefully, and when lifting it up you
must hold it by the handle. Do not try to hold
it whilst it is hot. Wait until it has cooled
down and then carry out the operation.
3
4

8

5

Pull forward the left locking lever (5) of
the fuser unit to unlock.

Push back the left locking lever (5) of
the fuser unit to lock.

5

5
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4

Replacing Consumables and Maintenance Units

9

Close the top cover (4) by pushing the
both sides of the cover firmly.
4

4

10 Close the front cover (2).
Note

4. Maintenance

●● The front cover cannot be closed if the top cover is
not closed securely.

2

11 Please recycle fuser unit.
Memo

●● If you must dispose of a fuser unit, put it in a plastic bag
or similar container and dispose of it in accordance with
your municipality’s ordinances or guidelines.
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Cleaning

●●
Cleaning
This section explains how to clean each part of your printer.

Cleaning the Surface of the
Printer

2

Wipe the two paper feed rollers (2)
inside the printer with a wet cloth that
has been wrung out well.

Note

●● Do not use benzine, thinners, or alcohol as a cleaning
agent. They may damage the plastic parts of the printer.
●● Do not lubricate your printer with oil.

1

Turn off your printer by pressing the
power switch.
Reference

●● “Turning Off the Power” P.22

3

Wipe the surface of the printer with a
soft cloth lightly moistened with water or
neutral detergent.

3

Remove paper loaded in the tray.

4

Wipe the paper feed roller (3) on the
tray with a wet cloth that has been
wrung out well.

Dry the surface of the printer with a dry
soft cloth.

Cleaning Paper Feed Rollers
Clean the paper feed rollers if paper jams occur
frequently.

3

Note

●● You should replace the paper feed rollers if paper jams
keep occurring even after cleaning the paper feed rollers.

For Tray 1/2/3/4
Memo

5

Load paper in the tray.

6

Push the tray back into the printer.

●● This procedure images use tray 1 as an example, but the
same procedure applies to tray 2/3/4.

For MP Tray

1

1

Pull out the tray (1).

Open the MP tray (1) forward by
inserting your fingers into the front
recesses (2).
2

1

1
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2
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2

4

2

Cleaning

2

Release the tab (3) of the paper feed
roller cover by pressing the right arm (4)
inward while lifting up the MP tray (1)
lightly.

5

Wipe the two paper feed rollers (6) with
a wet cloth that has been wrung out
well.
6

4

1

4

3

3

4. Maintenance

Also press the left arm (4) inward while
lifting up the MP tray (1) lightly to
release the tab (3) of the paper feed
roller cover.

6

Open the separation roller cover (7)
forward while pressing the center part of
the MP tray.
Wipe the two separation roller (8) with a
wet cloth that has been wrung out well.

4
8

3
7

1

4

7

Close the separation roller cover (7).

Open the paper set cover (5) until
touching the printer.

5

7

8

Lower the paper set cover (5).
5
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9

Hook one tab (3) of the paper feed roller
cover by pressing the right arm (4)
inward while lifting up the MP tray (1)
lightly.
Note

●● If closing the MP tray without returning the tab to the
correct position, the paper set cover may be broken.
Be sure to return the tab to the original position.

Cleaning LED Heads
Clean the LED heads if vertical lines appear,
images are fading vertically, or the periphery of
letters is smudged in the printouts. Dirt on the
LED heads may also cause paper jams.
Note

●● Do not use methyl alcohol or thinners as a cleaning agent.
They may damage the LED heads.

4

●● Do not expose the image drum to direct sunlight or very
bright interior light (approximately more than 1500 lux).
Even under the normal interior light, do not leave it for
more than 5 minutes.

1
1

Turn off your printer by pressing the
power switch.

4

Reference

3

10 Also hook the other tab (3) of the paper

feed roller cover by pressing the left arm
(4) inward while lifting up the MP tray
(1) lightly.

2

Insert your finger into the recess on
the right side of the printer and pull the
front cover open lever (1) to open the
front cover (2) forward.

Note

●● If closing the MP tray without returning the tab to the
correct position, the paper set cover may be broken.
Be sure to return the tab to the original position.
4

1

3
2

3

Press the top cover open button (3) and
open the top cover (4).

CAUTION

1

Possible to get
burned.

●● The fuser unit is extremely hot. Do not touch
it.

11 Close the MP tray (1).
If the MP tray cannot be closed, return the paper
set cover to the correct position by pressing the
paper loading part on the MP tray downward.

1
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●● “Turning Off the Power” P.22

Cleaning

4

Lightly wipe the lenses (5) of the LED
heads with soft tissue paper.

5

4
5
4. Maintenance

Close the top cover (4) by pushing the
both sides of the cover firmly.
4

6

Close the front cover (2).
Note

●● The front cover cannot be closed if the top cover is
not closed securely.

2
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●●
Moving or Transporting Your Printer
This section explains how to move or transport your printer.

Moving Your Printer

2

Unplug all the cables.
●● AC cord and ground wire.

CAUTION

It may cause
injury.

●● Ethernet or USB cable.

●● At least two people are needed to lift the printer
safely because it weighs about 37 Kg or 40 Kg.

1

3

Remove any paper from the paper trays.

4

Insert your finger into the recess on
the right side of the printer and pull the
front cover open lever (1) to open the
front cover (2) forward.

Turn off your printer by pressing the
power switch.
Reference

4

●● “Turning Off the Power” P.22

Unplug all the cables.
●● AC cord and ground wire
●● Ethernet or USB cable

3

Remove any paper from the paper trays.

4

Lift your printer and move it to a new
location.

2

Transporting Your Printer
CAUTION

5

It may cause
injury.

Possible to get
burned.

●● The fuser unit is extremely hot. Do not touch
it.

Possible to get
burned.

3

●● The fuser unit is extremely hot. Do not touch
it.
Note

●● The image drum (the green tube) is very delicate. Handle
it carefully.
●● Do not expose the image drum to direct sunlight or very
bright interior light (approximately more than 1500 lux).
Even under the normal interior light, do not leave it for
more than 5 minutes.

1

Press the top cover open button (3) and
open the top cover (4).

CAUTION

●● At least two people are needed to lift the printer
safely because it weighs about 37 Kg or 40 Kg.

CAUTION

1

Turn off your printer by pressing the
power switch.
Reference

●● “Turning Off the Power” P.22
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4
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2

Moving or Transporting Your Printer

6

Hold the toner cartridges with both
hands and remove them with the image
drums. Remove all the toner cartridges
and image drums, and place them on a
flat surface.

4

9

Close the top cover (4) by pushing the
both sides of the cover firmly.
4

10 Close the front cover (2).
Note

4. Maintenance

●● The front cover cannot be closed if the top cover is
not closed securely.

7

Secure each toner cartridge to each
image drum with vinyl tape (5).

5
2

8

Return all the toner cartridges and
image drums to the printer.

11 Remove the optional additional tray unit
from the main unit if it is installed.
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Moving or Transporting Your Printer

12 Protect your printer with packing
materials.

13 Lift your printer and put it in a box.
Note

●● Use the packing materials attached to your printer when
purchased.
●● After transporting or when setting up again, remove
the vinyl tape used to secure the image drum and toner
cartridges.

4
4. Maintenance
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5. Appendix
This chapter explains the specifications of your printer.

●●
Menu List of the Operator Panel
Checking the Printer’s Status with the Display Screen
From the <ENTER> button on the operator panel, you can check the status of your printer.

5
5. Appendix

Checking the Device Status
You can check the residual life of the consumables, counter information, network settings and system
information on the display screen.

1

Press the <ENTER> button on the
operator panel to open the status menu.

2

Press the scroll button to select the
item you want to check and then press
the <ENTER> button.
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Menu List of the Operator Panel
The function number is described on the right of each item.
Functions
Configuration

MPTray
Tray1
Tray2
Tray3
Tray4

Supplies Life

Cyan Drum
Magenta Drum
Yellow Drum
Black Drum
Cyan Toner
Magenta Toner
Yellow Toner
Black Toner
Belt
Fuser

Network

Printer Name
Short Printer Name
IPv4 Address
Subnet Mask
Gateway Address
MAC Address
Network FW Version
Web Remote Version
IPv6 Address (Local)
IPv6 Address (Global)

System

Serial Number
Asset Number
Lot Number
CU Version
PU Version
Total Memory
Flash Memory
SD Card

Configuration
Network
Demo Page
File List
PS Font List
PCL Font List
IBM PPR Font List
EPSON FX Font List
Usage Report
Error Log
Color Profile List

Print Secure Job

Encrypted Job
Stored Job

Fn100
Fn101

DEMO1
...

Fn102

Copies

Fn103

Fn1
Fn2

To NEXT PAGE
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Print Information

Tray Count

Menu List of the Operator Panel

Memo

(
Menus

Tray Configuration

MPTray Config

Tray1 Config

Tray2 Config (When tray2 is installed)

5
Tray3 Config (When tray3 is installed)

5. Appendix
Tray4 Config (When tray4 is installed)

) indicates the factory default setting.

Paper Size (A4
or Letter )
X Dimension (210mm or 8.5inch)
Y Dimension (297mm or 11inch)
Media Type (Plain)
Media Weight (Light)
Tray Usage (Do Not Use)

Fn90

Paper Size (Cassette Size)
X Dimension (210mm or 8.5inch)
Y Dimension (297mm or 11inch)
Media Type (Plain)
Media Weight (Light)
Legal Paper (Legal14)
Other Size (16K(184x260mm) )

Fn10

Paper Size (Cassette Size)
X Dimension (210mm or 8.5inch)
Y Dimension (297mm or 11inch)
Media Type (Plain)
Media Weight (Light)
Legal Paper (Legal14)
Other Size (16K(184x260mm) )

Fn20

Paper Size (Cassette Size)
X Dimension (210mm or 8.5inch)
Y Dimension (297mm or 11inch)
Media Type (Plain)
Media Weight (Light)
Legal Paper (Legal14)
Other Size (16K(184x260mm) )

Fn30

Paper Size (Cassette Size)
X Dimension (210mm or 8.5inch)
Y Dimension (297mm or 11inch)
Media Type (Plain)
Media Weight (Light)
Legal Paper (Legal14)
Other Size (16K(184x260mm) )

Fn40

X Adjust (0.00millimeter)
Y Adjust (0.00millimeter)
Duplex X Adjust (0.00millimeter)
Duplex Y Adjust (0.00millimeter)

Fn220

Fn91
Fn92
Fn93
Fn94
Fn95

Fn11
Fn12
Fn13
Fn14
Fn15
Fn16

Fn21
Fn22
Fn23
Fn24
Fn25
Fn26

Fn31
Fn32
Fn33
Fn34
Fn35
Fn36

Fn41
Fn42
Fn43
Fn44
Fn45
Fn46

Paper Feed (Tray1)
Fn80
Auto Tray Switch (On)
Tray Sequence (Down)
Unit of Measurement (millimeter)
Duplex Last Page (Skip Blank Page)
System Adjust

To NEXT PAGE

Power Save Time (1minute)
Sleep Time (15minutes)
Auto Power Off Time (4hours)
Clearable Warning (ONLINE)
Auto Continue (Off)
Manual Timeout (60seconds)
Wait Timeout (40seconds)
Low Toner (Continue)
Jam Recovery (On)
Error Report (Off)
Print Position Adjust

Paper Black Setting (0)
Paper Color Setting (0)
Trans. Black Setting (0)
Trans. Color Setting (0)
SMR Setting (0)
BG Setting (0)
Drum Cleaning (Off)
Hex Dump
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Fn200
Fn201
Fn202

Fn210

Fn230
Fn231
Fn232
Fn233
Fn234
Fn235
Fn236
Fn237

Fn221
Fn222
Fn223

Menu List of the Operator Panel

Admin Setup

TCP/IP (Enable)
IP Version (IPv4)
NetBEUI (Disable)
NetBIOS over TCP (Enable)
NetWare (Disable)
EtherTalk (Disable)
Frame Type (Auto)
IP Address Set (Auto)
IPv4 Address
Subnet Mask
Gateway Address
Web (Enable)
Telnet (Disable)
FTP (Disable)
IPSec (Disable)
SNMP (Enable)
Network Scale (Normal)
Hub Link Setting (Auto Negotiate)
TCP ACK (Tray1)
Factory Defaults?

Print Setup

Personality (Auto)
Copies (1)
Duplex (On)
Binding (Long Edge)
Media Check (Enable)
Resolution (600dpi)
Toner Save
Mono-Print Mode (Auto)
Default Orientation (Portrait)
Form Length (64lines)
Edit Size (Cassette Size)
X Dimension (210mm or 8.5inch)
Y Dimension (297mm or 11inch)

: You must input a password.

PS Setup

Network Protocol (RAW)
Parallel Protocol (ASCII)
USB Protocol (RAW)

PCL Setup

Font Source (Resident)
Font Number (I0)
Font Pitch (10.00CPI)
Font Height (12.00 point)
Symbol Set (PC-8)
A4 Print Width (78 column)
White Page Skip (Off)
CR Function (CR)
LF Function (LR)
Print Margin (Normal)
True Black (Off)
Pen Width Adjust (On)
Tray ID#

XPS Setup

To NEXT PAGE

DigitalSignature (Off)
DiscardControl (Auto)
MC Mode (On)
Unzip Mode (Speed)
White Page Skip (Off)

- 137 -

5
Toner Save Level (Off)
Color (All)

Tray2 (5)
Tray3 (20)
Tray4 (21)
MPTray (4)

5. Appendix

Network Setup

Menu List of the Operator Panel

5
5. Appendix
To NEXT PAGE

IBM PPR Setup

Character Pitch (10 CPI)
Font Condense (12CPI to 20CPI)
Character Set (SET-2)
Symbol Set (IBM-437)
Letter O Style (Disable)
Zero Character (Normal)
Line Pitch (6 LPI)
White Page Skip (Off)
CR Function (CR)
LF Function (LR)
Line Length (80 column)
Form Length (11.7 inch)
TOF Position (0.0 inch)
Left Margin (0.0 inch)
Fit To Letter (Disable)
Text Height (Same)
Continuous Paper Mode (Off)

EPSON FX Setup

Character Pitch (10 CPI)
Character Set (SET-2)
Symbol Set (IBM-437)
Letter O Style (Disable)
Zero Character (Normal)
Line Pitch (6 LPI)
White Page Skip (Off)
CR Function (CR)
Line Length (80 column)
Form Length (11.7 inch)
TOF Position (0.0 inch)
Left Margin (0.0 inch)
Fit To Letter (Disable)
Text Height (Same)
Continuous Paper Mode (Off)
LQ Mode (Off)
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Ink Simulation (Off)
UCR (Low)
CMY 100% Density (Disable)
CMYK Conversion (On)

Memory Setup

Receive Buffer Size (Auto)
Resource Save (Off)

Flash Memory Setup

Initialize

SD Card Setup (When SD Memory Card is installed)

Initialize
Resize Partition
Format Partition (PCL)

System Setup

Near Life Status (Enable)
Near Life LED (Enable)
Idle Display (Toner Gauge)
Panel Contrast (0)

Buzzer Setup

Invalid Operation Volume (Off)
Error Volume (Off)

Power Setup

Power Save (Enable)
Sleep (Enable)
Auto Power Off (Auto Config)

Change Password

New Password

Settings

Reset Settings
Save Settings
Restore Settings

Auto Density Mode (On)
Adjust Density
Adjust Registration
Print Tuning Pattern
Cyan Tuning

Fn301
Fn302

Highlight (0)
Mid-Tone (0)
Dark (0)

Magenta Tuning

Highlight (0)
Mid-Tone (0)
Dark (0)

Yellow Tuning

Highlight (0)
Mid-Tone (0)
Dark (0)

Black Tuning

Highlight (0)
Mid-Tone (0)
Dark (0)

Cyan Darkness (0)
Magenta Darkness (0)
Yellow Darkness (0)
Black Darkness (0)
Java Application

Fn300

Fn310
Fn311
Fn312
Fn313

…
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PCL (20)
Common (50)
PS (30)

5
Verify Password

5. Appendix

Calibration

Color Setup

Menu List of the Operator Panel
Boot Menu

USB Setup

USB (Enable)
Speed (480Mbps)
Soft Reset (Disable)
Offline Receive (Disable)
Serial Number (Enable)

Security Setup (When SD Memory Card is installed)

Job Limitation (Off)
Make Secure SD Card
Make Normal SD Card
Reset Cipher Key

Storage Setup

Check File System (When SD Memory Card is installed)
Check All Sectors (When SD Memory Card is installed)
Enable SD Card (Yes) (When SD Memory Card is installed)
Erase SD Card (When SD Memory Card is installed)
Enable Initialization (No)

Language Setup

Language Initialize

System Setup

High Humid Mode (Off)
Moisture Control (Off)
Narrow Paper Speed (Slow)
Slow Print Mode (Off)
Warmup Control (Off)
Menu Lockout (Off)

To display the [Boot Menu],
turn on the power while
pressing the <ENTER>
button.
: You must input a
password.

5
Print Statistics

5. Appendix

: You must input a
password.

Usage Report (Enable)
Supplies Report (Disable)
Reset Main Counter
Reset Supplies Counter
Change Password

New Password
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Basic Steps in Windows

●●
Basic Steps in Windows
These are the steps for displaying the printer driver setting window from [Printer] / [Printers and
Faxes] folder in Windows OS used for examples in this manual other than Windows 7.
Memo

●● The steps for Windows Server 2008 R2 are the same as for Windows 7.
●● If you have multiple printer drivers installed, the icons for each driver are displayed in the [Printer] / [Printers and Faxes]
folder. Please follow the below steps using the drivers you want to set/check. Please follow the below steps using the printer
drivers you want to set/check.

Displays the Property Screen
 For Windows Vista/Windows Server 2008
1

Click [Start], and select [Control Panel] > [Printer].

2

Right-click on the OKI C831 icon, and select [Properties].

 For Windows XP/Windows Server 2003
Click [Start], and select [Printers and Faxes].

2

Right-click on the OKI C831 icon, and select [Properties].

 For Windows 2000
1

Click [Start], and select [Settings] > [Printer].

2

Right-click on the OKI C831 icon, and select [Properties].

Displays the Printer Setting Screen
 For Windows Vista/Windows Server 2008
1

Click [Start], and select [Control Panel] > [Printer].

2

Right-click on the OKI C831 icon, and select [Printing preferences].

 For Windows XP/Windows Server 2003
1

Click [Start], and select [Printers and Faxes].

2

Right-click on the OKI C831 icon, and select [Printing preferences].

 For Windows 2000
1

Click [Start], and select [Settings] > [Printer].

2

Right-click on the OKI C831 icon, and select [Printing preferences].
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5

Specifications

●●
Specifications
Model
C831/ES8431
C841/ES8441

Model Number
N35100A, N35100B
N35101A, N35101B

 General Specifications
C831/ES8431
CPU
Memory

Resident
Option

Flash RAM

Storage Device

5

Weight

5. Appendix

Dimensions
Power supply

Power
consumption

Typical
operation
Idle
Peak
Sleep mode
Power save
mode
Off mode

Interface
Display
Supported OS

C841/ES8441

PowerPC464FP, 800 MHz
256 MB
256 MB/512 MB
NAND : 64 MB
NOR : 2 MB
Serial NOR : 512 KB
SD memory card kit
●● Optional
16 GB
37 Kg (including consumables without a duplex unit),
40 Kg (including consumables with a duplex unit)
449(W) x 552(D) x 360(H) mm
N35100A, N35101A :
110 - 127 VAC (Range 99 - 140 VAC), 50/60 Hz ± 2%
N35100B, N35101B :
220 - 240 VAC (Range 198 - 264 VAC), 50/60 Hz ± 2%
700 W
100 W
1400 W
N35100A, N35101A : Less than 0.7 W
N35100B, N35101B : Less than 1.0W
Less than 12 W
N35100A, N35101A : Less than 0.1 W
N35100B, N35101B : Less than 0.15 W
USB 2.0 (Hi-Speed), Ethernet 10BASE-T/100BASE-TX
Graphics panel 60(W) x 32.6(H) mm, 128 x 64 dots
●● Windows 7, Windows Vista, Windows Server 2008 R2, Windows Server 2008,
Windows XP, Windows Server 2003, Windows 2000
●● Mac OS X 10.3.9-10.7
Please refer to product requirements for details.
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 Printing Specifications
C831/ES8431
Printing method
Emulation language
Resident fonts
Resolution
Color
Print speed (A4)
Paper size

Tray 1

Tray 2/3/4
(Option)
MP Tray

Custom size

Media type
Feeding method
Paper loading capacity

300 sheets of Standard paper /80 g/m2, total thickness 30 mm or lower.
●● MP tray
100 sheets of Standard paper /80 g/m2 and total thickness 10 mm or lower, 10
envelopes/ weight of 85 g/m2.
●● Additional tray unit (optional)
Output method
Paper output capacity

530 sheets of Standard paper /80 g/m2, total thickness 53 mm or lower.
Face up/Face down
●● Face up
100 sheets (less than 80 g/m2), 10 sheets (ultra-heavy/envelopes)
●● Face down

Print guaranteed area
Print precision
Warm-up time

250 sheets (less than 80 g/m2)
6.35 mm or more from the paper edge (not applicable to special media such as
envelopes)
Print beginning:± 2 mm, paper skew:± 1 mm/100 mm,
image expansion:± 1 mm/100 mm (80 g/m2)
●● From power on
32 seconds (at room temperature 25°C, rated voltage)
●● From power save mode
27 seconds (at room temperature 25°C, rated voltage)
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Duplex
Printing

C841/ES8441

Dry electrophotographic recording method with LED (Light-emitting diode)
PCL6 (XL3.0 and PCL5c), PostScript 3
PCL: 91 european fonts
PS: 80 european fonts
600 x 600 dpi, 600 x 1200 dpi,
1200 x 1200 dpi, 600 x 600 dpi
600 x 600 dpi 2bit
Yellow, Magenta, Cyan, Black
Simplex: 35 ppm
Duplex: 27 ppm
Legal 13/13.5/14, letter, executive, tabloid, A3, A4, A5, B5, B4, A6, 8K (260 x
368 mm, 270 x 390 mm, 273 x 394 mm), 16K (197 x 273 mm, 195 x 270 mm,
184 x 260 mm)
Legal 13/13.5/14, letter, executive, tabloid, A3, A4, A5, B4, B5, 8K (260 x 368
mm, 270 x 390 mm, 273 x 394 mm), 16K (197 x 273 mm, 195 x 270 mm, 184 x
260 mm)
Legal 13/13.5/14, letter, executive, tabloid, statement, A3, A4, A5, B4, B5, A6,
C4, C5, DL, Com-10, index card (3 x 5 inch), custom size, banner up to 52 inch,
8K (260 x 368 mm, 270 x 390 mm, 273 x 394 mm), 16K (197 x 273 mm, 195 x
270 mm, 184 x 260 mm)
Legal 13/13.5/14, letter, executive, tabloid, A3, A4, A5, B4, B5, 8K (260 x 368
mm, 270 x 390 mm, 273 x 394 mm), 16K (197 x 273 mm, 195 x 270 mm, 184 x
260 mm), custom size (148 - 297 mm (W) x 182 - 431.8 mm (L))
●● Tray 1
105 - 297 mm (W),
148, 182 - 431.8 mm (L)
(4.1 - 11.7 inches (W), 5.8, 7.2 - 17.0 inches (L))
●● Tray 2/3/4 (option)
148 - 297 mm (W),
182 - 431.8 mm (L)
(5.8 - 11.7 inches (W), 7.2 - 17.0 inches (L))
●● MP tray
64 x 90 - 297 x 1321 mm (2.5 x 3.5 - 11.7 x 52 inches)
Plain paper (64 g/m2 - 256 g/m2), envelopes, label.
Automatic feeding from the tray 1, MP tray and additional tray unit (optional),
Manual feeding from MP tray
●● Tray 1

Specifications

C831/ES8431
Operating environment

Conditions for the guarantee
of print quality

Consumables, Maintenance
Unit

C841/ES8441

●● When in operation
10 - 32°C / Relative Humidity of 20 - 80% (maximum wet bulb temperature of
25°C, maximum dry bulb temperature of 2°C)
●● When not in operation
0 - 43°C / Relative Humidity of 10 - 90% (maximum wet bulb temperature of
26.8°C, maximum dry bulb temperature of 2°C)
●● Operating Range
Temperature 10°C, humidity 20 to 80% RH
Temperature 32°C, humidity 20 to 60% RH
Humidity 20% RH, temperature 10 to 32°C
Humidity 80% RH, temperature 10 to 27°C
●● Full-color Print Quality Assured Range
Temperature 17 to 27°C, humidity 50 to 70% RH
Toner cartridges, image drum, belt unit, fuser unit, feed roller set

 Network Specifications

5

C831/ES8431
Interface
Protocol

5. Appendix

Supported browsers

C841/ES8441

Ethernet 10BASE-T/100BASE-TX
TCP/IPv4, TCP/IPv6, SMTP, POP3, HTTP, SNMPv1/v3, DHCP, DNS, LPR, Port9100,
BOOTP, ARP, FTP, SLP, Bonjour (Rendezvous), Web Services Discovery (WSD),
NetWare, EtherTalk, NetBEUI
Microsoft IE 6.0 or later, Safari 3 or later, Firefox 3.0 or later
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 Printer Dimensions
TOP VIEW

449 mm

SIDE VIEW
1107 mm
255 mm

552 mm

300 mm

400 mm

760 mm

5
420 mm

5. Appendix

360 mm

OPTION-INSTALLED VIEW (TRAY2/3/4)

498 mm
774 mm

138 mm
138 mm
138 mm
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ATTENTION indicator............. 98

Other Error Messages............ 98
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Belt Unit............................ 122
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Paper Size................ 59, 62, 69
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D
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Placement Space.................. 16
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POWER SAVE button............. 22

E

Power Supply Conditions....... 21
Printer Driver....... 32, 37, 52, 54

Envelope............................. 60

Product Requirements........... 31

F

S

Facedown Stacker................. 73

Sleep Mode.......................... 78

Faceup Stacker.................... 73

T

Feed Rollers....................... 127
Fuser Unit......................... 124

Toner Cartridges................. 114

I

W

Image Drum...................... 119

Windows............................. 31

Install
Printer Driver
(Mac OS X).........37, 54
Printer Driver
(Windows)..........32, 52
IP Address........................... 32

L
Label.................................. 60

M
Mac OS X............................ 31
MP Tray............................... 65
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Contact Us
Italia 				www.oki.com/it
Français 			www.oki.com/fr
Deutschland 			www.oki.com/de
United Kingdom 		

www.oki.com/uk

Ireland 			www.oki.com/ie
España 			www.oki.com/es
Portuguesa 			www.oki.com/pt
Sverige 			www.oki.com/se
Danmark 			www.oki.com/dk
Norge 				www.oki.com/no
Suomi

www.oki.com/fi

Nederland 			www.oki.com/nl
België/Belgique 		www.oki.com/be
Österreich 			www.oki.com/at
Schweiz/Suisse/Svizzera

www.oki.com/ch

Polska 				www.oki.com/pl
Česká

www.oki.com/cz

Slovenská

www.oki.com/sk

Magyarország

www.oki.com/hu

Россия

www.oki.com/ru

Україна

www.oki.com/ua

Türkiye’ye 			www.oki.com/tr
Serbia 				www.oki.com/rs
Croatia 			www.oki.com/hr
Greece 			www.oki.com/gr
Romania 			www.oki.com/ro
OKI Europe 			www.oki.com/eu
Singapore 			www.oki.com/sg/
Malaysia 			www.oki.com/my/
ประเทศไทย 			www.oki.com/th/printing/
Australia 			www.oki.com/au/
New Zealand 			

www.oki.com/nz/

United States 			www.oki.com/us/
Canada 			www.oki.com/ca/
Brasil 				www.oki.com/br/printing
México 			www.oki.com/mx/
Argentina 			www.oki.com/la/
Colombia 			www.oki.com/la/
Other countries 		

www.oki.com/printing/
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Oki Electric Industry Co., Ltd.
1-7-12 Toranomon, Minato-ku, Tokyo,
105-8460, Japan
www.oki.com/printing/
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